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Manual Configuration

The following manuals are included with the product.
* Residual Risk
This manual describes the map of residual risks that require protective measures by users.
e Setup Guide
This manual describes how to connect the printer to a computer and set it up following installation.
* User’s Guide (This Manual)
This manual describes details about product functions and operations.

* Maintenance Guide

This manual describes how to replace consumables, and how to clean and maintain the product.

The latest versions of the manuals and installer can be downloaded at the Afinia
Label website.

https://afinialabel.com/LT5Cinfo
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Reading the Manual
Symbols

= These are cautions and restrictions for the correct operation of the device. Make sure to read to avoid misoperation.

Memo

= These are references and information that are useful when using the device. We recommend reading them.

Reference

= These are the reference pages. Read to learn detailed information and relevant information.

/N\WARNING

= Mishandling due to ignoring this display may cause death or serious injury.

/N\ CAUTION

= Mishandling due to ignoring this display may cause personal injury.

Keys, Buttons, and Symbols

This chapter describes the following keys, buttons, and symbols.

Inscription Description
= Indicates hardware buttons and the numeric keypad on the control
panel.
E.g.:
<OK> button <BACK> button
< > button/key -} ©+
@-} <Fn> key © -} <CLEAR> key

Indicates your PC keyboard.

Indicates menu names on the display screen.
Indicates menu, window, and dialog names on the computer.
Indicates messages and input text on the display screen.

Indicates file names and screen names on the computer.
Indicates reference titles.

S Indicates how to get to the item you want in the menu of this printer or
the computer.




Unless otherwise specified, the printer illustrations used herein show the printer with the unwinder
mounted.

Illustrations may differ from the actual product.

The images of the control panel and PC used herein are examples. The images may differ from actual
products and screens.

Functions 1/1 Page
n Configuration
E Print Information

B Menus
ﬂ B Admin Setup
B B Print Statistics

B Calibration
() Use Online button to return to standby screen.

The following inscriptions are used in this manual.

= Microsoft® Windows® 10 64-bit Edition operating system — Windows 10 (64-bit version)
= Microsoft® Windows® 10 operating system — Windows 10

Unless otherwise specified, the examples in the manuals included with the printer show operation using
Windows 10 and the LT5C printer.

Depending on the OS, model, and version you are using, descriptions in this manual may differ from
what you actually encounter.
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Paper Settings

Printing on Various Papers................ 12

Registering a Desired Paper Size
with the Printer Driver...........ccveeee00e.. 15

* The examples in this chapter use Windows WordPad for explanations. Depending on the
application, the screens and operations procedures may differ.

= For detailed explanations of the printer driver and utility setup items, see "Online Help".

= Due to printer driver and utility version upgrades, actual operations may be different from the
descriptions in this manual.
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Printing on Various Papers

Printing on Various Papers

Usable Media Types

For high-quality printing it is necessary to use paper that satisfies conditions regarding quality,
thickness, paper finish, etc. If printing on paper not recommended by Afinia Label, thoroughly test
the print quality and paper traveling performance, etc., and check that there are no impediments

before use.

If using a (paper) medium that is curled or wrinkled before printing, print quality and paper
traveling performance cannot be assured.

Paper Types, Size, and Thickness
m Roll Paper Specifications

Reference

= Refer to the "Maintenance Guide” for specific paper sizes.

Roll Paper Types

Media Form

Description

Continuous Paper

Paper wound on a roll

Continuous Paper (Black Mark)

Paper wound in a roll with black marks printed on the back surface

Die-cut Label (Gap)

Paper that is die-cut into a label shape

Die-cut Label (Black Mark)

Paper that is die-cut into a label shape with black marks printed on the back
surface

Continuous Label

Paper that is not die-cut into a label shape, with the entire surface covered with
label paper

Continuous Label (Black Mark)

Paper that is not die-cut into a label shape, with the entire surface covered with
label paper and black marks printed on the back surface

Media Type Description
Plain Wood-free Paper
Plain Labels Label paper made of wood-free paper
Glossy Labels Label paper made of glossy paper
Film Labels Label media made of film
Film Film

Roll Paper Size

Roll Outside Diameter

No greater than 203.2 mm (8 inches)

Paper Width

25.4 to 130 mm (1 to 5.12 inches)

Paper Thickness

0.07 mm to 0.25 mm’” (0.003 to 0.0098 inches)

Roll Core Width

Same as roll paper

Roll Core Inner Diameter

76.2 mm

Note

* When there is backing paper, total thickness includes backing paper.

= Using metal foil paper or conductive paper creates the risk of defective printing due to electrical discharge, and device

malfunction.

= Use paper that has black marks printed on its back surface (non-printing surface). Black marks printed on the front surface

cannot be detected.

= Use paper with black marks printed with carbon ink. Use paper with black marks that have a reflective index of less than 10%.

-12 -




Printing on Various Papers

= Die-cut labels that are used in Gap Mode must satisfy the following conditions.
The transparency of the label part (including both the label and the label liner) must be below 25%.

The liners must be within a range of 10% to 45% transparent. However, the transparency of the liners must be more than 1.8
times the transparency of the label part.

= Die-cut labels that are used in Gap Mode cannot use transparent liners or labels.
= Die-cut labels that are used in Black Mark Mode cannot use transparent liners.

= Use continuous labels that have been smoothed on both edges and have been dry edge processed. Recommended
specifications are for paper that has 2 mm of liner on both edges. Please refer to the “Maintenance Guide” for details.

= Thermal paper will become discolored and deformed by heat used for fusing. Do not use it.

= Use film that can withstand heat up to 230°C. Use of film that is not heat resistant creates the risk of film deformation by heat
used for fusing, paper jams, and device malfunction.

« Do not use a liner on which glue is smeared. It will not feed correctly in the equipment. In the worst case, it could damage the
equipment.

= Cast-coated paper is not recommended. Printing quality cannot be guaranteed when it is used.

= If the paper length, label length, or black Mark Interval for a single sheet is less than 4 inches, blank sheets may be printed to
satisfy the paper length that can be fed.

= When printing on paper that is cut to less than 152 mm (6 inches) long in the direction that media is fed, it may feed at an
angle.

If this happens, print it so there is a continuous length that is longer than 152 mm (6 inches).

= When printing on paper that is very narrow (25.4 mm (1 inch)), it may feed at an angle at about 80 mm from the cut trailing
edge.

< When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), smeared or smudged printing may occur near
the cut trailing edge as the roll diameter gets smaller.

= When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), slight damage may occur at the leading edge
as the roll diameter gets smaller.

= Use of the types of paper below is not supported.
Paper whose roll surfaces are not cut cleanly.
Paper that is connected part way through by tape, etc.
Label paper without backing paper with paste on the front surface
Paper whose labels are easy to peel or are peeling
Paper with paste squeezing out onto the base paper area or affixed to the label surface
Paper that is folded or bent
Paper that has holes in it
Paper that is notched
Paper that has perforations
Paper with different size labels on a single roll
Paper with different paper widths on a single roll
Media that has liners and labels that are both transparent (cannot be used even if it has black marks)
Continuous paper that is transparent (cannot be used even if it has black marks)

m Setting the Paper Weight
Set the printer and printer driver paper weight according to the weight of the paper to be used.

Paper Weight
(Total thickness including
backing paper)

Setting Value of the
Media Weight

76 to 95 pm Light
96 to 140 pm Medium Light
141 to 159 pm Medium

160 to 180 pm

Medium Heavy

181 to 199 pm

Heavy

200 to 214 pm

Ultra Heavy1

215 to 229 pm

Ultra Heavy2

230 to 249 pm

Ultra Heavy3

-13 -




Printing on Various Papers

Storing Media

Improper paper storage can cause absorption of
moisture, discoloration, and warping. Note that
printing on such paper can adversely affect print
quality, feeding, etc. Leave packages of media
unopened until you are actually ready to use
them.

B Store media in locations like the
ones described below

e On a flat shelf in a location that is dark and
where there is little moisture

= On a flat table

= An environment with a temperature of 23°C
+£1°C and humidity of 50%RH £2%

B Avoid locations like the ones
described below
Directly on the floor

In direct sunlight

Near the inside surface of an external wall

On a surface that is uneven or curved

In a location where electrostatic charge is
generated

In a location subjected to very high
temperatures or sudden temperature changes

Next to a photocopying machine, air
conditioning equipment, heater, or duct

« Proper printing may not be possible on paper that has
been stored for a long time.

= Leaving roll paper in an environment where it is exposed
to high temperatures and high humidity for long periods
can cause it to become deformed. Do not use deformed
roll paper. Store roll paper in an environment where the
temperature and humidity are appropriate.

= We recommend putting partially used label paper back
into the vinyl bag it was packaged in, to prevent the paper
from absorbing moisture.



Registering a Desired Paper Size with the Printer Driver

Registering a Desired Paper Size with the Printer

Driver

1 Click [Start] and select [Control Panel]
in [Windows System].

@

R |

5 Hardware

® CaER

&)

3 Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

On the [Setup] tab, click [User-defined

paper].
% Afinia LT5C Label Printer PCLG Printing Preferences. X
S00 Cokr Ovedap Btend
Eaample Favorites
|1 Default setting Save Management
2 Paper seftings Continuous 4.000 x 6.000in User-gefined paper...
ils Sormat Contibin Pt
= Media Type Plain
3 Media Weight  Medium Light {96+140 ym
¢ |a
2
£
3 5 Onentaton ®) Porrait ) Landscape 0 [T Mirrce Prnt
Copees: 1 I Coltate | Print in rgverse order
6 a
[ Te prioritize colistion specified by sppication
7 Cut Mode: Only cut at the end of job
8
9 Quality Finve / Detail (1200 x 1200) []Pheto Enhance
I ‘ Screeg Prontize resolution
b ATINIA LABLT o o

5 Input information about the paper you
want to register.

(1)

Use [Registered user-defined
paper] to select "New Paper".

In the [Paper Name] box, enter a
paper name.

Select a Media Form to match the
paper.

Select a Media Type to match the
paper.

- 15 -

()

Select a Media Weight to match the
paper thickness.

Memo

e If you are unsure of the paper thickness,
select [Medium Light].

(6) Enter paper size information. )

Ao

= Input the label length and gap for media that has
gaps and the black mark interval for black mark
media.

= Use a ruler to measure, as accurately as possible,
the actual size of the media, and then input those
values.

= If the label length or the black mark interval is less
than 4 inches, use the following method to measure
the media, and then input values to the first decimal
place to be accurate.

L LLLL TR

(3)L/10-Gap length(mm)
(2)L/10(mm)

)

(1)L(mm)

How to Measure the Actual Size of Paper

(1) Measure the length from the leading edge of the
first label (or black mark leading edge) to the
leading edge of the 11th label (or black mark
leading edge). Use this as L (mm).

(2) Divide the length you measured in (1) by 10 to
calculate the length from the leading edge of the
first label (or black mark leading edge) to the
leading edge of the 2nd label (or black mark leading
edge) to the first decimal place.

(3) Subtract the length of the gap from the length you
calculated in (2) to calculate the length of one label
to the first decimal place.

For media that has gaps, input the value calculated in (3)
in [Label length] and input the gap length in [Gap].

For media that has black marks, input the value
calculated in (2) in [Black Mark Interval].



Registering a Desired Paper Size with the Printer Driver

Memo Using the Printer Driver

= A blank piece of paper may be inserted after cut to FI ne-tu ne the Prlnt

pages if the paper length, label length, or black Position
mark interval is less than 4 inches.

Click [Start] and select [Control Panel]

6 Enter other information as required. in [Windows System].

1 If you performed sensor ; i ; i

( ) ad}/ustrl%ent, blect the censor 2 Click [View devices and printers].
setting that was registered to the P ; "
device from [Sensor settings]. i —

Memo

= Refer to “Calibrating the Sensor” (P.30)
regarding how to adjust the sensor.

® Cak

(2) If you want to fine-tune the
image position, enter the position

shift amount into [Print position
correction].

Right-click the [LT5C PCL6] icon, and

(3) E;Lgou want to fine-tune the paper 3 then select [Printing preferences].

position, enter the position
shift amount into [Cut position

correction]. 4 On the [Setup] tab, click [User-defined
paper].
ot @ Afinia LTSC Label Printer PCLG Printing Preferences x

Setip  Color  Ovedays Bxtend
Bample

Favortes

1 Defoult setting v Save Ienagement...
2| s [CanmiomieE g
o é’ Format: Continuous Paper
=L > 3 Media Type: Plain
T i - Media Weight:  Medium Light (36-120 pm)
| :
i L g 5 Ogientaticn @ Portan O landecape O ) Magroe Print
(18
é S S Copres: 1 ClCetate [JIPrint in rgverse order
1 — - [ To pocettize collation specdied by appication
e — 7 CutMode: Only cut st the end of job
8
. . . 9 Qualityy Firse / Detad (1200 x 1200) > [ Pheto Enhance
7 When all the input is complete, click L — T
[ ] ) '™ ACINIA LABCL Apowt.. Dt
JrSp— x ] come Heb

Paper e [ Lo 1 130000 Pase Infurmman

F
i
3
A 1904 S e
T
§
5
2




Registering a Desired Paper Size with the Printer Driver

Use the [Registered user-defined paper] ) .
5 list to select the paper whose print 9 Open the file to be printed.

position you want to correct.

Memo 10 Specify the paper size, and then print.

= If the paper you want to use is not in the list, select
[New paper] and add it. See “Registering a Desired
Paper Size with the Printer Driver” (P.15).

Mess Form Cortmusus Pages

Medateght  Medum Light (36-140 pm)

Prnter lompption wauszon
sae
it Poper leagth(y 000 [ [ 00 - 000 |
| mkmeter S k3
Paper w0 4000 & | w0 ERLL I |
Bent potiza cenecton
3 o | O 0
sowten (0000 12/( 008 ~oow | §
i Lettighe margn o0
Yeasten (0000 2/| am - oom | 5 )
Cia postion comection § I U
Yooptien: (0000 1] [ 00N — 009 | ]
LQose e

6 In [Print position correction], set the
values for the print start positions
vertically and horizontally on the paper.

Urer defined poper x

Papes Hames Paper information
Tegeteres i defined paper Masa Form Centirwou Papes
tiew

Mesa Iype Plen
Mesa feght Medtam Light (56-140 )
Prster indonmaticn acqustion
See
U 7 Baper lengthD o 18l o%0 - om0 )
—— @ s
Paper mth(l) 4000 5 [ s )
pret peuties conecton
» Top/Bottom mergin [0 [ Estended Penting
Xgostion [0000 s/t -0om —oom 1 §
i LetRight masgn o023
Ypgstien (0200 (31000 - 0om | & K-> .
1
Cut postizn comection g 4
YPojtier (0000 3 [ 00 - Q0 | f_l
Close Help
7 Click [Overwrite].
Ve defined peper x
Papertiame Fope idemnstion
Fagetered uter-defined pager Meds Fegme Cortnuous Paper
Medu Trpe Shsin
Media fogne | Meduum Light (56-120 yom)
[ Rpe—
s Paper keagth() 6000 /2 [ 050 - 2000 )
o @i T
Paper width() 00 3 o0 s )
P poskion comection
= Top/Bottom maegn 0083 [ itented Prnting
X govtiens [ 0000 ™ m o1 §
S B R P S Le/Right margin 0.083
Voouwen [G24 1311 0om ~oom | L “
o pren e 1| e
YPogtien: (0000 121 | 002 2 —
Clon Help

8 Click [OK] or [Close] as many times
as necessary to exit the "Printing
preferences" screen.



Registering a Desired Paper Size with the Printer Driver

Using the Printer Driver to 5 Use the [Registered user-defined paper]

- o . list to select the paper whose cut
Fine-tune the Cut Position position you want to correct.

Click [Start] and select [Control Panel]
Memo
1 in [Windows System].

= If the paper you want to use is not in the list, select

. . . . [New paper] and add it. See “"Registering a Desired
2 Click [View devices and printers]. Paper Size with the Printer Driver” (P.15).

0 Comrel Panet o x User-defnred paper X
- 1 ED . Covtr Pana e | . , oo | Use Doficd s Fra
Fle Ede me Teek Pegatered caer Setned page Mesa Form Contnusus Pages

Meda pe Min

Medua teght Meckuum Light (36- 145 pam)

Peinter il onmation wquison
Sae
e . -
Paper (D 6000 50 [ 030 - K000 1
) meliencters Bnch T -
T Paper mdth D) 400 % | o s 1
Dot postien comection
7 Tptotommagn (008 | [Jetended Ponting
Xgomen (0000 2i( -00% - oom | §
i‘ S tevngre mapn )
Yogsten: (0000 1211 407 - 009 | & &
Cua postien comion § N
YPogtion: 0000 & | 000 ~ 000 | [—1
Qose e

3 Right-click the [LT5C PCL6] icon, and

then select [Printing preferences]. 6 Use [Cut position correction] to specify

an adjustment value for distance from

4 On the [Setup] tab, click [User-defined the_print completion position to the cut
paper]. position.

e defined peper x
8 Afinia LTSC Label Printer PCLG Printing Preferences x
| Paper tame o Oc Paper information
Seio Color  Ovedmys Doend Regietored uies-defined paper Madia Foym Centinsous Papes
- \ -
| Mesa 1
1 Defoult setting v Seve Idenagement... ‘ \ Gn -
| Mesaljeght  Medam Light (56140 ym)
2 Paper settings: Continuous 4000 x 6.000m v Usar-gefined paper—. .
%’ 3 Format: Continuous Paper
-4 Media Type: Plain
i Media Weight:  Medium Light (36- 120 pm) Prter idomaticn xquason
2|4 -
g .
g 5 Ogentaticn @Poan  Olandecape O ) Mgroe Print “ & o = Paper length(D 00 3 | a0 Ro0 )
. s i K Paper math() 400 5 [ M0 -3 )
& Copres: 1 Ol Coltate [IPriot in rgvesse ordes Pret pestiea conectan t T
» Topcttommagn 0000 | [Esended Prnting
[ To prcetice colation specdied by apphcation Xpowtion [0000 ‘21 -00% oo ) §
7 i Let/Fight margn 0083
Cut Mode: Only cut at the end of job Yppstion (0000 (571 -00m - 00% | S e )
i
8 Iwmm cornecton l § )
YPoyon [0000 |51 1 000 ~ 000 | —
9 Qualityy Firve / Detail (1200 x 1200) ¥ [ Pheto Enhance —
= Ser Priontize <
I ey resalution | Clote Help
b AFINIA LABLT o o
O om0 [ e 7 Click [Overwrite].
Vier defined paper x
| Poper tome: o Bager intcrman
Pagetered usee-defined pager Medha Fogm Cortavout Papar
Hew gager
Cos
< Meda Fype L
| =] I ——
Printer informanion acquenon
o
e - —
2 6000 (3] [ 0500 - 2000 )
O miirnators B inch T : Sewlenb 0 {
Papes wth() 00 3] (100 .S )
Prire pottion comectien
= - Top/Bottommaegn | 0083 | () Citended Prnting
Kgowtien (0000 301 00M o 1 E
R R Le/Right margin 0083
Vpostiea: | 0000 S0 -00m wn | 5 = =
o ) B s
YPoytion: [0000 131 | 000 - 089 | —
Clese Help



Registering a Desired Paper Size with the Printer Driver

8 Click [OK] or [Close] as many times
as necessary to exit the “Printing
preferences” screen.

9 Open the file to be printed.

10 Specify the paper size, and then print.



Registering a Desired Paper Size with the Printer Driver
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Printing

Preparing Paper ......ccicciirninnsnnnnnans
Loading Media ........cccvvmimneennnnnnnnnnss
Calibrating the Sensor..........civeceiis

Detecting the Interval between
Pages .....iiiiivisssssssssssssssssssnnnnnnnnnnns

Printing .....cciiiciiiiciiisnincsnnnssnnnnnnnas

Canceling a Print Job ........ccciviieeein

22
24
30

43
45
46

= The examples in this chapter use Windows WordPad for explanations. Depending on the

application, the screens and operations procedures may differ.

= For detailed explanations of the printer driver and utility setup items, see "Online Help".

= Due to printer driver and utility version upgrades, actual operations may be different from the

descriptions in this manual.
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Preparing Paper
Preparing Paper

This section describes how to load paper onto the holder of the unwinder.

For paper sizes and types that can be loaded onto the unwinder, see “Roll Paper Specifications” (P.12).

Check the leading edge of the paper
and cut it off straight.

If the leading edge of the paper is cut

1 Remove the paper from the packaging.

Take care of the tape that is holding the

leading edge of the paper.

If there is no tape holding the leading
edge of the paper, you can just load it
as is.

(1)

Remove the tape that is holding
the leading edge.

Note

= Remove the tape that is holding the leading
edge of the paper before you use it. Do not
load paper while the tape is still attached and
feed it into the equipment. There is a risk of
damaging the equipment.

2)

Cut off the part of the paper on
which there is leftover adhesive.

Note

= There is a risk of adhesive being left over
after removing the tape. If paper that still
has adhesive on it is fed into the equipment,
the adhesive may stick to the feed path and
damage the equipment.

Cutting off the part of

the paper on which there

h ) Tape is removed (1)
is leftover adhesive (2)

-22 -

straight, you can just load it as is.
Be particularly careful when replacing

paper and after removing and reloading
jammed paper.

(1)

When loading paper, cut the
leading edge of the paper straight

before loading it.

= Do not cut at an angle, do not cut black

marks, and do not cut labels. Depending
on the size and shape of the leading edge,
there is a risk of skewing the print position,
not being able to print, or damaging the
equipment.

e Standard media and continuous labels

(dry edge)

* Standard media (with black marks) and
continuous labels (dry edge)

1.2t0 4.0 mm 1.2 to 4.0 mm
(0.0472 to 0.1575 (0.0472 to 0.1575
inches) inches)

Length of leading
margin when paper
is loaded

Length of leading
margin when paper
is loaded




Preparing Paper

« Die-cut label paper (no black marks)

1.2 to 6.5 mm
(0.0472 to 0.2559 inches)
Length of leading liner
when paper is loaded

T

T

« Die-cut label paper (with black marks)

1.2 to 4.0 mm
(0.0472 to 0.1575 inches)
Length of leading margin
when paper is loaded

T >

— |




Loading Media

Loading Media

Load the paper onto the Unwinder. For paper sizes and types that can be loaded on the Unwinder, see
“Roll Paper Specifications” (P.12).

= When setting roll paper, be careful not to drop it. As roll paper is heavy, when you drop it, there is a risk of injury.
= If you drop roll paper, it may roll on the floor and cause injury to the people around.

= To prevent roll paper from dropping, store it horizontally on a desk, etc.

= Do not use any roll paper that is not specified by the Roll Paper Specifications.

Memo

e If the printer is turned OFF, press the <POWER> button to turn it on.

1 Open the Flange Locking Lever. Rotate the Roll Paper Holder Knob to
contract the Roll Paper Holder shaft.

e

~ A
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Loading Media

Slide roll paper onto the Roll Paper Aligning the Flange with the Roll Paper
Holder shaft as far as it will go. Holder shaft as shown in the illustration,
attach the Flange.

7 Slide the Flange as far as it will go in
accordance with the roll paper width.

= Make sure to slide the roll paper as far as it will go.
Insufficiently sliding the roll paper can adversely
affect print position accuracy. @ Note
= Take care to avoid pinching your fingers or hands

when sliding the roll paper. « Slide the Flange up to the side of the loaded roll

paper.

= Take care to avoid pinching your fingers or hands
when attaching the Flange.

Rotate the Roll Paper Holder Knob to fix
the roll paper core in place.

= Rotate the Roll Paper Holder Knob until it clicks.



Loading Media

8 Close the Flange Locking Lever. Lower the Unwinder Cover Open Lever
<] to open the Unwinder Cover.

Open the Unwinder Cover manually in
the direction indicated by the arrow
until it locks.

= After loading roll paper, take care not to rest your
body weight on the top of the Roll Paper Holder
shaft. Doing so risks causing injury due to the
device falling.

= Open the Unwinder Cover until it locks securely.



Loading Media

1 Before loading the paper, rotate the Roll Pass paper below the Tension Bar and
Paper Guide Adjustment Knob clockwise FO Roller, and align the leading edge of
and move the Roll Paper Guide towards the paper with the Roll Paper Guide and

you. Paper Guide.

Roll Paper Guide Paper Guide
*D shape metallic pin

1 Check the paper status from the
direction indicated by the arrow.

Press the Tension Bar Open Lever
upwards until it clicks.




Loading Media

Rotate the Roll Paper Position
Adjustment Dial to adjust the paper
until it is straight.

Roll Paper Position
Adjustment Dial

Memo

1

Press down on the Tension Bar Open
Lever until it clicks.

18 After loading the paper, rotate the

= If you rotate the Roll Paper Position Adjustment Dial

in
direction A—the roll paper moves in the direction C
direction B—the roll paper moves in the direction D

Lower the FO Roller Release Lever to fix
the roller in place.

Roll Paper Guide Adjustment Knob
counterclockwise and align the Roll
Paper Guide to the width of the paper.

« Set the Roll Paper Guide correctly. If the Roll Paper
Guide is not set correctly, the width of the paper
cannot be detected correctly.

Be careful that the Roll Paper Guide does not press
too strongly on the paper. Doing so could damage
the paper.

Do not allow too much of a gap between the paper
and the Roll Paper Guide. Doing so could allow the

paper to twist and the print position to shift.

When setting the Roll Paper Guide to the width of
the paper, rotate the Roll Paper Guide Adjustment
Knob counterclockwise, as shown in the following
diagram, to make the Roll Paper Guide narrower
so it matches the width of the paper. If it is too
narrow, rotate the Roll Paper Guide Adjustment
Knob clockwise to first open the Roll Paper Guide
wider, and then make it narrower.




Loading Media

>< 19 Close the Unwinder Cover.
\‘\](’/// \\\\

= When closing the Unwinder Cover, there is a risk of
pinching your fingers or hands. Press the top of the
Unwinder Cover to close it.

This completes setting roll paper.

Memo

= If, even though the roll paper is set correctly, the
paper separates from the Unwinder Paper Guide
during printing, rotate the Roll Paper Position
Adjustment Dial in the B direction to adjust it so the
paper does not separate from the Unwinder Paper
Guide.
As a guideline, the adjustment should be the same
distance that the paper is separated from the
Unwinder Paper Guide.
Each notch on the adjustment scale at the base of
the Roll Paper Position Adjustment Dial is 1 mm.

Roll Paper Guide is aligned to width of paper

J

Adjustment notches

Roll Paper Guide is too tight



Calibrating the Sensor

Calibrating the Sensor

Note

* Check the position of the sensor each time you load paper.
Check the position of the sensor in the following cases especially.
- When you load a different type of paper
- When you switch the type of sensor from black mark sensor to gap sensor
- When you switch the type of sensor from gap sensor to black mark sensor

= If the sensor position settings do not match, paper feed jams may occur, you cannot adjust the black mark sensor or the gap
sensor, and the skew in the adjusted values may cause the print position to skew.

Confirming the Sensor

Position

Unwinder

Lower the Unwinder Cover Open Lever
to open the Unwinder Cover.

Open the Unwinder Cover manually in
the direction indicated by the arrow
until it locks.

I
o] 'O
&3

« Open the Unwinder Cover until it locks securely.

- 30 -



Calibrating the Sensor

Confirm the sensor position.

Sensor Position Adjustment Dial

rPosition During Regular Usage )
Factory setting is this position.
10 mm from
edge of paper
The “A” indicates the Edge of
black mark sensor paper
position
The “|” indicates 1.5 mm  Edge of
the gap sensor  from edge Paper
Lp05|t|on of paper y

(1)

Check the black mark sensor
position

Align the paper, and check the
actual position of the black mark

and the black mark sensor position.

Black mark (on back
side of paper)

- 31 -

If the position of the black mark
and the black mark sensor position
do not align, rotate the Sensor
Position Adjustment Dial to adjust
the position (go to step 3).

Black mark (on back
side of paper)

The black mark sensor position is
set 10 mm from the edge of the
paper.

If the black mark is 15 mm or
more from the edge of the paper,
you do not need to adjust it.

If the black mark is 15 mm or less
from the edge of the paper, adjust
the position of the A so it is in the
center of the black mark.

Check the gap sensor position
Align the paper, and check the
actual position of the label and the
gap sensor position.




Calibrating the Sensor

If the position of the label and the
gap sensor position do not align

in relation to the regular usage
position, rotate the Sensor Position
Adjustment Dial to adjust the
position (go to step 3).

Width of the
right edge
of the liner

Label

The gap sensor position is set 16.5
mm from the edge of the paper.

If the width of the right edge of
the liner is 10 mm or less, then
adjustments are not necessary.

If the width of the right edge of the
liner is 10 mm or more, then adjust
the gap sensor using the above
positions as a rough estimate.

If the corners of the label are
rounded, then consider the position
of the radius of the corner.

Refer to the following example of
adjusting the position.

Radius of
corner

Label

Rotate the Sensor Position Adjustment
Dial to adjust the sensor position.

Memo

= If you rotate the Sensor Position Adjustment Dial in
direction A—the sensor position moves in the
direction C
direction B—the sensor position moves in the
direction D



Calibrating the Sensor

Printer

Grasping the Top Cover Open Lever,
open the Top Cover.

Remove the Print Cartridge Set and the
Belt Unit.

Memo

= Refer to "Maintenance Guide” for the procedure to
install the print cartridge set and belt unit.

Confirm the sensor position.

Sensor Position Adjustment Dial

(

Position During
Regular Usage
Factory setting
is this position.

The “|” indicates the They' ” indicates the
gap sensor position black mark sensor
osition
- P w,

65 mm from
edge of paper

of
58.5mmfromedge | paper
of paper




Calibrating the Sensor

(1)

Check the black mark sensor
position

Confirm the center of the black
mark on the media and the black
mark sensor position on the device
(number on the V indicator).

If the position of the black mark
and the black mark sensor position
do not align, rotate the Sensor
Position Adjustment Dial to adjust
the position (go to step 4).

The black mark sensor position is
set, at the factory, to 58.5 mm from
the right edge of the label liner.

Adjust the position of the V" so it
is in the center of the black mark
of the media you are using.

< > < >
i it
~
Black mark Center of black mark

(on back side or paper)

Check the gap sensor position
Confirm the center of the label

on the media and the gap sensor
position on the device (humber on
the | indicator).

If the position of the label and
the gap sensor position do not
align, rotate the Sensor Position
Adjustment Dial to adjust the
position (go to step 4).
The gap sensor position is set, at
the factory, to 65 mm from the
right edge of the label liner.
Adjust the position of the ™ | " so it
is in the center of the labels of the
media you are using.

I I

~1_7

Center of label

Rotate the Sensor Position Adjustment
Dial to adjust the sensor position.

Memo

= If you rotate the Sensor Position Adjustment Dial in
direction A—the sensor position moves in the
direction C
direction B—the sensor position moves in the
direction D



Calibrating the Sensor

Sensor Calibration

Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

—r— o

Q- 88 oo
e 3 oo
&l ,

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

On the [Setup] tab, click [User-defined
paper].

& Afinia LTSC Label Printer PCLG Printing Preferences x

S0 Coor Ovedays Btend

Frample Eavorites

—
1 Default setting Save Management..
2 Paper seftings Continwous 4,000 x 6,000 User-gefined paper...
§’ Foemat Continuous Paper
- 3 Media Type Plain
3 Media Weight  Medium Light (36-140 pm)
g9
2
g 5 Orientation ®Ponrait (O Landscape O I Mirrce Print
6 Copees 1% CICepate L[l Pring in reverse order
[ To prioritize collation specified by application
7 Cut Mode Only cut at the end of job
8
9 Quality Fimve / Detail (1200 x 1200) [C]Phete Enhance
1 Screeny Priontize resolution

b AFINIA LABLL

5 Input information about the paper you
want to register. To adjust settings that
are already registered, select the names
of the paper from the list in [Registered
user-defined paper].

6 Click [Sensor Adjustment].

et forrm D cotlabes (Dock W)

P b

Nedarn Ught (8140 gers

[ ——"

Memo

« [Sensor Adjustment] appears if the following
conditions are met.

- The Media Form is one of the following
Continuous Paper (Black Mark)
Die-cut Label (Gap)

Die-cut Label (Black Mark)
Continuous Label (Black Mark)

- The [Ports] of the printer driver is USB or
standard TCP/IP port

« Before performing [Sensor Adjustment], make sure
that the printer is “online”.

= If [Sensor Adjustment] does not appear, advance to
step 12 of this procedure.

7 Click [Next].

Sensor Adjustment x
Starts Gap sensor adjustment.
Information of the paper to be adjusted is as fallows.
Paper Name © User Defined Size
Paper farm : Die-cutLabel (Gap)
Label length : 4000in
Label width © 384%n
Gap © 01
Set applicable paper to the printer, and click [Next].
<Back [ mee ) Cancel

Memo

= Before performing the next steps of this procedure,
make sure that paper is loaded.

= If there are no paper size settings configured on the
control panel, it may cause a paper size mismatch
on the device. Pressing the <OK> button on the
control panel overwrites the device paper size
setting with the paper size setting in the printer
driver.
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Calibrating the Sensor

8

Select a registration location (a) for
the adjustment, and then enter a
registration name (b).

Sensor Adjustment n

Selects the registration destination.

Select the registration destination for adjustment values from the following list.

Unreaistered User settings |

(a)

S S ———————————
3 Unreqistered  User settings 3
4 Unreaistered  Usersettings 4
5 Unregistered  User settings 5
&  Unregistered  Usersettings 6
7 Unregistered  User settings 7
8 Unregistered  User settings &
9 Unregistered  User settings 9
10 Unregistered  User settings 10

Registered name: I 150MM '(b)

Input the registered name, and click [Next].

<Back Next> Cancel

Memo

= You can enter up to eight alphanumeric English
characters for the registration name.

Click [Next].

This starts the sensor adjustment and

displays a wait message.

Sensor Adjustment n

Selects the registration destination.

Select the registration destination for adjustment values from the following list.

Ne.  Status Registered name

Unregistered  User settings 2
Unregistered  User settings 3
Unregistered  User settings 4
Unregistered  User settings 5
Unregistered  User settings 6
Unregistered  User settings 7
Unregistered  User settings &
Unregistered  User settings 9
0 Unregistered  User settings 10

e VI

Registered name: [ 190MM

Input the registered name, and click [Next].

<Back Next» Cancel

v

Sensor Adjustment %
Sensor being adjusted.

Wait for a while until sensor adjustment is complete.

Cancel

1 When the completion screen appears,
click [Complete].

Sensor Adjustment.

Sensor adjustment completed.
Registered with the following name.

No.  Status Registered name

1 Registered 190MM

2 Unregistered  User settings 2

3 Unregistered  Usersettings 3

4 Unregistered  User settings 4

5 Unregistered  Usersettings 5

6  Unregistered  Usersettings 6

7 Unregistered  Usersettings 7

8  Unregistered  User settings 8

9 Unreqistered  User settings 9

10 Unreqistered  User settings 10

Complete |

Memo

= The results of adjusting the sensor are registered
on the printer. In [Sensor settings] in [User-defined
paper] in the printer driver, you can specify the
number registered in the printer for the adjustment
results and whether to apply it when printing. By
standardizing the registration numbers of the sensor
adjustment results, you can get the same print
results by specifying the same number in [Sensor
settings] in the printer driver for any printer. This is

useful when printing on the same media on multiple
| | printers.

To register new settings, click [Add] or
click [Overwrite] to select paper that is

12 already registered.
Click [OK] or [Close] as many times

as necessary to exit the “Printing
preferences” screen.

13 Open the file to be printed.

1 Specify a registered paper size, and
then print.



Calibrating the Sensor

If You Cannot Set the Sensors from the Printer Driver

If you cannot set the sensors from the printer driver, then set them from the control panel.

Black Mark Sensor

Gap Sensor

Confirm the sensor position

¥

Confiure the sensor type

Media form = Continuous Paper (Black Mark)
Die-cut Label (Black Mark)
Continuous Lable (Black Mark)

¥

A4

Confiure the paper size

Paper size = Custom

X Dimensio = Input the “label width”

For die-cut labels (Black Mark):
Paper Length = Input the “label length”

Gap Length = Input the “gap length”
Otherwise:
Black Mark Interval = Input the “length beween

black marks”

Confiure the sensor type
Media form = Die-cut Label (Gap)

A4

Confiure the paper size

Paper size = Custom
X Dimensio = Input the “label width”
Y Dmension = Input the “label length”
Gap Length = Input the “gap length”

¥

Execute sensor calibration
Sensor Calibration — Execute
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Calibrating the Sensor

Ca|ibrating the Black Mark Press the <Fn> key, and then press the
following buttons: <9>, <0>, <OK>.

Sensor

Function Number
You can adjust the black marks on roll paper o0l B
using the black mark sensor. iz 11-EE gt [Nt

Here, we will show the method when Continuous
Label (Black Mark) are used.
Press the <Fn> key.

The numerical values input screen will )
P On the Paper Size menu, select

be displayed. [Custom], press the <OK> button, and
Meny — ONLINE 01N]O) then press the <ON LINE> button.
ABC  DEF The display will return to the standby
screen,

GHI JKL MNO

~ D®®

e TUV  WXYZ

] DI,

Fn CLEAR

ATTENTION

Press <8>, <9>, <1> (function
numbers), and then press the <OK>

Use Online button to return to s...

button.
Function Number 7 Press the <Fn> key, and then press the
891l following buttons: <9>, <1>, <OK>.

Enter 1-3digit Number
Function Number

91
Enter 1-3digit Number

Select [6. Continuous Label (Black
Mark)], and then press the <OK>

button. 8 Use the numeric keypad to enter the
label width, press the <OK> button,
Continuous Paper and then press the <ON LINE> button.

Continuous Paper (Black ... The display will return to the standby
Die-cut Label (Gap) screen.

Die-cut Label (Black Mark)
Continuous Label

[ v continuous Label (Black Ma
| Use Online button te return to s...

Media Form

Wmillimeter

(254 -126.0)

4 Press the <ON LINE> button to return
to the standby screen.

Use Online button to return to s...




Calibrating the Sensor

Press the <Fn> key, and then press
the following buttons: <8>, <9>, <0>,
<OK>,

Function Number

8908
Enter 1-3digit Number

1 Select [Black Mark Interval] from
[Unwinder Config], and then press the
<OK> button.

Unwinder Config

n Media Form

Liner Width Config
B Paper Size

n X Dimension
B Black Mark Interval
Adjust Cut Position

nglPage

]1 Use the numeric keypad to enter the
Black Mark Interval, press the <OK>
button, and then press the <ON LINE>
button.

The display will return to the standby
screen.

- Black Mark Interval

|+ [EBAmillimater
(15.9-1324.0)

O Use Online button to return to s...

Press the <Fn> key, and then press
the following buttons: <8>, <9>, <3>,
<OK>.

Function Number

893K
Enter 1-3digit Number

Select the setting number of the sensor
to be configured, and then press the
<OK> button.

: Sensor Calibration

: <Unregistered>

: <Unregistered>

Set3 : <Unregistered>

Setd4 : <Unregistered>

Setb : <Unregistered>

Setb : <Unregistered>

BTIlPage

1 Select [Execute Calibration], and then
press the <OK> button.

Set1 : <Unregistered> 1/1 Page
n Execute Calibration

(0) Use Online butten te return to standby screen.

15 Enter the sensor calibration name, and
then press the <OK> button.

o Input Name

(0 - 8 digits )

Memo

= You can leave the name blank, if you want.

1 If an execution confirmation screen
appears, select [Yes].

= o You Execute?

O Use Online button to returnto s...

1 This executes sensor calibration.

Sensor Calibrating



Calibrating the Sensor

After sensor calibration is complete,
press the <OK> button.

Sensor Calibration Success

Press OK Button

Calibrating the Gap Sensor

You can adjust the distance between die cut
labels using the gap sensor.

Press the <Fn> key.
The numerical values input screen will
be displayed.

Menu ON LINE @@@

ABC DEF

O ®

GHI JKL MNO

CANCEL @@
7/ O @D ©

Fn CLEAR

ATTENTION

Press <8>, <9>, <1> (function
numbers), and then press the <OK>
button.

Function Number

891
Enter 1-3digit Number

Select [3. Die-cut Label (Gap)], and
then press the <OK> button.

1/1 Page

izl:i- Media Form

| n Continuous Paper
Continuous Paper (Black ...
BVDie-cut Label {Gap)

n Die-cut Label {Black Mark)
Continuous Label

a Continuous Label (Black ...
(L) Use Online button to return to s...

4 Press the <ON LINE> button to return
to the standby screen.

MEenu ON LINE @@@

ABC DEF

@ ®®

GHI JKL  MNO

CANCEL @ @

PQRS TUV  WXYZ

©@O

CLEAR

ATTENTION



Calibrating the Sensor

5 Press the <Fn> key, and then press the

following buttons: <9>, <0>, <OK>.

Function Number

90K
Enter 1-3digit Number

6 On the Paper Size menu, select
[Custom], press the <OK> button, and
then press the <ON LINE> button.
The display will return to the standby
screen.

E Paper Size

(L) Use Online button to return to s...

1

7 Press the <Fn> key, and then press the

following buttons: <9>, <1>, <OK>.

Functicn Number

91l
Enter 1-3digit Number

Use the numeric keypad to enter the

8 label width, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

(25.4-126.0)

Use Online button to returnto s...

Press the <Fn> key, and then press the
following buttons: <9>, <2>, <OK>.

Function Number

92K
Enter 1-3digit Number

Use the numeric keypad to enter the
label length, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

EEREmillimeter

(12.7-1320.8)

Use Online button to return to s...

Press <8>, <9>, <0> (function
numbers), and then press the <OK>
button.

Function Number

890K
Enter 1-3digit Number

Select [Gap Length] from [Unwinder
Config], and then press the <OK>
button.

Unwinder Config

n Media Form

B Liner Width Config
B Paper Size

a X Dimension
Y Dimension
ﬂ Gap Length

gT!lPage
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Use the numeric keypad to enter the
gap length, press the <OK> button,
and then press the <ON LINE> button.
The display will return to the standby
screen.

Tk Gap Length

Vmillimeter
(3.0-10.0}

O Use Online button to return to s...

1 From here, perform the same steps as
those under “Calibrating the Black Mark
Sensor” from step 12 of this procedure.



Detecting the Interval between Pages

Detecting the Interval between Pages

m When executing from the printer
driver

You can use the following procedure, from the

printer driver, to register the paper gap and black

mark interval on the device. Registering these

settings improves your printing results. However,

it does waste approx. 10 sheets of paper.

1 Click [Start] and select [Control Panel]
in [Windows System].

Click [View devices and printers].

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

paper].

After confirming that the paper name
you entered in the “Paper Name” box is
shown under [Registered user-defined
paper], click [Close].

4 On the [Setup] tab, click [User-defined

6

9

For [Paper settings], select the paper
settings you registered, and then click
[Paper interval detection].

@ Afinia LT5C Label Printer PCLG Printing Preferences

S0o Cor  Ovwian B

1
2
3
4
5
I3

Memo

= [Paper interval detection] is displayed ifthe
following conditions are met.

- The Media Form is one of the following
Continuous Paper (Black Mark)
Die-cut Label (Gap)

Die-cut Label (Black Mark)
Continuous Label (Black Mark)

- The [Ports] of the printer driver is USB or
standard TCP/IP port

= If [Paper interval detection] does not appear,
advance to step 8 of this procedure.

Confirm the displayed paper
information, and then click [Measure].

Check Media Gap x

Check media gap.

The infermation of the adjust paper is as follows.

Paper Name © Label BM1 120x100
Paperform . Die-cut Label (Gap)
Label length ;. 101.6mm

Label width : 976mm

Gap : 30mm

Please set the coincident paper in printer then push [Calculate] button.

C e ) Cancle Help

This starts checking the media pitch
and closes the dialog box.

Memo

= If you change to another type of paper, you should
execute this paper interval detection again.

Click [OK] as many times as necessary
to exit the “Printing preferences”
screen.

Open the file to be printed.

10 Specify a registered paper size, and
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Detecting the Interval between Pages

B When executing from the control
panel

Detect the paper gap and black mark interval
from the control panel.

1 For black mark media, execute steps
1 to 11 in “Calibrating the Black Mark
Sensor” (P.38).

For gap media, execute steps 1 to 13 in
“Calibrating the Gap Sensor” (P.40).

2 Press the <Fn> key.

3 Press <8>, <9>, <4> (function
numbers) and then press the <OK>
button.

Function Number

894K
Enter 1-3digit Number

4 Select [Execute], and then press the
<OK> button to start paper interval
detection and close the dialog box.

Check Media Pitch 1/1 Page

n Execute

() Use Online button to return to s..




Printing

Printing

After loading the paper, use the computer to open the file you want to print. Next, use the printer driver
to select the [Paper Size] and [Paper Weight], and then print.

Memo

= When printing on label paper for the first time, execute [Sensor Adjustment] before printing.

= When reprinting after an error occurs, if Cut Mode is set, the media may not be cut in the position you expect.
If you want to align the cut positions, temporarily cancel printing, and then send the print data starting from the page you
want to reprint.

Reference

= For detailed explanations of the printer driver setup items, see “Online Help”.
* For information about how to load paper, see “Loading Media” (P.24).

m Windows PCL Printer Driver Click [Print] in the “Print” screen to
Here, we will show how to print an open print.
WordPad file as an example.

Select [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and then click [OK].

On the [File] menu, click [Print] >
[Print].

Click [Preferences].

On the [Setup] tab, configure [Paper
settings].

OT B WO PP

5 Afinia LT5C Label Printer PCLG Printing Preferences
Sebo Cokr Ovedas Extend
¢ Frvortes
Default getting Sovn Minagement

Peper setbngs: Continucus 4.000 x 6000 User-defined paper..

Format:

UBKIH991 SR m— £
v {
5

N

Only cut ot the end of job

Queliy Fine / Detail (1200 % 1200) . [ Pneto Ennance

9
[“] Screeg Pricctirs resohstion

4 AFINIA LABEL e

Memo

= Configure the [Cut Mode] setting on the [Setup] tab
as required.

When the settings are complete, click
[OK] in the “Setup” screen.
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Canceling a Print Job

Canceling a Print Job

Use the procedure below to cancel a print job from the printer’s control panel.

On the control panel, press the
<CANCEL> button.

Mzu ON LINE @CA%:)@

Back
. O®®
GHI  JKL  MNO
@ @ CANCEL g;% g?
i loloje

ATTENTION

2 If a verification message appears, select
[Yes], and then press the <OK> button.
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Print Function
Settings

Printer Driver Functions Table......... 48

Table of Setting Items
in the Control Panel Menu Screen... 50

Saving Toner When Printing.............. 79

Fine Quality Printing ..........ccvecvieiieeee. 81

Adjusting the Print Position
on the Paper .......ciiiiiiiiiiiinec e 84

Other Print Functions.......ccercevereeeee. 87

Deleting or Updating a
Printer Driver ....cccccivvvcsnnsnncsnnsnnnees 98

Note

* The examples in this chapter use Windows WordPad for explanations. Depending on the
application, the screens and operations procedures may differ.

= For detailed explanations of the printer driver and utility setup items, see "Online Help".

= Due to printer driver and utility version upgrades, actual operations may be different from the
descriptions in this manual.
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Printer Driver Functions Table

Printer Driver Functions Table

This section explains the convenient functions when printing from a PC.

Reference

= For detailed explanations of the printer driver setup items, see "Online Help".

Explanation of Functions

Windows PCL Printer Driver Functions

[User-defined paper]

[Setup] Tab

5 Afinia LTSC Label Printer PCLE Printing Preferences

(Doe_ I

Hili="" — t
[ 2 [ rowescns gtz () |

1 ille

t|3 Eape . 1C) i

s ] 1

i | (Those _|
(5 [Dome
G o o [
|7 ® o ki
| b Oy & ’ - -
i 8 Item Description
[ e e (1| Paper Name Enter the name of the paper

b AFINIA LABEL,

settings you want to register.
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(2| Registered user-| Shows a list of paper settings
defined paper that have been registered.
Item Description @) Size Specifies either millimeters
Lid or inches as the unit for input
(] Example Shows what printing results values.
wil _be basef:l on currenF . (@) Print position Adjusts the print start position
settings. This example is just -
. - correction on the paper edge.
an approximation and does not
indicate the exact actual humber (8)| Cut position Adjusts the cut position when
of print pages and cut positions. correction cutting and printing roll paper.
@ Paper settings | Specifies, from among (6)| Media Form Specifies the paper setting type
registered paper settings, to be registered. .
which one should be applied for Size input items change in
printing. accordance with this setting.
(@ Orientation Specifies the print orientation. ([ Media Type Specifies the paper type.
@] Copies Specifies the quantity to be printed. (8| Media Weight | Specifies the paper thickness.
& Cut Mode Specifies the timing to cut roll paper )| Sensor settings | Specifies the settings, from
when cutting and printing on it. among those registered on the
@ Quality Specifies the resolution during device, to be used for printing.
printing. 10| Sensor Click to calibrate the gap of
@[ Screen Specifies the halftoning available Adjustment blagk mark or die-cut Iabe_ls, and
with the device register the results as device
. sensor settings.
8/ User-defined Clic_k when using the driver to This button is not displayed for
paper register paper settings to be media forms that do not require
used for printing. calibration.
@ Paper .interval B_efore printing tp black mark or av| Printer Obtains, from devices, the
detection die-cut labels, click to execute information names of settings registered as
learning on the device to acquisition sensor settings and the names
imprpve the print position before of user types registered as
starting. paper types, and reflects them
Ngte that executing this function in the sensor settings and paper
will cause some paper to be used. type list on the printer driver.
@[ About Displays the printer driver
version information.
17| Default Restores default settings.




Printer Driver Functions Table

[Color] Tab

[Extend] Tab

= Afinia LTSC Label Printer PCLG Printing Preferences X | i Afinia LTSC Label Printer PCL6 Printing Preferences X
€ Erverites 4 Ervorres
T 1 Current setting Sove. Mansgement T 1 Current setbing v Sove Mansgement
2 -/]-\-;g.crr.';.s. 2 |
4 s 14 4] Vistesmarts. You can prins data created by 40 application with & watesmark over &
ﬁl‘ 3 Detas} § 3
L §
“F] T s
= (@ sgetcotor e s
: < :
8 | _ 8
‘/@wx-ma. g oif
9 ]
r:‘ ) 0o not save 100% iack temer ﬁ
b AFINIA LABH Ot b AINIALABLL Adanes Ot
Carcel oty Heo Carcel Ioy Heo
Item Description Item Description
(1) | Color Mode Selects either color printing (I | watermarks Sets when implementing
or monochrome printing. stamp printing.
V\I/_hﬁ_n colgr |s_|seljgct?d, N @ | Fonts Configures TrueType and
clicking [Detail] displays the printer font settings.
Detail" dialog box, which can
be used to configure detailed
color printing settings.
@ | Spot Color Specifies how white toner
should be used for printing.
@ | Toner Saving Specifies the print density
when economizing on toner.

[Overlays] Tab

@ Afinia LTSC Label Printer PCLE Printing Preferences x
Setp Cokr  Owelrs Gmend
Eooghe  prcire
T 1 Current setting Sove. Mansgement
2
1 D nct use cveray print
i3
7 Nome Oesenption
|4
§
TS
6
7
8
9
1
b AINIA LA Detmt
Crei | [ n |
Item Description
Overlays Specifies whether or not a

form should be overlaid on the
document to be printed, or
whether the document should be
registered as a new form in the
device.




Table of Setting Items in the Control Panel Menu Screen

Table of Setting Items in the Control Panel Menu
Screen

Device Setup Screen

Item Description

Configuration View device information (total number of sheets, remaining consumable quantity,
system information, etc.)

Print Information Print the settings, usage report, error log, color profile list, and user media lists for
this machine.

Menus Used to configure system settings, print position adjustment, color, and other
settings.

Admin Setup Administrator sets the network settings, changes passwords, etc.

Print Statistics Check the print use status of the user.

Calibration Used to adjust the color densities and shades, color misalignment, etc.

Boot Menu Set whether or not to restart the printer when a malfunction occurs in the HDD or
file system, etc.

Item Description
Feeder Count Unwinder nnnnnn Displays the total print quantity for the unwinder. (This
is the number of sheets converted into the A6 size paper
from the length of paper fed from the unwinder.)
Supplies Life Cyan Print Cartridge Remaining Shows the remaining service life (%) of each color's print

nnn% cartridge.

Magenta Print Cartridge| Remaining
nnn%

Yellow Print Cartridge | Remaining
nnn%

Black Print Cartridge Remaining
nnn%

White Print Cartridge | Remaining
nnn%

Waste Toner Box Remaining Shows the remaining service life (%) of the waste toner
nnn% box.

Belt Remaining Shows the remaining service life (%) of the belt unit.
nnn%

Fuser Remaining Shows the remaining service life (%) of the fuser unit.
nnn%
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Table of Setting Items in the Control Panel Menu Screen

Item Description
Network Printer Name FRkxxx*kkxx [ Shows the printer name used by the DNS and Network
>k 3k 5k 3K 3K > 3 K 5k K PnP.
>k 3k 5k 3K 3K > K K 5K K %
Short Printer Name | *¥*xx** Displays the short printer name.
>k 3k 3k 5k 5k K K %
IPv4 Address XXX.XXX.XXX. | Shows the IP address. When TCP/IP is enabled, shows the
XXX setup of the following control panel setting [Admin Setup]
> [Network Setup] > [IPv4 Address].
Subnet Mask XXX.XXX.XxX. | Displays the subnet mask. When TCP/IP is enabled, shows
XXX the setup of the following control panel setting [Admin
Setup] > [Network Setup] > [Subnet Mask].
Gateway Address XxX.XxX.xxx. | Displays the gateway address. When TCP/IP is enabled,
XXX shows the setup of the following control panel setting
[Admin Setup] > [Network Setup] > [Gateway Address].
MAC Address XX XX XX: Shows the MAC address.
XX 1XX: XX
Network FW Version | xx.xx Shows the network firmware version.
Web Remote Version | xx.xx Shows the web page version.
IPv6 Address (Local) | xxxx:xxxx:xx | Shows the (local) IPv6 address. This menu is not displayed
XX IXXXX:XXXX | when TCP/IP is disabled or when the IP version is IPv4.
IXXXX T XXXX X
XXX
IPv6 Address XXXX:XXXX: XX | Shows the (global) IPv6 address. This menu is not
(Global) XX:Xxxx:xxxx | displayed when TCP/IP is disabled or when the IP version
IXXXXIXXXX:X |is IPv4.
XXX
System Serial Number XXXXXXXXXX Displays the serial number.
XXXXXXXXXX
XXXXXX
Asset Number XXXXXXXXXX Displays the asset number of the printer manager.
XXXXXXXXXX
XXXXXXXXXXXX

Firmware Version

XXX.XX_X_X

Shows the version number of FirmSuite.

CU Version XX. XX Displays the control unit firmware version.

PU Version XX.XX. XX Displays the printer unit firmware version.

RAM xxXxMB Shows the total availability of all mounted RAM.

Flash Memory XXMB[Fxx] Displays the total availability of all flash memory and flash

system versions installed.

HDD

XX.XXGB [Fxx]

Displays the HDD size and file system version installed.

Date and Time

mm/dd/yyyy
or

dd/mm/yyyy

Displays the current date and time.
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Table of Setting Items in the Control Panel Menu Screen

[Print Information]

Item Description

Configuration Execute Prints the device setup details.

Demo Page DEMO1 Execute Prints the demo pages.

File List Execute Prints the file list.

Usage Report ™ Execute Prints the total print results.

Error Log Execute Prints the error log.

Color Profile List Execute Prints the color profile list.

User Media List * Execute Prints the user media list.

Test Print-1 Execute Prints the patterns for analyzing the print quality.

Test Print-2 Execute Prints the patterns for analyzing the CMYK print
quality.

Test Print-3 Execute Prints the patterns for analyzing the status of the
print cartridges.

Test Print-4 Execute Prints the patterns for analyzing print quality of the
spot colors.

Cleaning Page Execute Prints the toner-free white sheet to remove dirt
from the surface of the fuser belt in the fuser unit.

*1: Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.
*2: Displayed when the user media is registered.
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Table of Setting Items in the Control Panel Menu Screen

B Unwinder Config

= Shaded areas are factory-set values.

Description
Specifies the shape of the roll paper.

Value
Continuous Paper

Item

Media Form

Continuous Paper
(Black Mark)
Die-cut Label (Gap)
Die-cut Label (Black

Mark)
Continuous Label
Continuous Label
(Black Mark)

Liner Width Config Liner Width  Auto Specifies the mode for setting the width
Mode Custom of the label’s liner.
Auto:
The width of the liner is set given that
the label is in the center of the liner.
Custom:
The width of the liner is input and the
left gap is calculated given that the left
and right gaps are different.
Liner Width  29.4 millimeter Inputs the width of the liner.
(1.16 inch) Appears when the [Liner Width Mode] is
1 [Custom].
105.6 millimeter
(4.16 inch) The initial values vary depending on your
109.0 millimeter operating environment.
(4.29 inch)
l
130.0 millimeter
(5.12 inch)
Right Gap 2.0 millimeter Specifies the distance from the right edge
(0.08 inch) of the label to the right edge of the liner.
l
25.4 millimeter
(1.00 inch)
Paper Size A6 Sets the size of the paper for the
4x6 inch unwinder.
Custom

The initial values vary depending on your
operating environment.

X Dimension

25.4 millimeter
(1.00 inch)
l

101.6 millimeter
(4.00 inch)
105.0 millimeter
(4.13 inch)

l

126.0 millimeter
(4.96 inch)™

Sets the width of the custom paper sizes
for the unwinder.

Sets the dimension perpendicular to the
paper feed direction.

The initial values vary depending on your
operating environment.

*1:130.0 mm (5.12 inch) if the [Media Form] is [Continuous Paper] or [Continuous Paper (Black Mark)]
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38 Shadedareasarefactory-setvalues.

Item Value Description
Y Dimension 12.7 millimeter Sets the length of the custom paper sizes
(0.50 inch) for the unwinder.
2 Sets the same direction as for the
101.6 millimeter dimension in the paper feed direction.
(4.00 inch) If the setting is 101.6 mm (4.00 inch) or
! lower, then the set page length is handled
148.0 millimeter as a whole-number multiple of the actual
(5.83 inch) length of the page such that it exceeds
152.4 millimeter 101.6 mm (4.00 inch).
(6.00 inch)

l
1320.8 millimeter
(52.00 inch)

The initial values vary depending on your
operating environment.

Appears when the Media Form is
[Continuous Paper], [Die-cut Label
(Gap)], [Die-cut Label (Black Mark)] or
[Continuous Label].

Black Mark Interval

Gap Length

15.9 millimeter
(0.63 inch)

l
101.6 millimeter
(4.00 inch)

l
151.2 millimeter
(5.95 inch)
155.6 millimeter
(6.13 inch)

l
1324.0 millimeter
(52.13 inch)

3.0 millimeter
(0.12 inch)

l

10.0 millimeter
(0.39 inch)

Sets the interval of the marks on custom
paper for the unwinder.

Sets the same direction as for the
dimension in the paper feed direction.

If the setting is 104.8 mm (4.13 inch) or
lower, then the set page length is handled
as a whole-number multiple of the actual
length of the page such that it exceeds
101.6 mm (4.00 inch).

The initial values vary depending on your
operating environment.

Appears when the Media Form is
[Continuous Paper (Black Mark)] or
[Continuous Label (Black Mark)].

Sets the interval for labels.

Sets the same direction as for the
dimension in the paper feed direction.
Appears when the Media Form

is [Die-cut Label (Gap)] or

[Die-cut Label (Black Mark)].

Adjust Cut Position

-0.5 millimeter
(-0.02 inch)

l
0.0 millimeter
(0.00 inch)

1§
+0.5 millimeter
(+0.02 inch)

Specifies the compensation value for

the distance from the print completion
position to the cut position (beginning of
next label). (Specifies margin on following
edge)

If you specify a negative value, cutting is
done at a short position.
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Table of Setting Items in the Control Panel Menu Screen

38 Shadedareasarefactory-setvalues.

Item

Value

Description

Media Type

Plain

Plain Labels
Glossy Labels
Film Labels1
Film Labels2
Film1

Film2
USERTYPE1™
USERTYPE2™
USERTYPE3™
USERTYPE4™
USERTYPE5™
USERTYPE6™
USERTYPE7™
USERTYPES™
USERTYPE9™
USERTYPE10™
USERTYPE11™
USERTYPE12™
USERTYPE13™
USERTYPE14™
USERTYPE15™
USERTYPE16™
USERTYPE17™
USERTYPE18™
USERTYPE19™
USERTYPE20™

Sets the type of the paper for the
unwinder.

Media Weight

Light

Medium Light
Medium
Medium Heavy
Heavy

Ultra Heavyl
Ultra Heavy2

Sets the thickness of the paper for the
unwinder.

Sensor Setting

Ultra Heavy3

Setl :
Set2 :
Set3 :
Set4 :
Set5 :
Setb6 :
Set7 :
Set8 :
Set9 :
Setl10 :

Sets the sensitivity of the gap sensor or
black mark sensor.

Only the adjusted sensor setting is
displayed.

Appears when the [Media Form] is
something other than [Continuous Paper]
or [Continuous Label].

*1: USERTYPE 1 to 20 are displayed when they are registered.
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Item

Value

Description

Sensor
Calibration

Check Media

Setl :

Set2 :
Set3 :

Set4 :

Set5 :
Setb6 :
Set7 :
Set8 :
Set9 :
Set10 :

Pitch

Execute Calibration

Adjust Reflective

Execute

Q

Executes calibration of the gap sensor or
black mark sensor.

Eine tunes the sensitivity of the reflective

Slice
Level

Sensor in
Unwinder

Reflective

1023

sensor in the unwinder that was measured
during Sensor Calibration.

The default value fluctuates according to
the results of the calibration.

Appears when the black mark sensor is
used.

Eine tunes the sensitivity of the reflective

Sensor in
Printer

Transmission

1023

sensor in the device that was measured
during Sensor Calibration.

The default value fluctuates according to
the results of the calibration.

Appears when the black mark sensor is
used.

Fine tunes the sensitivity of the

Sensor in
Unwinder

Transmission

1023

transmission sensor in the unwinder that
was measured during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.

Appears when the gap sensor is used.

Sensor in
Printer

Fhangp Name

1023

Execute

Fine tunes the sensitivity of the
transmission sensor in the device that
was measured during Sensor Calibration.
The default value fluctuates according to
the results of the calibration.

Appears when the gap sensor is used.

You can change the name of the specified

Reset QpH’ing

Execute

setting numbers.

You can use up to eight characters of
single-byte upper case English and
numbers.

Initializes the content of the specified

Execute

setting numbers.
Measures the intervals on the paper

Appears when the [Media Form] is
something other than [Continuous Paper]
or [Continuous Label].
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Hm Cutter Setup

e Shaded areas are factory-set values.

Item Value Description
Cut Mode Job Specifies the cutting operation.
Collation Job:
Specified Interval Cuts at the end of a job.
Collation:

Cuts at the end of the job and at the end of the job collation.
Specified Interval:

Cuts in units of the specified number of pages. Cuts at the end

of the collation/job.

Cut Interval

9999

Sets how many pages are cut each time.
Appears when the [Cut Mode] is [Specified Interval].
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m System Adjust

e Shaded areas are factory-set values.

Item

Value

Description

Power Save Time

1 minute

2 minutes
3 minutes
4 minutes
5 minutes
10 minutes
15 minutes
30 minutes
60 minutes

Sets the time until the printer enters power save
mode.

Auto Power Off Time

1 hour
2 hours
3 hours
4 hours
8 hours
12 hours
18 hours
24 hours

Sets the time until the printer enters OFF mode
from stand-by status.

Clearable Warning

ONLINE
Job

Sets the timing until clearable warning display turns
OFF.

Timeout InJob

Off

5 seconds
10 seconds
20 seconds
30 seconds
40 seconds
50 seconds
60 seconds
90 seconds
120 seconds
150 seconds
180 seconds
210 seconds
240 seconds
270 seconds
300 seconds

Sets the time from loss of the receipt of data until
force-printing.
With PS, the job is canceled without printing.

Timeout Local

0 seconds
5 seconds

40 seconds
290 seconds

295 seconds
300 seconds

Sets the time for each port to be kept opened after
printing. (Excludes network)

Timeout Network

0 seconds
5 seconds

90 seconds
290 seconds

295 seconds
300 seconds

Sets the time for the network port to be kept
opened after printing.

Error Report On Specifies whether to print error reports when an
Off internal PCL or PS error occurs.
Hex Dump Execute Prints received data in QR code.

Turn off the power to stop printing the hex dump.
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H Print Adjust

e Shaded areas are factory-set values.

+0.1 millimeters

+2.00 millimeters
-2.00 millimeters

0.1 millimeters

Item Value Description

Print Position |X Adjust 0.00 millimeters Adjusts the overall image print position perpendicularly

Adjust +0.1 millimeters (horizontally) in the direction of paper feed (0.1 mm
t intervals).
+2.00 millimeters
-2.00 millimeters
l
-0.1 millimeters

Y Adjust 0.00 millimeters Adjusts the overall image print position in the direction of

paper feed (vertically) (0.1 mm intervals).

Paper Edge Detect Mode

Model
Mode2
Off

Set the action of the controls for the leading edge of the
media to avoid image skew and detection position skew
of the leading edge of labels.
Model:
For long leading edges, this setting automatically cuts/
outputs and then starts printing. For short leading
edges, printing just starts. (Applicable for the gap/
black mark setting)
Mode2:
For short or long leading edges, this setting
automatically cuts/outputs and then starts printing for
both situations.
(Applicable for the gap/black mark setting if the
leading edge is long. If the leading edge is short, then
only the gap setting is applicable.)
Off:
With this mode, the user straightens the leading edge
so paper is not wasted. (Applicable for the gap/black
mark setting)

Roll Paper End Detect Mode

Auto
Stop
Forced Cut

Sets the control for ejecting the trailing edge of the

paper to auto, stop feeding, or forced cut.

Auto:
With this mode, the trailing edge is processed
appropriately according to the media.

Stop:
With this mode, feed is forced to stop when the trailing
edge of the paper is detected, regardless of the length
or type of media.

Forced Cut:
With this mode, the system is forced to cut and eject
the paper when the trailing edge of the paper is
detected, regardless of the length or type of media.

Media Transfer Setting Black

Performs fine adjustment if black is faded or tiny white
spots appear when printing with the black (K) print
cartridge only (when printing with the YMCW print
cartridges are raised).

Lower the setting value if there are only fewer white
spots, or raise the setting value if the high-density
portion is thinner.

Media Transfer Setting Color

Performs fine adjustment if colors are faded or tiny
white spots appear when printing with two or more print
cartridges or just the white (W) print cartridge.

Lower the setting value if there are only fewer white
spots, or raise the setting value if the high-density
portion is thinner.
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38 Shadedareasarefactory-setvalues.

Item Value Description
SMR Setting  Cyan 0 Compensates for uneven print density due to
t temperature and humidity, and printing quantity, using
+3 cyan. Raise the setting value if it is blurred. Lower the
-6 setting value if the density darkens partially.
t * Continued use with the setting value raised has a risk
-1 of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
0 Compensates for uneven print density due to
t temperature and humidity, and printing quantity, using
+3 magenta. Raise the setting value if it is blurred. Lower
-6 the setting value if the density darkens partially.
Magenta ! * Continued use with the setting value raised has a risk
-1 of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
0 Compensates for uneven print density due to
2 temperature and humidity, and printing quantity, using
+3 yellow. Raise the setting value if it is blurred. Lower the
-6 setting value if the density darkens partially.
Yellow ! * Continued use with the setting value raised has a risk
-1 of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
0 Compensates for uneven print density due to
2 temperature and humidity, and printing quantity, using
+3 black. Raise the setting value if it is blurred. Lower the
-6 setting value if the density darkens partially.
Black | * Continued use with the setting value raised has a risk
-1 of printing stains.
* Continued use with the setting value lowered has a risk
of blurring.
0 Compensates for uneven print density due to
2 temperature and humidity, and printing quantity, using
+3 white. Raise the setting value if it is blurred. Lower the
. -6 setting value if the density darkens partially.
White ! * Continued use with the setting value raised has a risk
-1 of printing stains.

* Continued use with the setting value lowered has a risk
of blurring.
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38 Shadedareasarefactory-setvalues.

Item Value Description
BG Setting Cyan 0 Compensates for print results variation due to differences
+1 in the temperature and humidity, using cyan. Lower the
+2 setting value if the underlay is dark.
+3 * Continued use with the setting value lowered has a risk
-3 of printing stains.
-2
-1
Magenta 0 Compensates for print results variation due to differences
+1 in the temperature and humidity, using magenta. Lower
+2 the setting value if the underlay is dark.
+3 * Continued use with the setting value lowered has a risk
-3 of printing stains.
-2
-1
Yellow 0 Compensates for print results variation due to differences
+1 in the temperature and humidity, using yellow. Lower the
+2 setting value if the underlay is dark.
+3 * Continued use with the setting value lowered has a risk
-3 of printing stains.
-2
-1
Black 0 Compensates for print results variation due to differences
+1 in the temperature and humidity, using black. Lower the
+2 setting value if the underlay is dark.
+3 * Continued use with the setting value lowered has a risk
-3 of printing stains.
-2
-1
White 0 Compensates for print results variation due to differences
+1 in the temperature and humidity, using white. Lower the
+2 setting value if the underlay is dark.
+3 * Continued use with the setting value lowered has a risk
-3 of printing stains.
-2
-1
Drum Cleaning On Sets whether to implement drum cleaning before
Off printing. The image quality may be improved.
Transfer Roller Cleaning Execute Implements cleaning of the 2nd transfer roller unit.
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Item Value Description
Transfer Cyan Transfer 0 Lower the setting value if lateral-stripe white dots and
Setting Setting dark streaks appear for cyan, green and blue toner.

Raise the setting value if the high-density portion of
cyan, green and blue is thinner.

Magenta Transfer
Setting

Lower the setting value if lateral-stripe white dots and
dark streaks appear for magenta and/or red toner.
Raise the setting value if the high-density portion of
magenta and/or red is thinner.

Yellow Transfer
Setting

Lower the setting value if lateral-stripe white dots and
dark streaks appear for yellow toner.

Raise the setting value if the high-density portion of
yellow is thinner.

Black Transfer
Setting

Lower the setting value if lateral-stripe white dots and
dark streaks appear for black toner.

Raise the setting value if the high-density portion of
black is thinner.

White Transfer
Setting

Lower the setting value if lateral-stripe white dots and
dark streaks appear for white toner.

Raise the setting value if the high-density portion of
white is thinner.

OlhLb+r++olu b+ ++0l L L +++0l L L+ + 40000+ ++
S|IPNVNYWHNR PNWLHR (PN OR PNWOHN R HNW G =

DV Roller Cleaning 1 Adjust the toner disposal threshold.

Off On:
Image quality priority
Off:
Toner life priority
DV Roller Cleaning 2 Mode 1 May be effective against lateral striping caused by
Mode 2 variations in ambient temperature and/or humidity. Try
Off mode 2 if desired results are not produced by mode 1.
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Note

= To enter this menu, it is necessary to enter the [Password].

= The factory default setting of the administrator password is [999999].

B Network Setup

= Shaded areas are factory-set values.

Item Value Description

TCP/IP Enable Enables/disables TCP/IP protocols.
Disable

NetBIOS over TCP ™ Enable Enables/disables NetBIOS over TCP/IP.
Disable

IP Address Set ™ Auto Specifies whether to request the IP address
Manual from the DHCP server.

IPv4 Address ™ XXX.XXX.XXX. Sets the IP address.
XXX

Subnet Mask ™™ XXX.XXX.XXX. Sets the subnet mask.
XXX

Gateway Address ™ XXX.XXX.XXX. Sets the gateway address.
XXX

Web ™ Enable Enables/disables access using web browsers.
Disable

Telnet ™ Enable Enables/disables access using Telnet.
Disable

FTp ™! Enable Enables/disables access using FTP.
Disable

IPSec ! Enable Enables/disables access using IPsec.
Disable

SNMP ™ Enable Enables/disables access using SNMP.
Disable

Network Scale Normal Normal:

Small Printer operates effectively even if
connected to a hub with spanning tree
functions. However, printer startup
time becomes longer when two or three
computers are connected to a small-scale
LAN.

Small:
Covers small scale LANs with 2 or 3 PCs
to large scale LANs are covered, but if
connected to a hub with spanning tree
functions, operations may not be effective.
Gigabit Network Enable Sets whether to support a Gigabit network.
Disable
Hub Link Setting Auto Negotiate Sets the connection mode to the hub.
100Base-TX Full

100Base-TX Half

10Base-T Full

10Base-T Half

Network Factory Defaults Execute Restores the settings, such as network, mail
server, LDAP server, and secure protocol
server, etc., to their default values.

*1: Appears when [Enable] is set on the control panel for [TCP/IP].
*2: Appears when [Manual] is set on the control panel for [IP Address Set].

- 63 -



Table of Setting Items in the Control Panel Menu Screen

m USB Setup
e Shaded areas are factory-set values.
Item Value Description

usB Enable Enables/disables access using a USB interface.
Disable

Speed 480Mbps Sets the maximum baud rate using a USB interface.
12Mbps

Soft Reset Enable Enables/disables the software reset command.
Disable

Serial Number Enable Enables/disables the USB serial humber.
Disable The USB serial number is used to identify USB

devices connected to a PC.

Offline Receive Enable Sets whether to receive data even if offline or a

Disable recoverable error occurs.
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H Print Setup

e Shaded areas are factory-set values.

Except 100%
Black

Item Value Description
Personality Auto Select the print language. Print language switching
PCL is automatic when set to [Auto].
PostScript
Copies 1 Sets the copy quantity.
t This setting is ignored in case of local print.
9999 This setting is disabled unless the [Job Copy]
setting is 1.
Job Copy 1 Sets the print quantity.
This setting is ignored in case of local print.
999 The settings in the printer driver always overwrite
these settings.
* This setting is enabled only if [Collate] is checked
and 1 is specified as the number of copies in the
PCL printer driver.
Edge to Edge On Sets the print margin.
Off
Resolution 600dpi Sets the resolution.
1200dpi
Toner Save Toner Save Level Off Set the toner save quantity.
Low Specifies [Off] when toner save mode is disabled.
Middle
High
Color All All:

All colors, including 100% black, comprise all the
target colors for toner saving.

Except 100% Black:
All colors, excluding 100% black, comprise all the
target colors for toner saving.

Check Unnecessary Print Cartridge On Set whether to generate an error or continue
Off printing when a print cartridge is detected to
be down even though it is not being used as a
specified color for the print data.
On:
An error is displayed and the print job is
cancelled, to give priority to the service life of
the print cartridge.
Off:
A warning screen is displayed, but printing
continues because priority is given to
productivity.
Default Orientation Portrait Sets the print orientation.
Landscape
Trapping Off Sets trapping.
Narrow
Narrow /
Choke White
Wide
Wide / Choke
White
Choke White

- 65 -




Table of Setting Items in the Control Panel Menu Screen

m PS Setup

e Shaded areas are factory-set values.

Item Value Description
Network Protocol ASCII Specifies the PS communication protocol mode for
RAW data from the network.
USB Protocol ASCII Specifies the PS communication protocol mode for
RAW data from USB.
m PCL Setup
= Shaded areas are factory-set values.
Item Value Description
Font Source Resident Sets the location of the fonts to be used.

Downloaded

PC-8 Dan/Nor
PC-8 Grk
PC-8 TK
PC-775
PC-850
PC-851 Grk
PC-852
PC-855
PC-857 TK
PC-858
PC-862 Heb
PC-866
PC-866 Ukr
PC-869
PC-1004

Pi Font
Plska Mazvia
PS Math

PS Text
Roman-8
Roman-9
Roman Ext
Serbo Croatl
Serbo Croat2
Spanish
UCS-2
Ukrainian
VN Int'l

VN Math

VN US

Win 3.0

Win 3.1 L/G
Win 3.1 BIt

Font Number™ I0 Sets the numbers of the fonts to be used.
S1
Font Pitch 0.44 CPI Sets the font width.
2 Increases and reduces in 0.01 CPI units.
10.00 CPI Displayed when the font selected using [Font
Number] is an outline font with fixed spacing.
99.99 CPI
Font Height 4.00 points Sets the font height.
Increases and reduces in 0.25 point units.
12.00 points |Displayed when the font selected using [Font
Number] is an outline font with variable spacing.
999.75 points
Symbol Set PC-8 Select the symbol set.

*1: Refer to "Resident Fonts” (P.71) about the Font Number to be used.
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Item Value Description

Symbol Set Win 3.1 Cyr Select the symbol set.
Win 3.1 Grk
Win 3.1 Heb
Win 3.1 L1
Win 3.1 L2
Win 3.1 L5
Wingdings
Dingbats MS
Symbol
OCR-A
OCR-B
OCRB Subset?2
HP ZIP
USPSFIM
USPSSTP
USPSZIP
Bulgarian
CWI Hung
DeskTop
German
Greek-437
Greek-437 Cy
Greek-737
Greek-8
Greek-928
Hebrew NC
Hebrew OC
Hebrew-7
Hebrew-8
IBM-437
IBM-850
IBM-860
IBM-863
IBM-865
ISO Dutch
ISO L1

ISO L2

ISO L4

ISO L5

ISO L6

ISO L9

ISO Swedish1
ISO Swedish2
ISO Swedish3
ISO-2 IRV
ISO-4 UK
ISO-6 ASC
ISO-10 S/F
ISO-11 Swe
ISO-14 JASC
ISO-15 Ita
ISO-16 Por
ISO-17 Spa
ISO-21 Ger
ISO-25 Fre
ISO-57 Chi
ISO-60 Nor
ISO-61 Nor
ISO-69 Fre
ISO-84 Por
ISO-85 Spa
ISO-Cyr
ISO-Grk
ISO-Hebrew
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Item Value Description
Symbol Set Kamenicky Select the symbol set.
Legal
Math-8
MC Text
MS Publish
PC Ext D/N
PC Ext US
PC Set1l
PC Set2 D/N
PC Set2 US
CR Function CR Specifies the operation when a CR code is received.
CR+LF
LF Function LF Specifies the operation when an LF code is
LF+CR received.
Print Margin Normal Sets the area of the paper where printing is not
1/5 inch possible.
1/6 inch
1/8 inch
1/12.5 inch
True Black On Specifies whether to use mixed CMYK or black
Off toner only for printing black of image data.
Pen Width Adjust On Compensates so that thin lines are visible.
Off
m Color Setup
= Shaded areas are factory-set values.
Item Value Description
Ink Simulation Off Sets the ink simulation. This setting is enabled only
SWOP for PS language jobs.
ISO Coated
Japan
UCR Low You can select the black plate (black) amount
Normal during color printing.
High Setting more black plate economizes on the toner
of the other three colors.
CMY 100% Density Enable Enables/disables 100% output for CMY 100% shade
Disable values.
CMYK Conversion On You can select the method of total toner quantity
Off control for CMYK data. Select [Off] to disable GCR
(Gray Component Replacement). Furthermore, this
menu setting is disabled if using the ink simulation
function.
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® Panel Setup

e Shaded areas are factory-set values.

Item Value Description
Idle Display Supplies Life |Sets the information displayed in the standby
Unwinder Config| screen.
Panel Brightness During Operation 5 Adjusts the brightness (backlight luminosity) of the
t control panel LCD.
31 The set brightness is applied during control panel
operations.
Panel Brightness While Power Save 0 Adjusts the brightness (backlight luminosity) of the
control panel LCD.
1 The set brightness is applied after the panel
l backlight timer time has elapsed from the last
31 operation.
Panel Backlight Timer 10 Adjusts the time (in seconds) from the last
t operation until [Panel Brightness While Power Save]
30 is applied.
l
300
B Time Setup
= Shaded areas are factory-set values.
Item Value Description
Date Format yyyy/mm/dd Sets the date display mode.
mm/dd/yyyy The initial values vary depending on your
dd/mm/yyyy operating environment.
Time Zone -12:00 Sets the time difference from GMT in 15-minute
) units. If the time zone setting is changed, the
+0:00 time differences before and after the change are
t reflected in the current time.
+13:00
Daylight Saving On Sets whether to display daylight saving time.
Off On:

Sets the current time 1 hour forward.
Off:
Sets the current time 1 hour back.

Time Setting

2000/01/01 00 :00

1

2091/12/31 23 :59

Sets the time.

® Power Setup

= Shaded areas are factory-set values.

Item Value Description
Power Save Enable Enables/disables power save mode.
Disable
Auto Power Off Enable Sets auto power off mode.
Auto Config
Disable
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B Others Setup

e Shaded areas are factory-set values.

Item Value Description
RAM Setup Receive Buffer Size Auto Sets the incoming buffer size that is assured by the
0.5 MB local interface.
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB
Resource Save Auto Sets the resource saving area size.
Off
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB
Storage Check File System Execute Implements management data (FAT information)
Common recovery, and resolves mismatches between the
Setup actual (free) space in the file system and the free
space displayed.
Check All Sectors Execute Recovers defective sector information on the HDD and
file system nonconformances.
Enable Initialization No Specifies whether or not to authorize setup changes
Yes associated with HDD and flash memory initialization.
Language Select Language Chinese Specifies the control panel display language.
Setup English
French
German
Italian
Japanese
Russian
Spanish
Language Initialize Execute Deletes the message files that have been downloaded.
Also, the [Select Language] setting returns to the
factory default setting.
Job Cancel Cancel Key Behavior Short Sets the operations when the device <CANCEL>
Setup Long button is pressed.
Off Short:
Hold down no longer than two seconds to cancel the
print job.
Long:
Hold down for 2 to 5 seconds to cancel a print job.
Off:
Disables the <CANCEL> button.
Inquiry Display On Sets whether to display the enquiry screen when a
Off job is canceled.
Focus Position Yes Sets whether to apply [Yes] or [No] focus for selection
No in the job cancellation enquiry screen.
Display Timeout 60 Sets the display timeout value for the enquiry screen
when a job is canceled.
180
300
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* Shaded areas are factory-set values.

Item Value Description
Media Inquiry Display On Specifies the operation when the <FEED> button or
Operation Off the <UNLOAD> button is pressed.
Setup On:
In the cases below, a confirmation screen is
displayed before the operation is executed.
<FEED>: When the paper changes from a stand-by
state to a through paper state
<UNLOAD/CUT>: When cut is executed
Off:
Operation is performed without displaying a
confirmation message.
Rewinder Distance 600 millimeter Specifies the amount to be fed when the <FEED>
(24 inch) button is pressed in the stand-by state, using the
900 millimeter output slot as the reference point.
(36 inch)
1200 millimeter
(48 inch)
Feed Distance 150 millimeter Specifies the amount to be fed when the <FEED>
(6 inch) button is pressed in the through paper state, using
300 millimeter the current position as the reference point.
(12 inch)
450 millimeter
(18 inch)
B Settings
= Shaded areas are factory-set values.
Item Value Description
Reset Settings Execute Restores the user menu settings to the factory
settings.
Save Settings Execute Saves the current menu settings.
Restore Settings™ Execute Changes the saved menu settings.

*1: Displayed when [Save Settings] is executed on the control panel.

m Change Password

= Shaded areas are factory-set values.

Item

Value

Description

New Password

3k 3K 3K 3k KK K K >k kK K

Sets a new password to be entered in the [Admin
menu] and [Boot Menu].

Verify Password

3K >k 3k 5K 5K kK >k kK kK k%

Sets a new password to be entered in the [Admin
menu] and [Boot Menu] for which [New Password]
has been set.

B Resident Fonts

Item Font Name List
10 Courier
11 Courier Bold
12 Courier Italic
I3 Courier Bold Italic
14 CG Times
15 CG Times Bold
16 CG Times Italic
17 CG Times Bold Italic
18 CG Omega
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Item Font Name List
19 CG Omega Bold
110 CG Omega Italic
111 CG Omega Bold Italic
112 Coronet
113 Clarendon Condenced
114 Univers Medium
115 Univers Bold
116 Univers Medium Italic
117 Univers Bold Italic
118 Univers Medium Condensed
119 Univers Bold Condensed
120 Univers Medium Condensed Italic
121 Univers Bold Condensed Italic
122 Antique Olive
123 Antique Olive Bold
124 Antique Olive Italic
125 Garamond Antique
126 Garamond Halbfett
127 Garamond Kursiv
128 Garamond Kursiv Halbfett
129 Marigold
130 Albertus Medium
131 Albertus Extra Bold
132 Letter Gothic
133 Letter Gothic Bold
134 Letter Gothic Italic
135 Arial
136 Arial Bold
137 Arial Italic
138 Arial Bold Italic
139 Times New
140 Times New Bold
141 Times New Italic
142 Times New Bold Italic
143 ITC Avant Garde Gothic Book
144 ITC Avant Garde Gothic Demi
145 ITC Avant Garde Gothic Book Oblique
146 ITC Avant Garde Gothic Demi Oblique
147 ITC Bookman Light
148 ITC Bookman Demi
149 ITC Bookman Light Italic
150 ITC Bookman Demi Italic
151 Courier PS
152 Courier PS Bold
153 Courier PS Oblique
154 Courier PS Bold Oblique
155 Helvetica
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Item Font Name List
156 Helvetica Bold
157 Helvetica Oblique
158 Helvetica Bold Oblique
159 Helvetica Narrow
160 Helvetica Narrow Bold
161 Helvetica Narrow Oblique
162 Helvetica Narrow Bold Oblique
163 New Century Schoolbook Roman
164 New Century Schoolbook Bold
165 New Century Schoolbook Italic
166 New Century Schoolbook Bold Italic
167 Palatino Roman
168 Palatino Bold
169 Palatino Italic
170 Palatino Bold Italic
171 Times Roman
172 Times Bold
173 Times Italic
174 Times Bold Italic
175 ITC Zapf Chancery Medium Italic
176 Symbol
177 Symbol PS
178 Wingdings
179 ITC Zapf Dingbats
180 OCRB Subset2
181 Line Printer
182 OCR-A
183 OCR-B
184 USPS POSTNET Bar Codes

< Scalable: 81 fonts (No.I0-80)
< Bitmap: 4 fonts (No.I81-84)

<& Total 85 fonts
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= To enter this menu, it is necessary to enter the [Password].

= In the default factory settings, the password is [0000].

= Shaded areas are factory-set values.

Item Value Description

Usage Report Enable Enables/disables the Usage Report function.
Disable

Supplies Report™ Enable Sets whether or not to display the nhumber of
Disable consumables replacements.

Reset Main Counter™ Execute Resets the main counter aggregate value.

Reset Supplies Counter™ Execute Resets the number of consumables replacements.

Change New Password *kokx Sets the new password to be entered in [Print

Password™ Statistics].

Verify Password Hrokx Sets a new password to be entered in the [Print
Statistics] for which [New Password] has been set.

*1: Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.
*2: Not displayed if [Disable] is set for the control panel [Supplies Report] item.
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= Shaded areas are factory-set values.

Item Value Description
Auto Density Mode On Sets whether to automatically compensate density
Off and shade.

Adjust Density Execute Implements density compensation. Implement
when the device is in stand-by status.

Adjust Registration Execute Implements auto color misalignment compensation
operations. Implement when the device is in stand-
by status.

Color Density Cyan Density -3 Adjusts the cyan density.

t This setting is enabled from printing after the
0 density compensation has been implemented.
l
+3

Magenta Density -3 Adjusts magenta density.
2 This setting is enabled from printing after the
0 density compensation has been implemented.
l
+3

Yellow Density -3 Adjusts yellow density.
2 This setting is enabled from printing after the
0 density compensation has been implemented.
l
+3

Black Density -3 Adjusts black density.
! This setting is enabled from printing after the
0 density compensation has been implemented.
l
+3

White Density -3 Adjusts white density.
2 This setting is enabled from printing after the
0 density compensation has been implemented.
l
+3

Print Color Tuning Pattern Execute Prints patterns to match the shading characteristics.

Base Color Highlight A-1 Matches the color balance for the parts displayed as

Tuning A-2 most clear in the highlight area of the printed color

B-1 tuning pattern.
B-2 The matching results are reflected in the highlight
t matching values for cyan, magenta, and yellow
O-1 matching.
0-2
Mid-Tone A-1 Matches the color balance for the parts displayedas
A-2 most clear in the mid-tone area of the printed color
B-1 tuning pattern.
B-2 The matching results are reflected in the mid-tone
) matching values for cyan, magenta, and yellow
O-1 matching.
0-2
Dark A-1 Matches the color balance for the parts displayed
A-2 as most clear in the dark area of the printed color
B-1 tuning pattern.
B-2 The matching results are reflected in the dark
! matching values for cyan, magenta, and yellow
O-1 matching.
0-2
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Fine Color
Tuning

Item Value Description
Cyan Tuning Highlight -4 Matches the highlights (light areas) of the cyan
t shade characteristics.
0
l
+4
Mid-Tone -4 Matches the intermediate areas of the cyan shading
t characteristics.
0
l
+4
Dark -4 Matches the dark (dark areas) of the cyan shade
l characteristics.
0
l
+4
Magenta Highlight -4 Matches the highlights (light areas) of the magenta
Tuning l shading characteristics.
0
l
+4
Mid-Tone -4 Matches the intermediate areas of the magenta
l shading characteristics.
0
l
+4
Dark -4 Matches the dark (dark areas) of the magenta
l shading characteristics.
0
l
+4
Yellow Highlight -4 Matches the highlights (light areas) of the yellow
Tuning l shading characteristics.
0
l
+4
Mid-Tone -4 Matches the intermediate areas of the yellow
l shading characteristics.
0
l
+4
Dark -4 Matches the dark (dark areas) of the yellow shading
2 characteristics.
0
l
+4
Black Tuning Highlight -3 Matches the highlights (light areas) of the black
t shading characteristics.
0
l
+3
Mid-Tone -3 Matches the intermediate areas of the black
l shading characteristics.
0
l
+3
Dark -3 Matches the dark (dark areas) of the black shading
2 characteristics.
0
l
+3
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Item

Value

Description

Reset Color Tuning

Execute

Resets CMYK color matching.

White Tuning  Highlight -3 Matches the highlights (light areas) of the white
t shading characteristics.
0
l
+3
Mid-Tone -3 Matches the intermediate areas of the white
t shading characteristics.
0
l
+3
Dark -3 Matches the dark (dark areas) of the white shading
t characteristics.
0
l
+3

Density Adjustment Media

Standard Media

Narrow/Thick
Media

Specifies the operation speed during a density
adjustment operation.
Standard Media:
Density adjustment operation performed at
normal speed.
Narrow/Thick Media:
Density adjustment operation performed at low
speed.
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Note

= This menu is displayed in English only.

H Boot Menu

Note

= To enter this menu, press and hold the <OK> button while turning ON the power supply.
« Confirm that [Boot Menu] is selected and then press the <OK> button.

= To enter this menu, it is necessary to enter the [Password].

= The factory default setting of the administrator password is [999999].

= Shaded areas are factory-set values.

Item Value Description
Storage Check File System Execute Executes management data (FAT information)
Common recovery, and resolves mismatches between the
Setup actual (free) space in the file system and the
displayed free space.
Check All Sectors Execute Recovers defective sector information on the HDD
and file system nonconformances.
Menu Lockout On Specifies whether or not to display menus on the
Off control panel.
Panel Lockout Model Sets whether to disable the operations buttons on
Mode2 the control panel.
Off

B Troubleshooting

= To enter this menu, press and hold the <OK> button while turning ON the power supply.
« Select [Troubleshooting] and then press the <OK> button.

Item Value Description

Sensor Calibration Reset Execute This resets all sensor calibration results to initial
values.
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Saving Toner When Printing

i Windows PCL printer driver
Savmg Toner When Open the file tc?be printed.

Printing (Toner Save
Mode)

You can print by economizing the toner Select [Print] in the [File] menu.
consumption amount by reducing the page print
density. Separately enable or disable the toner

lick [Preferen P i .
economy mode for 100% black. Click [Preferences] (or [Properties])

On the [Color] tab, use [Toner Saving]
to select a toner save quantity.

|:> | 8 Afinia LTSC Label Printer PCL Printing Preferences X
| So G Ovedors Bt

~ooprd -

Congle Farvorites.

1 Current gatting v Sove Managermens.
2 Solor Mede: ® Color
Memo il e -
B i [ Always create 100% lack (K) tooer
-] O Monochreene
* You can suppress the quantity of toner used by selecting f 5 -
one of the following five patterns as necessary to reduce o wcee B
toner density. l:l
5 T
- Printer setting: Follows the printer’s setup. 5
- Off: Prints using regular density without economizing 5 I oo o |
the toner. = (00 it ave 00% btck tomer
- Save Level Low: Prints using medium light toner. | ANATABIL ot
- Save Level Middle: Prints using light toner. ‘ Grod || mwr | e
- Save Level High: Prints using considerably light toner.
= [Toner Saving] is enabled only if the print quality is 5 Print.
specified as [Normal] or [Draft].

= The settings on the printer can be changed from [Admin
Setup] > [Print Setup] > [Toner Save]. However, the
printer driver settings are given priority.

= Toner save mode is hot compatible with Spot Color
printing.
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the Specified Print Cartrid

e Only (Lift Up)

The lifespan of an unused print cartridge can be prolonged by separating it from the belt unit.

Setting combinations are shown in the table

below.

Print Color

Print Cartridge to be
Lifted Up

Black (K) only

Cyan, magenta, yellow,
white*

White* (W) only

Black, cyan, magenta,
yellow

Black + white*

Cyan, magenta, yellow

Black, cyan, magenta,
yellow

White*

Example: Printing using the CMYK Print Cartridge

only

In this example, the White (W) Print Cartridge is

lifted up.

1 Grasping the Top Cover Open Lever,
open the Top Cover.

2 Check the position of the unused print

cartridge via the label letters and color.
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Turn the lift up lever on the print
cartridge that is not being used
clockwise to raise the print cartridge.

= When closing the Top Cover, there is a risk of
pinching your fingers at the Top Cover support point
and Top Cover. Press the top of the Top Cover to
close it.

= When closing the Top Cover while grasping the LED

head, there is a risk of pinching your fingers or
hands. Press the top of the Top Cover to close it.



Fine Quality Printing

Fine Quality Printing

Changing Print Quality

(Resolution)

Set [Quality] by aligning to the environment in
which it is used.

Memo

« Selecting [Fine/Detail(1200x1200 dpi)] prints at the
highest quality available with the printer.

B Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

On the [Setup] tab, change the [Quality]
setting.

8 Afinia LTSC Label Printer PCLE Printing Preferences x

Sehp Cokr  Ovedas Extend

Meda Woght  Medum Light (56:140 pm

ool Frvortes
Defauit cetting v Sove.. Management..
Peper settngs Continuous 4.000 x 64050 v User-defined paper...
g" format: Continucus Paper
- Medsa Type Plain
:
H
4

Ogjentation : @Potmar O Landscape Chger I Migror Print
Copres: 1B [ Cotate [ eretin reverse order

2 To prcritize collabion spectied by application

_|||aon\nauvaw~v-'
e

Lot Mode: Dby cut ot the end of job
Fine / Detail (1200 1200) v [ Picto Enhance
Screeq: Prioetae resohstion
b AINIALABIL Apeat.. Defagh

o [ | il [ e

5 Print.

Making Photograph
Printing More Vivid (Photo

Enhance)

You can print more natural and vivid images,
such as photos, etc.

* This function can be used with Windows PCL printer
drivers only.

B Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).

On the [Setup] tab, select [Photo
Enhance] in the [Quality] section, and
then click [OK].

~ 00

& Afinia LTSC Label Printer PCLG Printing Preferences X
Sebo  Cok Ovedays  Exterd
Erample Favortes
1 Defauit cotting S Minagement..
2 Peper setbngs: Continuous 4000 x £.200n v User-defined papes...
%’ 3 format: Contoucus Paper
13 Media Type Plain
2 Moo Woght  Medurm Light (96140 ym)
e|a
H
£ s Ogientation: @Potra  (landscape g CIMiror Print
6 Copres: 1 v I Cotate [ Print in 1gverse order
2 To proritize celtabion spectied by application
7 Cue Mode: nly <ot ot the end o job
8
9 Quelty: Fine / Detail (1200 1200)
= Screeq Prontae resohtion
b AINATABIT Apect. Defayht
[ = -

5 Print.



Fine Quality Printing

Adjusting Fine Lines

You can prevent misaligned lines being printed
when ultra-fine lines are specified from the
application.

This function is normally ON.

Memo

= Depending on the application, bar code and other intervals
will narrow. In this case, turn OFF the function.

® Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click [Advanced].

= Afinia LTSC Label Printer PCLG Printing Preferences X
Setp Cokr  Ovedan Eterd
Canple Favortes
1 Cursent sesting v Sove Management.
2
b Woetermarks.. You created by o wtha L3
fl3
% Fy Fonts... Makes settings releted to Truelype feots and penter foots
i
5
6
7
8
9
b ALNIATABIL Advanged.. Defaght
o o | s e

5 Select [Adjust ultra fine lines]. Next,
select [Off] for [Settings], and then
click [OK].

Advanced X

tem Setting
Recluce Size of Spool File on
Keep page layout when resizing document off
Overprint Black

Adjust ultra fine lines
Run maintenance cycle before printing Off
Trapping Printer setting

Settings on -

Description

Adjustment of fine lines remedies the problem that the outline of rectangles
bulges when printed.

Concel | [t || et

6 Print.

Using Printer Fonts

You can print by replacing TrueType fonts with
printer built-in fonts.

* The font replacement function stores the document
fonts, but font designs cannot be reproduced. If it is
necessary to print font designs accurately, disable the font
replacement function.

= In some applications, the font replacement function may
not work properly.

B Windows PCL Printer Driver

1 Open the file to be printed.

Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).

O PO

4 Click the [Extend] tab, and then select

[Fonts].
= Afinia LTSC Label Printer PCLG Printing Preferences X
Setp Cokr  Ovedams Eterd
Cumgle Favertes
1 Current seeting v Sove Management..
2
- Wetermarks... You can print deta created by an apphcation with @ watermark over it.
f|3
?—_‘. 4 Fonts... akes settings related to TrueType foots and panter fonts.
§
'S
6
7
8
9
b AINIALADI Adangea. Oetayn
[ [




Fine Quality Printin

On the "Font" screen, select the [Font

Substitution] check box.

For this printer, this check box is selected as the

default setting.

Font

TrueType Fent Qutput Type
(") Download as Outline Font

@®Download as Bitmap Font|

Font Substitution

Font Substitution Table

dl

For TrueType Font: Use Printer Font:

Arabic Transparent (Mot Substituted) -
Arial AvantGarde

Arial Baltic Bookman

Arial Black Helvetica-MNarrow

Arial CE MewCenturySchlbk

Arial CYR Palatino

Arial Greek ZapfChancery

Arial TUR CourierP5

Bahnschrift Helvetica hd

Using Computer Fonts

You can output TrueType fonts as they appear on
the screen.

Note

* Print time may be longer.

B Windows PCL Printer Driver

Open the file to be printed.

Select [Print] in the [File] menu.

Cancel Help Default

Use the [Font Substitution Table] to
specify which printer fonts should
replace the TrueType fonts.

Print.

O~ LWPNO -

6

Click [Preferences] (or [Properties]).

On the [Extend] tab, click [Fonts].

On the "Font" screen, clear the [Font
Substitution] check box.

= Download as Outline Font
Font image is created by the printer.

= Download as Bitmap Font
Font information is created by the printer
driver.

Font X

TrueType Font Qutput Type
(O) Download as Outline Font

(®) Download as Bitmap Font

Fent Substitution Table

For TrueType Font: Use Printer Font:

Arabic Transparent -~ (Mot Substituted) A
Arial AvantGarde

Arial Baltic Bookman

Arial Black Helvetica-Narrow

Arial CE NewCenturySchibk

Arial CYR Palating

Arial Greek ZapfChancery

Arial TUR CourierPs

Bahnschrift hd Helvetica hd

Cancel Help Default

Print.



Adjusting the Print Position on the Paper

Adjusting the Print Position on the Paper

You can correct the print start position vertically and horizontally on the paper by the printer settings.

Please refer to the following procedure.

Using the roll paper 3 Pressthescrollbuttona or ¥ toselectthe

item you want to adjust.

i Print Position Adjust 11 Page

& @ < Adiust

O Use Online button to return to s...

Paper feed

direction

4 Press the <OK> button.

[V 4 mmillimeter
{-2.0-+42.0)
1 Press the <Fn> key.
The numerical values input screen will
be displayed.
MENU ON LINE Switch +/-

O3

ABC DEF

5 Pressthescrollbuttona or ¥ toselectthe

GHI  JKL  MNO amount of the adjustment, and then press

C
~ @ @ the <OK> button. Confirm there is a check
v
@ © mark (¥) tothe left of the selected value.
Fn CLEAR : ]
ATTENTION

| " Zikgmillimeter
(-2.0-+2.0)

2 Press <2>, <2>, <0> (function
numbers), and then press the <OK>
button.

Function Number

2208
Enter 1-3digit Number

|E3 Switch +/-

Note

= Y represents the paper feed direction and X represents the
orthogonal position relative to the paper feed direction.

e Set positive [+] numbers to widen the blank space in the
X direction, and also set positive [+] numbers to widen
the blank space in the Y direction.

= Readjustment might be necessary depending on the usage
conditions (temperature, humidity, media type).

« By eliminating the differences between printers and using
the same settings on all the printers with this procedure,
you can use one computer when you want to get the
same print results on multiple printers. Refer to “Using
the Printer Driver to Fine-tune the Print Position” (P.16)
about setting the computer.

-84 -



Adjusting the Print Position on the Paper

Adjusting the Position

That Printing Starts

This section explains how to better align the
position at which printing starts for die-cut label
paper (with black mark), continuous label (with
black mark), and die-cut label paper.

This adjustment is unnecessary if your print jobs
do not require accurate positioning of where
printing starts.

Adjust the position that printing starts
on the first page.

2)

After setting the size of the
mediacalibrate the sensor
and execute Paper interval
detection.

In the driver’s print settings, set[To
specify the number of pages per

cut] in [Cut Mode] and set [1] in
[Page(s) per cut].

= You may not be able to set [1] in [Page(s) per

cut] if the paper on which you are printing is
shorter than 101.6 mm. If this is the case, set
the smallest value that you can select.

Print five pieces of the media on
which you are actually printing.

Measure the distance at A or B
as shown in the diagram, for all

five sheets and then calculate the
average of these values.

Calculate the difference in the
position you want to print and the

average value from (4).

Adjust the position using [Y Adjust] in

[Menus]>[Print Adjust]>[Print
Position Adjust].

( T
When using a black
mark sensor

- -
When using a gap
sensor

At the point that the
black mark intersects
the position of the
black mark sensor on
the printer, measure
the distance at A from
the leading edge of
the black mark to the
printed matter on five
sheets.

Label Black mark sensor
Paper  on the printer
Printed
matter \V4

\ comes

At the point that
the label intersects
the position of the
gap sensor on the
printer, measure the
distance at B from
the leading edge

of the label to the
printed matter on
five sheets.

Gap sensor on the
printer

Liner{m—x—%

Leading edge
ofblackmark

N 7

Y\

Cutting off part of
the label makes

measuring easier.

Memo

= About Print Position Adjust (Y Adjust)
Plus and minus direction for Y adjust

Direction that media is fed

If you set Y Ad-
just in the minus
A direction, the im-
age moves up

If you set Y Ad-
just in the plus
direction, the im-
age moves down




Adjusting the Print Position on the Paper

2

3

If you are actually printing more than
two sheets consecutively, then next, do
the following adjustment.

(Improve the accuracy of the function
for learning the position that printing
starts)

(]_) In the driver’s print settings, set[To
specify the number of pages per

cut] in [Cut Mode] and set [20] in
[Page(s) per cut].

(2) Print 20 pieces as a test print (*).
* These printouts are test prints

for adjusting positions, so throw
them away when you are done.

The adjustments are complete when
printing is done in the position you
want.

Reset the cutter settings, and then start
printing.



Other Print Functions

Other Print Functions

Specifying the Page Order

Extracts by page order when printing documents
with multiple pages.

There are two methods.

« Printing documents in page order.

= Printing documents in reverse page order.

B Windows PCL Printer Driver

1 Open the file to be printed.

Select [Print] in the [File] menu.

On the [Setup] tab, select the [Print in

3 Click [Preferences] (or [Properties]).
4 reverse order] check box in the [Copies]

area.
% Afinia LTSC Label Printer PCLG Printing Preferences
S0 Colr  Oweian Gownd
Liamgl Evortes
1 Octaut setting o Management.
2 Paper settings: Cortnuews 4.000 x 6.000m User-gefined pager.
i mat: Continuous Paper
3 deds Ty o
i a leda Weight v Light (5- 140 pm)
i
g 5| Ovems oo - ) Landseape %
P [
6
spplc
7 Aode
8
9 & e / Detall (1200 x 1200) heeo Enhanc
'——‘ Scre Prosbze reschaicn
b ALNIATABIL pow Odta

Overlaying Stamps for

Printing (Watermarks)

The details to be printed from the application can
be independently printed overlaying [Samples],
[Confidential], etc.

>

Samples

B Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click

[Watermarks].
&% Afinia LT5C Label Printer PCL6 Printing Preferences
So Cor  Owdapy e
Lamgie roortes
1 Cument setting v Seve Management
2
| —-—
il
iha
§
5
6
7
8
9
b AUNIALAR Advanges odmn
: Cancel Hon -




Other Print Functions

5 Click [New].

Watermarks x

Watermarks

First page only

lob information
[]Print job information Job information settings

First page only

QK Cancel Help Default

On the "Watermarks" screen, enter text
into [Text], and configure [Size] and
other settings.

Watermarks X

Text
| secret]

Size:

2] « .

Angle:

< >

-180 0 +180

Font... Color...

Trim Bosition
(®) None Centre ~
() Circle
() Single Frame
(O Double Frame

Watermark Adjustment

w0 w0

Cancel Help

7 Click the <OK> button.

8 Print.

Collating Printed Output

(Sorted Printing)

You can store print jobs in the device memory
and collate the printing.

Printing by specifying batches

[ [
[ [
X 2 sets E>
3 3
1

Printing without specifying batches

HstetsE>
1

= Not usable with some applications.

B Windows PCL Printer Driver

1 Open the file to be printed.

Select [Print] in the [File] menu.

On the [Setup] tab, enter a value for

3 Click [Preferences] (or [Properties]).
4 [Copies], and then select the [Collate]

check box.
5 Afinia LT5C Label Printer PCL6 Printing Preferences
SO0 Colw  Owdan Boend
Lamgle Eovortes
1 Curment setting v Sove Menagement_
2 Paper settings Continuses 4000 x £000n - User-gefined paper...
i format: Continwous Paper
- 3 Meda Type Plan
i § Meda Weight  Medhem Light (56-140 pm
i
g 2 Opertation O [ Meror Pt
3 Copren [Pt in rgverse coder
[T grortize collstion speciied by spplication)
1 Lot Mode Ondy cut at the end of job
2
3 Guatey: Fine / Detadl (1200 x 1200) v [)Pheto Enhance
T Screeny Pricetse reschstien v
b ALNALABL Ao odnn

e R e

5 Print.



Other Print Functions

a Mirror Image

Print using mirror print when you want to print
image to appear normal when the page is viewed
from the back.

B Windows PCL Printer Driver

Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

Fle ESe Vma ook

5
=1
e b

-~
1o

3 Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].

Select [General] tab, and then click
[Preferences].

5 On the [Setup] tab, select the [Mirror
Print] check box in the [Orientation]
section, and then click [OK].

@

P e & BB
+

I
<
€
Y
e
]
LY
8
e
[2_

b AITNIA LAWY, oo cann

Open the file to be printed.

Select [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and then click [OK].

Select [Print] in the [File] menu.

O© OO0 O

1

Click [OK] to return to the "Print"
screen.

Click [Print] in the "Print" screen to
print.



Other Print Functions

Printing Registered Forms On the [Overlays] tab, select [Register
print document as a new form].

(Print Overlay)

You can register forms, logos, etc., as forms to T —— x
the device, and overlay for printing. i pak
T T Current setting(Default setting) v Save.. Management...
2] Regrster print document a5 a new form v
i[5 C )
i Name 0 Description
Memo 1o
5
= To print an overlay, you need to create a form and register a
it in advance.It is possible to specify a maximum of four 5
forms in one group.Forms are overlaid and printed in the i
order they are registered. That is to say, the last form you =
register is printed on top. 2]
b AINIA AR Detaut
B Windows PCL Printer Driver Rl
Click [Start] and select [Control Panel] Memo

in [Windows System].
= If the form you want to print is already registered to
the device, you do not need to do steps 5 through 10.

2 Click [View devices and printers]. Advance to step 11 of this procedure.
& o - e o ' Click [Apply] > [OK] to close the
- “Printing Preferences” screen.
‘ :'_" : . e Afinia LTSC Label Printer PCL6 Printing Preferences x
\ﬂ. ll‘,“ Euample :':,.;.m::
1] Current setting(Default setting) v Save... Management...
- gj 3} Namq [ Description
S o/ .
g 5
6/
7}
'8/
Right-click the [LT5C PCL6] icon, and 2]
then select [Printing preferences]. b ALNA LA | —
I[T|| WI ooy l Heo

Click the [Overlays] tab.
T T —— = 7 From the application, print the image
you want to register as a form.

SMO Cor  Ovelan Boend

amgie Evvornes
1 Octaut setting See Management
2 Poper setiga: Continusas 4.000 x 6.000m - User-gefined poger... .
ils o Commaton Confirm that the [New Form] screen
5 Meda Type Plan
i Meda Weght  Medrem Light (36-143 pm)
s appears.
g 5 Opentation e
Copres New Form X
6
; Registration information for printer
Cot Mose Form name:
8 D:
9 [ Fine / Detall (1200 ¥ 1300) v [)Pheto tnhance Registered overlay offset
= P Proskse rschaicn x [000 13 inch v [000 (20 inch
b AVINALABIL Agowt. ety
Registered information for driver
o Cancal e
Print on Pages: | All pages v
Custom Pages

Enter page numbers and/or page ranges separated by
commas. For eample. 135-12

[ Test print of the form after registration

Cancel Help




Other Print Functions

9 Input the [Form name] and [ID], and Perform the following operation to
then click [OK]. close the “Printing Preferences” screen:

New Form X [‘ ‘ppIY] > [C K]'
Registration information for print @ Afinia LTSC Label Printer PCLS Printing Preferences X
Form namef 0
See Cow  Owion Bawd

1D: Uamgie Eavortes
Registered overlay offset Cument setting v Sve Management.
X [000F%] inch ¥ [000 15 inch
Overlay Prnt
i Name ) Descriptien [
Registered information for driver

2 et Pt
Print on Pages: Al pages v § T
Custom Pages:

Enter page numbers and/or page ranges separated by
commas. For example, 1.3,5-12

[ Test print of the form after registration

|ownmmvmnn

—
b AINALADIL oot

1 The form is sent to the device and ‘ ot ks
registered with the specified ID. 14 Print from the application.

On the [Overlays] tab, select [Overlay
Print].

@ Afinia LTSC Label Printer PCL Printing Preferences x

.
L Cument setting o hanagement
' " Overtay Pret
} “ Nan ) Descriphi 9 bt
il ) T
4
]
AY
8
Q
=

£ ALINIA LAWY ount

Select the forms you want to use for
overlay printing.

1 Afinia LTSC Label Printer PCLE Printing Preferences x

Swo Cow Owion Gased
Lampie Ervortes

I Curent setting v Seve Denagement
<
' Overay Pret
e "
i - -
il® | J
§ Test i
e
]
AY
8
Qe

1
4 ALINIATAB oot
Cocd || mon e



Other Print Functions

Outputting to a File

Without Printing

You can write and save to a file without printing
the print data.

= PC administrator privileges are required.

B Windows PCL Printer Driver

1
2

o1 -~

Click [Start] and select [Control Panel]
in [Windows System].

Click [View devices and printers].

5 5
- g -
bl @:=

Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].
Select the [Ports] tab.

In the ports list, select [FILE:], and
then click [OK].

5 Prol050 PCLE Properties x

Print.

Enter the file name, and then click [OK].

Changing the Check

Unnecessary Print
Cartridge Setting

You can have an error displayed and cancel

the print job to prioritize the service life of a
print cartridge that is detected to be down even
though it is not being used as a specified color
for the print data.

1 Press the scroll button A or v,

Acun ON LINE

N LPLRP
BACK

<0K> GHI JKL MNO
~ DO ®

v PQRS TUV WXYZ
S OO
Fn CLEAR

ATTENTION

2 Select [Admin Setup], and then press
the <OK> button.

Functions 111 Page‘
n Configuration
Print Information

a Menus

B E] Print Statistics

B Calibration
(1) Use Online butten to return to standby screen.

3 Enter the administrator password, and
then press the <OK> button.

Memo

* The factory default setting of the administrator
password is [999999].

Enter Password

|
{6 - 12 digits )

(L) Use Online button to return to standby screen.



Other Print Functions

Select [Print Setup], and then press the
<OK> button.

Admin Setup 1/2 Page|
n Network Setup

USB Setup

a PS Setup

PCL Setup

B Color Setup

ngl Page

Select [Check Unnecessary Print
Cartridge], and then press the <OK>
button.

Print Setup 2/2 Page
n Check Unnecessary Print Cartridge

Default Orientation

ﬂ Trapping

nglPage

6 If you want an error to be generated
when a print cartridge is detected to be
down even though it is not being used
as a specified color for the print data,
select [On]. Select [Off] if you want
printing to continue. Then, press the
<OK> button.

(L) Use Online button to return to ..

Press the <ON LINE> button to return
to the standby screen.

MENU ON LINE
R olole)
Baci ABC  DEF
@ > ®
@ Cance GHI  JKL  MNO
@OE®®
v PQRS TUV WXYZ
GO @O
Fn CLEAR

ATTENTION

Saving Printer Driver

Setups

You can save the details set using the printer
drivers.

If you save the changes to the settings for
multiple locations, then the next and following
times you change the settings, all you have
to do is specify the driver settings so that
those settings in the multiple locations are
automatically changed to the settings that you
saved.

Save a Setup

Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

o X

525
R ] % \

3 Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

Change the settings to create the setup
you want to save.

5 On the [Setup] tab, click [Save].

@ Afinia LTSC Label Printer PCLG Printing Preferences.

SO Colw  Owday Gamd

DE— E .
Py o 4 x v

User-gefined paper..

[T

e w v~ o0 v &8 w n w°
H

i
£

b ATNIALAD L bt Cetnat
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Enter the setting name into [Save
Favorites as], and then click [OK].

Save Favorites =

Save Favorites as:

| Save Favorites

Click [OK] to close the Print Setup
dialog box.

Recall a Saved Setup

Delete a Saved Setup

Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

On the [Setup] tab, configure
4 [Favorites].

# Afinia LTSC Label Printer PCLS Printing Prefe

SOO Cor  Ovelays Bowd

© ® N O

MEry
b ALNA LA

5 Print.

tre Panal

Fle [de Vmw Teck

rx

<

@ . ook
. 10 :‘

< @

~
1o

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

On the [Setup] tab, click [Management].

Click [Delete].

Select the setup you want to delete,
and then click [Delete].

Click [Yes].
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Importing/Exporting a

Printer Driver Print Setup

You can convert printer driver print setup
information to a file, and then export/import the
file. The file extension for exporting/importing is

Export a Setup

1
2

Click [Start] and select [Control Panel]
in [Windows System].

Click [View devices and printers].

2 Comtrel Paned

& i

g -

-~
1o

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

On the [Setup] tab, click [Management].

Click [Export].

Favaorites management x

Import..

In the [List of favorite settings] on the
"Export" screen, select the checkbox
next to the setup you want to export,
and then click [Export].

Export s

List of favorite settings

Save Favorites
Select All

Unselect

Display by paper form
Disglay all

Continuous Paper
Continucus Paper(black mark)
Die-cut label(gap)

Die-cut label(black mark)

[ Full Surface label

Full Surface label(black mark)

Enter a file name, specify where to save
it, and then click [Save].

Import a Setup

1
2

Click [Start] and select [Control Panel]
in [Windows System].

Click [View devices and printers].

N——

‘::‘.
% a1l

& Hard ;‘ ‘

-~
1o

Right-click the [LT5C PCL6] icon, and
then select [Printing preferences].

On the [Setup] tab, click[Management].
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5 Click [Import]. Changing Default Printer
x Driver Settings

T Evport.. Delete.
It is convenient to set frequently used settings
s Eicky as the default settings.
On the "Import" screen, click [Open the B Windows PCL Printer Driver
file].
Click [Start] and select [Control Panel]
Import X

in [Windows System].

List of favorite settings

Coee] 2 Click [View devices and printers].
B Contret Panet o X
SEIECta” T ED . Covtrel Panel
Uﬂ[ElECg File 9e Vmw Teck
ad
] Overwrite duplicate settings
[ Overwrite duplicate paper ‘ = -' - S.?‘ ;)—
Display by paper form . Network and internet E‘f Appe
[ Disglay all \ﬁ. e 3
Continuous Paper : : = -
[ Continuous Paper(black mark) - - = @ i
[ Die-cut label(gap) (\ - P
Die-cut label(black mark) J
A Eull Surface label
Full Surface label(black mark]
import Hep 3 Right-click the [LT5C PCL6] icon, and

then select [Printing preferences].
7 Specify the file you want to import, and
then click [Open]. Change the various settings, and then
click [OK].
Check the names of the settings in the
[List of favorite settings], and then click
[Import].

9 When the message "Imported
successfully." appears, click [OK].



Deleting or Updating a Printer Driver

Deleting or Updating a Printer Driver

Deleting a Printer Driver

B Windows PCL Printer Driver

= PC administrator privileges are required.
= Restart the computer, and then delete the driver.

Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

[

Fle St Vma Tock

Q- £ o
& % :

3 Right-click the [LT5C PCL6] icon,
and then select [Remove device].

If a verification message is displayed,
click [Yes].

Note

= If a message appears while the device is in use,
restart the PC, and then perform steps 1 and 2 of
this procedure again.

5 Select one of the icons in [Devices
and Printers], and click [Print server
properties] in the top bar.

6 Select the [Drivers] tab.

7 Click if [Change Driver Settings] is
displayed.

Select the driver to be deleted, and
click [Remove].

=5 Print Server Properties X

Forms Ports  Drivers  Securty Advanced

g. DESKTOP-G1GC40T

Installed printer drivers:

Name Processor Type

Microsoft enhanced Point... x64 Type 3 - User Mode
Microsoft enhanced Peint.. x86 Type 3 - User Mode

Microsoft Print To PDF xb4 Type 4 - User Mode
Llicroooft WPE oo e £l ped_llce
Pro1050 PCLE x 3 - User Mode

.....

Close

9 If a message asking whether to delete
the drivers only, or the drivers and
packages from the system, select to
delete drivers and packages, and click
[OK].

Remaowe Driver And Package

Do you want to remove the driver(s) cnly, or remove
the driver(s) and driver package(s) from your system?

() Remove driver only.

(®Remove driver and driver package.;

0K Cancel

1 If a verification message is displayed,
click [Yes].

If the [Remove Driver Package] dialog
box is displayed, click [Delete]>[OK].

Note

= If you cannot cancel, restart the PC, and then
perform steps 4 to 10 of this procedure again.

Click [OK] in the [Print server
properties] dialog box.



Deleting or Updating a Printer Driver

13 Restart the PC.

Note

= Network Extension and the Color Swatch Utility installed
together with the printer driver are not deleted even ifthe
printer driver is deleted.
To delete Network Extension and the Color Swatch Utility,
use [Control Panel] > [Uninstall a program].

Updating a Printer Driver

For information about the latest driver
versions, check the Afinia Label website.

B Windows PCL Printer Driver

Note

= PC administrator privileges are required.

1

QOO

Download the printer driver from
the Afinia Label website.

afinialabel.com/LT5Cinfo

Double-click the file you downloaded

Select the desired language, and then
click [OK].

Memo

< When the "User Account Control" window is
displayed, click [Yes].

Read the "Software License Agreement",
and click [Accept].

Follow the instructions that appear on
the screen to finish driver installation.

Memo

= Attempting to install an old version driver will cause
an update screen to appear. Follow the instructions
that appear on the screen.

= Updating a driver may require restarting of the
computer.

When the [Program Compatibility
Assistant] dialog appears, click [This
program installed correctly].


file:///C:/Users/andrews.MICROBOARDS/Documents/LT5C/Manuals/For%20Users/afinialabel.com/LT5Cinfo
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Adjusting Color with the Control Panel

Correcting Color Drift

Manually

The printer compensates color drift automatically
according to the conditions of use. If the color
drift is noticeable, you can also implement
compensation manually.

l Press the <Fn> key.

The numerical values input screen will
be displayed.

MENU ON LINE

O3

ABC DEF

GHI JKL  MNO

- ©®@

e TUV  WXYZ

PO

Fn CLEAR

ATTENTION

2 Press <3>, <0>, <1>, and press the
<OK> button.

Function Number

301
Enter 1-3digit Number

3 Check that [Execute] has been selected,
and press the <OK> button.

Adjust Registration 1/1 Page

O Use Online button to returnto s...

4 The display will return to the standby
screen.

Configuring Settings

for Auto Adjustment of
Density and Gradation

The printer compensates density automatically
according to the conditions of use. To
compensate automatically, turn [On] the density
compensation matching setting.

In the default factory settings, density
compensation matching is implemented
automatically.

1 Press the scroll button A or V.

LT ON LINE

5222

(0@ GHI JKL  MNO
~ D®®

PQRS TUV WXYZ

[ ®O@O

CLEAR

ATTENTION

Select [Calibration], and press the
<OK> button.

Functions
n Configuration
g Print Information

B Menus
ﬂ B Admin Setup
B Print Statistics

O Use Online button to return to standby screen.

11 Page\

Select [Auto Density Mode], and then
press the <OK> button.

Calibration 1/2 Page
n Auto Density Mode

B Adjust Density

B Adjust Registration

ﬂ Color Density

Print Color Tuning Pattern

B Base Color Tuning

ngl Page
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Select [On], and then press the <OK>
button. Confirm there is a check mark
(+) to the left of [ON].

Auto Density Mode 1/1 Page

Adjusting Density

U ELTETY

The printer can implement compensation
periodically using auto density compensation
mode, but if the print density is noticeable, it
can also be compensated manually.

Memo

) = Density adjustment values are set by specifying [Cyan
(© Use Online button to retum to s. . Density], [Magenta Density], [Yellow Density], [Black

Density], and [White Density] values with the control
Press the <ON LINE> button to return panel.

to the standby screen.

Menu | Onbie Press the <Fn> key.
Back 4 @ @ @ The numerical values input screen will
@ @ ]K®L @ be displayed.
CANCEL ON LINE
. PC;,;? gv%? MENU @ @ @
PO
ATTENTION GHI  JKL  MNO

e TUV  WXYZ
PO O©
Fn CLEAR

ATTENTION

Press <3>, <0>, <0>, and press the
<OK> button.

Function Number

3008
Enter 1-3digit Number

Check that [Execute] has been selected,
and press the <OK> button.

7 Adjust Density

O Use Online button to return to s...

4 Execute density adjustment.
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Adjusting Color with the Control Panel

The display will return to the standby Fine Tuning Density
screen after density adjustment is

complete.

Adjustments

Ready To Print You can finely adjust the densities of colors
that are used as the references for density
compensation.

e 3 e _— o Adjust each color separately for the parts where
the density is noticeable from the print results.
This section describes the procedure for

Yellw  Magenta  Cyan Black  White adjusting the reference density for cyan. Use the

same adjustment procedure also for other colors
that you wish to adjust.

= Increasing cyan after checking the print
results

1 Press the <Fn> key.

The numerical values input screen will
be displayed.

MEeNu ON LINE

O3

ABC DEF

GHI JKL MNO

UV WXYZ
™0 O©
Fn CLEAR

ATTENTION

2 Press <3>, <1>, <0>, and press the
<OK> button.

Function Number

3108
Enter 1-3digit Number

Memo

= For magenta, yellow, black, and white, use the
operations below.

- To tune magenta, press the <Fn> key, and then
press the following buttons: <3>, <1>, <1>,
<OK>.

- Totune yellow, press the <Fn> key, and then
press the following buttons: <3>, <1>, <2>,
<OK>.

- To tune black, press the <Fn> key, and then press
the following buttons: <3>, <1>, <3>, <OK>.

- To tune white, press the <Fn> key, and then
press the following buttons: <3>, <1>, <4>,
<OK>.
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Adjusting Color with the Control Panel

Press the scroll button a or ¥ to specify
a value that is larger than the current
value, and then press the <OK> button.

Confirm there is a checkmark (¥) to
the left of the selected value.

Switch +/-

Memo

e Select +1 to +3 to make density darker, or -1 to -3
to make it lighter.

Press the <ON LINE> button to return
to the standby screen.

MENU ON LINE

O3

ABC DEF

@ ®®

GHI JKL  MNO

CANCEL @ @

PQRS TUV WXYZ

olole

CLEAR

ATTENTION

Press the <Fn> key, and then press
<3>, <0>, <0>, <OK>.

Function Number

3000
Enter 1-3digit Number

Check that [Execute] has been selected,
and press the <OK> button.

Adjust Density

n Execute

(L) Use Online button to return to s...

7 The display will return to the standby
screen.
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Print.

If you are not satisfied with the density,
repeat steps 1 to 6 of this procedure.



Adjusting Color with the Control Panel

Adjusting Color Balance Use the print results for the color tuning
= attern to check the current color
(Density) P
balance.
The printer can implement compensation
periodically using auto density compensation
mode. However, you can implement this Color Tuning Pattern
adjustment when you want to adjust the gray i
balance of the halftones, which is not sufficiently O A i i i i i o i e
adjusted by the auto density compensation.
C:DN“e g R
O P OO I D
= The densities of the colors are mutually dependent on R .......-.......
each other, so you will need to repeat adjustment several o i b e I Rl
times until the desired color balance is achieved. |4 A | | | L T

* The results of the basic [Base Color Tuning] are reflected
in the settings in [Fine Color Tuning]. Consequently, if the
[Fine Color Tuning] are adjusted manually, these settings
will be reset, so be careful. However, the [Black Tuning] Color Tuning Pattern
settings are not reset. Fine Color Tuning

Highlight Mid-Tone Dark
i

Print a color tuning pattern. R
(1) Press the <Fn> key. : ’

M nta ' ‘ :_"
The numerical values input screen @ PN En.
will be displayed. Yetow ! ' ‘
MENU ON LINE

olole - A

GHI JKL MNO 1
CanceL Check the area to be referenced
@ @ ( ) using “Base Color Tuning”.
Check the numbers (A1,2 to O-1,2)
0 ! !
C?? ) %2 of the pattern that seems the
ATTENTION

most similar to the adjacent CMY
mixed colors part and single color

(2) Press <3>, <0>, <2>, and press K part from among the patterns
the <OK> button. distributed in the “Highlight”,
Function Number “Mid'Tone", or “Dark” areas.
3020
Enter 1-3digit Number Memo
L

e If the pattern that seems most similar to the
adjacent CMY mixed colors part and single color K
part in the “Highlight”, “Mid-Tone"”, or “Dark” areas
matches the “Current” on the left of the colortuning
pattern, the color balance is normal and does not
require adjustment.

(3) Check that [Executeg has been Use the print results for the color tuning

Eilégt:d’ and press the <OK> pattern to adjust the color balance.

(1) Press the scroll button A O v

Areans ON LINE

= Va jelele

ABC DEF

®O®®
B o 222

PQRS TUV WXYZ

©®@O

CLEAR

(L) Use Online button to return to s...

ATTENTION

(4) The colortuning pattern will be printed.
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Adjusting Color with the Control Panel

(2) Select [Calibration], and press the (7) The pattern number specified in
<OK> button. each area will be displayed.
S — LiaRags If the pattern number is correct,
S‘f”:'f’“fra“""t_ select [Yes], and press the <OK>
8 Mens button.
aE'Admin Setup ' Apply Values? 1/1 Page
E' Print Statistics

B Calibration

O Use Onling button to return to standby screen.

(3) Select [Base Color Tuning], and
press the <OK> button.

Calibration 1/2Page, B W
n Auto Density Mode
BAdjust Density Memo
N
B st egl.Stratmn « To respecify the pattern number select [No] to
(B Color Density return to the "Calibration" screen.
Print Color Tuning Pattern
(8) Select [Return], and press the <OK> button
@B 1/ Page to return to the standby screen.

Finished Adjusting. 1/1 Page
| High Light: A-1
Mid. Tone: C-2
Dark: B-2

Return

(4) Specify the number of the desired
square in the "Highlight" area of the
pattern, and then press the <OK>
button.

O Use Online button to returnto s...

@ vero

e If the desired color balance is not obtained even

B/ Page after [Base Color Tuning], adjust the CMY color
o balance manually using the procedure under
Specify the number of the desired [Adjusting the color balance]. For color balance
. WA " fine tuning, see “Fine-tuning Color Balance”
square in the "Mid-Tone" area of the (P.106).
pattern, and then press the<OK> = If the overall tone is still too bright or too dark

button even after implementing [Base Color Tuning],
adjust the black tone manually using [Fine
Color Tuning], and then implement [Basiccolor
Tuning] again. To brighten the overall tone,
adjust the black tone in [Fine Color Tuning] in
the - direction, and to darken the overall tone,
adjust the black tone in [Fine Color Tuning] in
the + direction.

BTIlPage

(6) Specify the number of the desired
square in the "Dark" area of the
pattern, and then press the <OK>
button.

BTIlPage
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Check the color balance adjustment Fine-tuninag Color Balance

results.
The printer can implement compensation

(]_) Print the color tuning pattern. periodically using auto density compensation
mode. However, you can implement this
(2) Use the print results for the adjustment when you want to finely adjust
color tuning pattern to check the the gray balance of the halftones, which is
adjusted results. not sufficiently adjusted by the auto density

compensation.
If the pattern that seems most

similar to the adjacent CMY mixed Note
colors part and single color K part
in the “Highlight”, “*Mid-Tone” = The densities of the colors are mutually dependent on

. " ! ! each other, so you will need to repeat adjustment several
or “Dark” areas matches the times until the desired color balance is achieved.
“Current” on the left of the color
tuning pattern, the color balance 1 Print a color tuning pattern.
adjustment is complete.
Repeat steps 1 through 3 of this (]_) Press the <Fn> key.

procedure in accordance with the

results of your pattern check. The numerical values input screen

will be displayed.

MENu ON LINE

OO

ABC DEF

GHI JKL  MNO

e TUV  WXYZ

PO

Fn CLEAR

ATTENTION

(2) Press <3>, <0>, <2>, and press
the <OK> button.

Function Number

3028
Enter 1-3digit Number

(3) Check that [Execute] has been
selected, and press the <OK>

button.

| Print Color Tuning Pattern 1/1 Page

(L) Use Online butten to return to s...

(4) The color tuning pattern will be
printed.
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Adjusting Color with the Control Panel

Use the print results for the color tuning Use the print results for the color tuning
pattern to check the current color pattern to adjust the color balance.
balance. If you are adjusting the color balance,
Color Tuning Pattern use the c_ontt_'ol panel to specif_y the
B Lok Ty shade (Highlight, Dark, and Mid-Tone)
g BRI IR ‘ AR of each color.
This section explains the procedure for
o 0oL Cl slightly darkening the cyan highlights.
-=============== Adgj!us’cy the coIorsgother Zhan cglangin the
oML T, Dol L same way.
] IIIIIIIIIIII=I=
Al A A AT A (1) Press the scroll button 4 or Y.
LI ON LINE
Color Tuning Pattern @ @ Cngc) CDEE?
Fine Color Tuning ™ -~ : BACK @ @ @
| P EEEE @ <°“> el o e o
i s 6 222
s =~ QOQ
Yoo ; ; ATTENTION f R
- | (2) Select [Calibration], and press the
<OK> button.

(1) Check the area to be referenced ;";::;uration 11 Page
using "Fine Color Tuning". @ Print Information
The color tuning pattern blocks E) Menus
are arranged in four rows of 11 B ) Admin Setue
columns. The four rows are printed
with the fO”OWing CO|OrS’ from top OUse Online button to return to standby screen.
to bottom: [Cyan], [Magenta],
[Yellow] and [Black]. (3) Select [Fine Color Tuning], and
The 11 columns represent color press the <OK> button.
tone, and vertical broken lines are Calibration 2/2 Page
labeled as [Highlight], [Mid-Tone], ) Fine Color Tuning
and [Dark] B} Reset Color Tuning

B White Tuning

n Density Adjustment Media

BTIlPage

4 Select [Cyan Tuning], and press
( ) the <O ;/button. 9l P

Fine Color Tuning 141 Page

Magenta Tuning
B Yellow Tuning
ﬂ Black Tuning

(0 Use Online button to return to standby screen.
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Adjusting Color with the Control Panel

(5) Select [Highlight], and press the
<OK> button.

Cyan Tuning 1/1 Page

Mid-Tone

B Dark

O Use Onling button to return to standby screen.

(6) Specify a larger value than the
current set value, and press the

<OK> button. Confirm there is a
check mark (¢) to the left of the
specified value.

Memo

e Select +0.1 to +4.0 to make density slightly
darker, or -0.1 to -4.0 to make it slightly lighter.
Note, however, that the black adjustment ranges
are +0.1 to +3.0 and -0.1 to -3.0.

(7) Press the <ON LINE> button to
return to the standby screen.

@ DD

ABC DEF

®®®

GHI JKL  MNO

CANCEL @ @

PQRS TUV WXYZ

®@O

CLEAR

ATTENTION

4 Check the color balance adjustment
results.

(1) Print the color tuning pattern.

(2) Use the print results for the
color tuning pattern to check the

adjusted results.

Repeat steps 1 through 3 of this
procedure in accordance with the
results of your pattern check.
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Adjusting Color with a Printer Driver

Color Matching

What Is Color Matching?

It is important to manage the work processes
from data creation to output based on methods
with color consistency. For example, scanners,
digital cameras, and monitors, and other devices
express the blending ratio to which the light of
red, blue, and green (three colors) have been
added to black as values over the RGB color
space (additive mixture of colors).

Meanwhile, printers express the blending ratio
of the four toner colors cyan, magenta, yellow,
and black relative to white (white light), with
the three reflected colors red, blue, and green
excluded as values in the CMYK color space
(subtractive mixture of colors).

The RGB color space and CMYK color space are
color spaces dependent on the machine used,
and so when converting color spaces, the colors
will be different from the reproduced colors
unless individual machine characteristics are
taken into consideration.

To maintain color consistency from data creation
to output, it is necessary to consider the color
differences by device when converting colors.
This process is called "color matching". The
program that implements the color matching is
called the "color management system" (CMS).

The printer can use either printer driver color
matching or application color matching.

Note

= Even if you are using color matching, the printed colors
may appear dark compared to the colors on the monitor.
This is because the range of colors that can be reproduced
by the device is narrower than the range of colors that
can be reproduced by the monitor, so even if color
matching is used, the vivid colors on the monitor cannot
be reproduced.

Color Matching

(Automatic)

The procedure below performs recommended
color matching for general documents. Generally
use the settings shown here.

B Windows PCL Printer Driver

1 Open the file to be printed.

On the [File] menu, select [Print].

In "Color" on the [Color] tab, select
[Automatic], and then click [OK].

1 Afinia LTSC Label Printer PCLG Printing Preferences

3 Click [Preferences] (or [Properties]).

1 Seve Mensgernert
: ]
3 Detas
q
s
6 - »o
; =
8
3 3 on
b ALTNA LAWY e

5 Print.
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Adjusting Color with a Printer Driver

Simple Color Matching m Setup Items
(Simp|e Adjustment) = [RGB Color Setting]
Specifies the method for expressing the
Color matching is used on a printer for colors processed using color matching.

reproduction of the RGB colors required to print

from word processor, spreadsheet, presentation, = Monitor - Auto

and other similar software. During color matching, represents
color by the most ideal method

Color matching is implemented using a special suited to the document to be printed,

accelerator (ASIC) that is built into the printer. emphasizing compatibility with the

When converting RGB color space print data to monitor (color temperature 6500 K).

the printer CMYK color space, color matching Normally use this setting.

processing is applied.

Monitor - Perceptual

Note During color matching, represents the
color by the method emphasizing the
* In the case of a Windows PCL printer driver, color gradation suiting the natural image
matching is not applied even if [Automatic] or [Simple e
Adjustment] is selected for the CMYK color space print Of_ the phOtOQ_raph and compatibility
data. In this case, select "Graphic Pro". with the monitor (color temperature
= If you are installing ICC profile in Windows, click [Advanced 6500K).

Setup] in the [Layout] tab, and then select [Disable ICM]
in [ICM Methods].

Monitor - Vivid
During color matching, represents the
color by the method emphasizing the
vividness suiting the images and text,
and compatibility with the monitor
(color temperature 6500K).

Monitor - light
During color matching, represents the
color by the method emphasizing the
gradation suiting the natural image
of the photograph and compatibility
with the monitor (color temperature
9300K).

Adobe RGB

Specify if you are using an input device
with AdobeRGB color characteristics.

sRGB

The sRGB colors within the printer's
color gamut are printed without any
modification. Only colors that fall
outside the printer's color gamut are
matched with the outer shell. Suitable
for matching specific colors.

= [Black Finish]

Sets the black finish when printing in color.
Normally use Auto as is.
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Color Matching

B Windows PCL Printer Driver

(Graphic Pro)

Open the file to be printed.

H

Graphic Pro is the optimal choice for use with
DTP software.

Select [Print] in the [File] menu. e . .
It lets you specify simulation printing for any

CMYK output device.

Click [Preferences] (or [Properties]). To use an ICC profile of an I/O device for color
matching, you need to register the ICC profile to

h i f h .
On the [Color] tab, click [Color], the device beforehand

select [Automatic] or [Simple . . .
Adjustment], and then click [OK]. B Windows PCL Printer Driver

B~ 00 DO

) Afinia LTSC Label Printer PCLG Printing Preferences x

1 Open the file to be printed.

Swo Colr  Ovetan Dtend
. Enorees

M e Mansgemers
I 2 ) 2 On the [File] menu, select [Print].
E fet
Z P @ 3 Click [Preferences] (or [Properties]).
4 -
s On the [Color] tab, click [Color], then
5] ™ - 4 select [Graphic Pro], and then click
4 AUNIA LABIT, odk [OK].
o] cmd | 5o o
5 Print | o cov Ot camd
Camgle Favertes
1 Current setting - Sove.. Management...
2 Lotor Mode:
i 3 Detai].
i|e - .
5 5 -
6 | excoe 00 nor e
8
& Jeewr Saing ot
,ﬁ 0 0% Elack teme
b AUNIA TABIL Oetayt

8 Afinia LTSC Label Printer PCLE Printing Preferences

5 Print.
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Color Matching

(No Color Matching)

Prints using the specified colors as is, without

implementing color matching using the printer

drivers or device.

Select if implementing color matching using an

application.

B Windows PCL Printer Driver

1

2
3
4

Open the file to be printed.

On the [File] menu, select [Print].

Click [Preferences] (or [Properties]).

On the [Color] tab, click [Color], then
select [No Color Matching], and then
click [OK].

1
2
3
q
s
6 Sgen Cokor W00 net e
7
8
19 |

§

b AINALAD L o

Print.

the Black Finish

The finish for the black parts will be changed

when printing in color. This can be used when
the printer driver's color mode setting is [Simple
Adjustment] or [Graphic Pro].

H Setup Items
= Black Finish

= Auto

Creates black using the optimum
methods according to the document to
be printed. This setting can be selected
only when the color mode is set to
[Simple Adjustment]. This setting
cannot be configured on the Graphic
Pro.

= Composite Black(CMYK)

Synthesizes black using cyan,
magenta, yellow, and black toner.
The black is close to brown. Ideal for
photos.

* True Black (K)

Prints black using black toner only.
Ideal for diagrams and documents.
When printing photos, the dark parts
are blackish.

* Pure Black Text/Graphics (Graphic Pro Only)
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If black defined using the RGB color space
for text and graphics (R=0, G=0, B=0) or
black defined using the CMYK color space
(C=0, M=0, Y=0, K=100%) is specified,

this setting specifies whether printing

should use black (K) toner only.

= ON

Prints the text and graphics specified
as black using black (K) toner only.

- OFF

Text and graphics specified as black
are synthesized using either black (K)
toner only or CMYK depending on the
profile specified by color matching.
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B Windows PCL Printer Driver

Open the file to be printed.

H

On the [File] menu, select [Print].

Click [Preferences] (or [Properties]).

On the [Color] tab, select [Simple
Adjustment] or [Graphic Pro], and then
click [Detail].

In the [Black Finish] section, select the
black finishing method. In the [Graphic
Pro] mode, also select ON or OFF for
[Pure Black Text/Graphics], and then
click [OK].

Colee Setting Detaih ®

o1 B~ PO

| Getor Mode
| RGE Celor Setting

| ’ ) Aasornatic Color matching opticns
This color setting & Mentor - Auto
cpbr

Monochrome

(Black and White) Printing

The color data is printed using grayscale (shades
of black and white) without touching the print
data.

= If implementing color printing after printing by specifying
"Monochrome", a delay may occur depending on the
temperature adjustment of the fuser unit.

Memo

= Even if the cyan (blue), magenta (red), yellow print
cartridge life has been reached, monochrome printing
using only black can be done by specifying *“Monochrome”.

= Refer to "Printing Using the Specified Print Cartridge Only
(Lift Up)"” (P.80) regarding printing with black only.

= For information about roll paper, see “Roll Paper
Specifications” (P.12).

B Windows PCL Printer Driver

1 Open the file to be printed.

Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).

On the [Color] tab, select [Monochrome].
Adjust lightness and darkness as

DO D

required.
@ Afinia LTSC Lsbel Printer PCLG Printing Preferences
Swo Cdor  Ovdan Bowd
Lamgle yoortes
1 Cument setting v Sove Management..
2 Color Mode: O Colee
i 3 Q) Graphec Pro
i
§ 4 # Moncchecma
g 5 Magusl sethngs
6 Saot Colo o e
4 @
8
Tener Seving on
9
,= (100 not cave 10N black toner
b AUINIALABL Octayg

o1
T
=
=
(s
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Suppressing White Lines
Between Text and the

Correcting for Print

Misalignment (Trapping)

Use if there are white or colored lines

Background
(BIaCk Overpl‘ll‘lt) between two overlapping objects due to print

misalignment.

If you are imaging 100% black text on a colored

background, you can print (overprint) by . . .
overlaying the text and background parts. Set if ® Windows PCL Printer Driver

there are gaps such as white lines, etc., in the
borders between the text and background.

Note

= Not usable with some applications.

Open the file to be printed.

Select [Print] in the [File] menu.

= Black overprint cannot be used if the text is not 100%
black, the text has been rendered as graphics by

: _ : graph Click [Preferences] (or [Properties]).
extracting the outlines, or if the text is an image.

= If the background color is dark (toner layer thickness
exceeds 240%), toner may not be fixed completely. For
example, if printing 100% black text on backgrounds of
50% cyan, 50% magenta, and 50% vyellow, the toner
layer thickness is 50+50+50+100=250%, which exceeds
240%.

On the [Extend] tab, click [Advanced].

Select [Trapping]. Next, select the
misalignment correction method with

® Windows PCL Printer Driver [Settings], and then click [OK].

Advanced x

o1 B~ LoD -

Open the file to be printed. fem
Reduce Size of Spoal File

Keep page layout when resizing document

Overprint Black

Adjust for overlapping colors
Adjust ultra fine lines
Job Spocl

Select [Print] in the [File] menu.

Settings

Click [Preferences] (or [Properties]). Description

Trapping creafl Narow of color. This
compensates | Narrow / Choke White the C. M, ¥ and K layers
of animage. Tide aps or color lines
between two dwide / Choke White
Choke White

On the [Extend] tab, click [Advanced]. | T T

Select [Overprint Black]. Next, for
[Settings], select [On], and then click

o1 B~ LoD -

Print.
[OK]. 6
Advanced x
tem Setting
Recluce Size of Spool File On
Overprint Black Off
Adjust ultra fine lines On
Job Spoel off
Run maintenance cycle before printing off
Trapping Printer setting
Qyerprint Black
[[s<tiings off +]
Description
Eliminates white outlines produced by misregistration around black
characters on  colored background.
Cancel Help Default

6 Print.
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Simulating Print Results

The printer adjusts CMYK color data to simulate
the characteristics of ink, such as that used in
offset printing.

The ICC profiles registered as standard are
described below.

= RGB Profiles
- sRGB
- AdobeRGB
e CMYK Input Profiles
- SWOP
- ISO Coated
- Japan Color
- JMPA

Note

= Enabled when [Color Mode] is set to either [Simple
Adjustment] or [Graphic Pro].

® Windows PCL Printer Driver

1 Open the file to be printed.
2 Select [Print] in the [File] menu.
Click [Preferences] (or [Properties]).

then select [Graphic Pro].

Select [Printer Simulation], and then
use the list under [Simulation Target
Profile] to select the ink characteristics
you want to simulate.

4 On the [Color] tab, click [Detail], and

Coler Setting Detail

Gelor Mode

O KC Prafile Color Matching
@ Priter Simulation

) Disable coke matching for pecfie creation

Black Finsh
Composite Black (CMVE)

71 Pure Black Text/Guaphics.

6 Click [OK].

7 Print.
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Spot Color Printing
Setup

Printer Driver Spot Color
Function List .......ccovveiinnersnnsnnsnnnnes 118

Printing on Color Papers..........zs10e.:. 119

Fine-Tuning White Shading ..............121

Note

* The examples in this chapter use Windows WordPad for explanations. Depending on the
application, the screens and operations procedures may differ.

= For detailed explanations of the printer driver and utility setup items, see "Online Help".

= Due to printer driver and utility version upgrades, actual operations may be different from the
descriptions in this manual.
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Printer Driver Spot Color Function List

Printer Driver Spot Color Function List

This section explains the Spot Color toner functions in the printer drivers.

B Windows PCL Printer Driver
Click the [Color] tab to display the screen for setting the spot color toner.

=0 Afinia LTSC Label Printer PCLE Printing Preferences *
Setup  Color  Overdays Extend
Example Favorites
1 Current setting ~ Save... Management...
2 Color Mode: ® Color
c%j 3 @Automatic w Detail...
g Always create 100% black (K) toner
% 4 () Monochrome
- m
6 Spot Color: W Do not use o
7 “Full page
\'\@Data portion (Excluding white)
\\@Data portion (Including white)
8 \\\@Prlntlng only spot color toner
Toner Saving: S8 Watermarks/Overlays
9
’—‘ [] Do not save 100% black toner
b AUINIA LABLL Default
Cancel Apply Help
Item Description
Usage Method Do not use Prints without using white toner.
Full page Uses white toner for the entire page being printed.
Data portion (Excluding white) Uses white toner for all data parts that do not include
white parts.
Data portion (Including white) Uses white toner for all data parts that include white
parts.
Printing only spot color toner Prints with white toner only.
Watermarks/Overlays Prints the selected watermark and overlay with white
toner.
Spot color 0 to 100 Adjusts the amount of white toner used while printing.
toner quantity
adjustment
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Printing on Color Papers

Printing on Color Papers

Usable Color Papers Printing Using White Toner

Only

Use color paper that satisfies the following

conditions. Printing text and illustrations using only white

= Pigment or ink used to color the paper heat- toner on color paper.

resistant to 230°C Before printing, check that the white print
= E-photo printer paper with the same paper cartridge has been mounted to the device, and
characteristics as plain paper that white toner has been selected using the
printer drivers.

Memo

= If you specify "Print Only with Spot Color" and lift up all
the other colors of cartridges, you can print with only spot
colors, even if one of the black, cyan, magenta, or yellow
print cartridges has reached the end of its service life.
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Printing on Color Papers

B Windows PCL Printer Driver

1 Open the file to be printed.

Select [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and then click [OK].

Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).

Use [Media Type] to select the paper
type.

Use [Media Weight] to select an
appropriate value.

Click the [Color] tab.

® Afinia LTSC Label Printer PCL Printing Preferences

coO d O O1 =~ OO

= Y
G ——
1 Current setting o HManagemen
2 Celor Mode 13
iz
i
il
i 5
& Sget €
7
8
Teasr Sadng
9
b AUNALAIT o

I =T

9 For [Usage Methods], select [Printing
only spot color toner], and then click
[OK].

& Afinia LTSC Label Printer PCLG Printing Preferences

S Cokr  Oveds Emend

wo9ag 994 B

v

Click [Print] in the "Print" screen to
print.

Printing White Under Color

When printing on color paper, print a base with
white toner, and then print in color on top of
that.

B Windows PCL Printer Driver

1 Open the file to be printed.

2

Select [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and then click [OK].

Select [Print] in the [File] menu.

Click [Preferences] (or [Properties]).

Use [Paper settings] to select the paper
type.

Click the [Color] tab.

For the [Spot Color] setting, select
one of the following: [Full page],
[Data portion (Excluding white)],
[Data portion (Including white)], or
[Watermarks/Overlays].

oo SOl B~ (&)

9 Click [OK].

Click [Print] in the "Print" screen to
print.
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Fine-Tuning White Shading

Fine-Tuning White Shading

Finely adjust the shade for each white highlight, dark, mid-tone gradation using the printer control
panel.

Here, we will show the procedure for slightly Select[Highlight], and press the <OK>
darkening white highlights. button.

1 Press the scroll button a or wv. el AR

ur\ ON LINE ®@® Mid-Tone

ABC  DEF B park

)

BACK

©,

GHI JKL MNO

CANCEL @ @

o)
Z/

v PQRS TUV WXYZ OUse Online button to return to standby screen.
~—r . .
— (?:? © CLE@A? 5 Specify a value that is larger than the
ATTENTION current set value, and then press the

_ _ <OK> button. Confirm there is a check
Select [Calibration], and press the mark ( ) to the left of the specified
<OK> button. value.

Functions 171 F’ageI
n Configuration
a Print Information

B Menus
a E' Admin Setup
E' Print Statistics

O Use Onling button to return to standby screen.

{(-3.0-+3.0}

Switch +/-

Select [White Tuning], and then press Memo

the <OK> button. _ )
= A larger value represents darkening, while a smaller value
Calibration 212 Page represents lightening.

Fine Color Tuning
Reset Color Turing Press the <ON LINE> button to return

to the standby screen.

ﬂ Density Adjustment Media

MENU ON LINE

ABC DEF

@ ©®

GHI JKL  MNO

~ DO®

PQRS TUV WXYZ

©®@O

CLEAR

BTIlPage

ATTENTION
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Network Settings

Initializing Network Settings ......... 124
Using DHCP ......ccciiiciininnsssnssnnnsnnnnnss 125
IPVG ccucciiiiic i nninc s s s nnnnnsns 127
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Initializing Network Settings

Initializing Network Settings

Note Select [Network Factory Defaults], and
then press the <OK> button.
= Implementing this operation will initialize all network
settings. Network Setup 22 Pagi‘
B /Psec
A v B shvp
1 Press the scroll button or . B Network Scale
ﬂ Gigabit Network
Select [Admin Setup], and then press @ Hub Link Setting
7 the <OK> button.
BB 1/ Page
Functions 11 Pa\geI
() Configuration When [Execute] appears, press the
B Print Informaticn <OK> button.
BMenus
; - Network Factory Defaults 1/1 Page
E' Print Statistics : Execute
B Calibration

(L) Use Online button to return to standby screen.

3 Enter the administrator password, and
then press the <OK> button.

B O Use Online button to return to s...

Memo 7 Initialization is executed, and the

= The factory default setting of the administrator display returns to the standby screen.

password is [999999].

Enter Password

*u***
(6 - 12 digits )

O Use Onling button to return to standby screen.

4 Select [Network Setup], and then press
the <OK> button.

Admin Setup 1/2 Page
n Network Setup

B USB Setup

B Print Setup

ﬂ PS Setup

B PcL Setup

B Color Setup

BTIlPage
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Using DHCP

Using DHCP

IP addresses can be acquired from a DHCP server.

Note

* PC administrator privileges are required for the setup.

= Incorrectly allocating the IP address may cause major malfunctions such as crashing of the network. Thoroughly consult the

network administrator before making the settings.

To use the device in a DHCP environment, select

[Auto] as the IP address setting method.

Also note that [Auto] is the IP address setting
method under factory default settings, so
performing this procedure is normally not
necessary.

1 Press thescroll button A or v,

= AN O3

ABC DEF

-« (O O22
FNDIO 366

PQRS TUV WXYZ

CLEAR

)

Q)
Z/

(«

Select [Admin Setup], and then press
2 the <OK> button.

Functions 11 PageI
n Configuration
8 Print Information

a Menus

E] Print Statistics

ﬂ Calibration

O Use Online button to return to standby screen.

3 Enter the administrator password, and
then press the <OK> button.

Memo

* The factory default setting of the administrator
password is [999999].

Enter Password

*u***
(6 - 12 digits )

O Use Onling button to return to standby screen.

Select [Network Setup], and then press
the <OK> button.

Admin Setup 1/2 Page
n Network Setup

USB Setup

a Print Setup

ﬂ PS Setup

B PcL setup

G Color Setup

BTIlPage

Select [IP Address Set], and then press
the <OK> button.

Network Setup 1/2 PageI
[ 1 el
NetBIOS over TGP

B web

Telnet

@Arrp
B T+ | Page

Select [Auto], and then press the <OK>
button.

P Address Set

Use Online button to return to s...

Press the <ON LINE> button to return

7 to the standby screen.
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Back ABC DEF
@ @O ®
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Using DHCP

B To use the printer in a BOOTP
environment

To use the printer in a BOOTP environment,
select [BOOTP] as the IP address setting
method.

1 Access the printer web page and log in
as an administrator.

2 Select [Admin Setup].

Select [Network Setup] > [TCP/IP] >
3 [Change Settings] > [Get IP address
automatically (BOOTP)].

4 Click [Submit].

Memo

= Refer to “"Using a Web Browser to Configure the Network
Setup” (P.141) regarding the printer web page.
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IPv6

This printer is compatible with IPv6, and the
IPv6 address is acquired automatically. IPv6
addresses cannot be set manually.

The device is compatible with the following
protocols.

* Printing:
- LPR
IPP
RAW (Port9100)
- FTP
* Setup:
- HTTP
- SNMPv1/v3
- Telnet

Checking the IPv6 Address

IPv6 addresses are allocated automatically.

Access the printer web page and select
[View information].

Memo

* Refer to “Using a Web Browser to Configure the
Network Setup” (P.141) regarding the printer web

page.

2 Select [Network] > [TCP/IP].

Memo

= If all the global addresses are displayed as "0", it is
possible an error has occurred in the router being used.

Reference

= Press the scroll button A or W, and then select [Print

Information] > [Configuration] to check the IPv6 address
using the configuration report. For reports and information
about how to print them, see “Printing Configuration
Information” (P.130).
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Viewing Machine
Information

Printing Configuration
INfOormation . ... nnnnnnnnnnss 130

Checking the Print Count................. 138
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Printing Configuration Information

Printing Configuration Information

Printable Report List

. A Reference
List Name Description pages
Configuration Prints the table of all menu category items and the current Page 131
settings. Further, the advanced printer settings are also printed
in the page header.
Demo Page Prints the demo print data stored in the printer. Page 132
File List Prints the file list. Page 52
Usage Report Prints the total print results. Page 133
Error Log Prints the errors detected and saved by the printer. Page 133
Color Profile List Prints the color profile list. Page 134
Color Adjustment Pattern Prints the patterns to match the shading characteristics. Page 104
Page 106
User Media List Prints the user media list. Page 135
Test Print-1 Prints the patterns for analyzing the print quality. Page 135
Test Print-2 Prints the patterns for analyzing CYMK print quality. Page 135
Test Print-3 Prints the patterns for analyzing the status of the print Page 135
cartridges.
Test Print-4 Prints the patterns for analyzing print quality of the spot colors. Page 135
Cleaning Page Prints the toner-free white sheet to remove dirt from the surface | Maintenance
of the fuser belt in the fuser unit. Guide

= Paper is cut at a fixed length when printing a report, so do not use die-cut label paper.
= To attain the full benefit of the report printing function, load paper that is 130 mm wide.
= Printing is canceled if a print cartridge for a color that is required for report printing is not lifted down.
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Printing Configuration Information

A e R ST AN 545 o ®Printing result samples

25 £3% £¥d3 g715¢
T L i
23 5 £3
a3 §3%
2

Configuration I :

Q
=}
3
Q -
<
8
S
S

Print the device information.

Print to see the remaining quantity of
consumables and other set values such as IP
addresses and MAC addresses, and to check
whether the printer is operating correctly, etc.

3 04 08 OM ¥OTTEL ¥IZ25 562011

Press the <Fn> key.

#

- :
o prin

I

The numerical values input screen will
be displayed. :

MENU ON LINE

O3

ABC DEF

GHI JKL  MNO

e TUV  WXYZ
™0 O©
Fn CLEAR

ATTENTION

Press <1>, <0>, <0> (function
numbers), and then press the <OK>
button.

Function Number

1008
Enter 1-3digit Number

Confirm that [Execute] is selected, and
then press the <OK> button.

Configuration

n Execute

O Use Online button to returnto s...
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Printing Configuration Information

Printing Printer Confirm that [Execute] is selected, and
then press the <OK> button.

Information Lists

n Execute

Demo Page

Prints demonstration pages.

B To print

O Use Online button to return to s...

1 Press the scroll button A or v,

ON LINE

@ OO

ABC DEF

®O®
®

GHI JKL MNO

CANCEL @ @

PORS TUv WXYZ

Y o000

CLEAR

Q)
Z/

(«

ATTENTION

Select [Print Information], and then
press the <OK> button.

Functions 11 Page|
n Configuration
a Print Information

B Menus
ﬂ E' Admin Setup
E' Print Statistics

B Calibration

O Use Online button to return to standby screen.

Select [Demo Page], and then press the
<OK> button.

Print Information 1/2 Page|
n Configuration

E)File List

a Usage Report
Error Log

@ color Profile List

BTIl Pags

When [DEMO1] appears, select one of
the items to be printed, and then press
the <OK> button.
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Printing Configuration Information

Error Log Usage Report

Prints the history of the errors that have Prints the total print results.

occurred in the device.
Memo

ETo prlnt = Not displayed if [Usage Report] of [Print Statistics] is set
to [Disable].
Press the <Fn> key.
The numerical values input screen will B To print
be displayed.
play Press the <Fn> key.
MeNu ON LINE
@ CA%? CD? The numerical values input screen will
be displayed.
GHI JKL  MNO MENU ON LINE
2 DA @ OO
@ Sooo TUV  WXYZ ABC  DEF
(_F):? @ gg GHI  JKL  MNO
ATTENTION CANcEr D ©)
© —— UV  WXYZ
Press <1>, <0>, <3> (function D] DO,
numbers), and then press the <OK> arrenron e
button.

: Press<1>, <0>, <2> (function
Function Number
103 numbers), and then press the <OK>
Enter 1-3digit Number button .

Function Number

1028
Enter 1-3digit Number

Confirm that [Execute] is selected, and
then press the <OK> button.

Confirm that [Execute] is selected, and
then press the <OK> button.

(L) Use Online button to return to s..

(L) Use Online button to retum to s...
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Printing Configuration Information

4 Use the numeric keypad or the scroll Printing Print Lists

buttons (A, ¥) to specify the number

of copies, and then press the <OK>
button. Color Profile List

Prints the table of the ICC profiles registered on
the printer.

- 1003

B To print

1 Press the scroll button A or v,

O Use Online button to return to s... LT ON LINE
| N @

ABC DEF
BACK

JAY
01010,
@77 @;} CANCEL PC;’;? g%?

[ ©®O©O

CLEAR

ATTENTION

Select [Print Information], and then
press the <OK> button.

Functions 1/1 Page |
n Configuration

B Menus
ﬂ E' Admin Setup
B E' Print Statistics

B Calibration
O Use Online button to return to standby screen.

Select [Color Profile List], and then
press the <OK> button.

Print Information 112 Page|
n Configuration
Demo Page
E)File List

a Usage Report
Error Log

nglPage

Confirm that [Execute] is selected, and
4 then press the <OK> button.

Color Profile List

4(0) Use Online button to return to s...
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User Media List

Prints the table of the user media registered to
the device.

Memo

= Displayed when the user media is registered.

B To print

1 Press the scroll button A or v,

LI ON LINE

8 /&\ ABC  DEF
ACK
@ ( ) @O®E®
oK GHI  JKL  MNO
C

~N O®®
v PORS TUV WXYZ
=~ OO
Fn CLEAR

ATTENTION

Select [Print Information], and then
press the <OK> button.

Functions 11 PageI
n Configuration

a Menus
a E Admin Setup
E Print Statistics

a Calibration

() Use Online button to return to standby screen.

3 Select [User Media List], and then press
the <OK> button.

Print Information 2{2 Page
n User Media List

g Test Print-1

B Test Print-2

ﬂ Test Print-3

Test Print-4

B Cleaning Page

BTI.I, Page

Confirm that [Execute] is selected, and
4 then press the <OK> button.

ser Media List

n Execute

(L) Use Online button to return to s..

Test Print

Prints the print quality lists.

e Test Print-1
Prints the patterns for analyzing the print quality.

e Test Print-2

Prints the patterns for analyzing CMYK print
quality.

e Test Print-3

Prints the patterns for analyzing the status of
the print cartridges.

e Test Print-4
Prints the patterns for analyzing print quality of
the spot colors (white).

B To print

1 Press the scroll button A or V.

Mo ON LINE

= Va jelele
®O®
@f @@ GHI  JKL  MNO
CANCEL
S OO
Fn CLEAR
ATTENTION

Select [Print Information], and then
press the <OK> button.

Functions 1/1 Page |
n Configuration

B Menus
ﬂ E' Admin Setup
B E' Print Statistics

G Calibration

O Use Online button to return to standby screen.

3 Select [Test Print-1], [Test Print-2],
[Test Print-3], or [Test Print-4], and
then press the <OK> button.

Print Information 2/2 Pagi‘

n User Media List
B Test Print-1

B Test Print-2
a Test Print-3
Test Print-4
a Cleaning Page

BTIlPage
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Printing Configuration Information

When [Execute] appears, press the Changing the
<OK> button.

Administrator Password

Change the administrator password. The factory
default setting is [999999].

1 Press the scroll button A or v,

LU ON LINE

O PLRPD
~ O®®
B o 222

O Use Online button to return to s...

v PQRS TUV WXYZ
=~ OO
Fn CLEAR

ATTENTION

2 Select [Admin Setup], and then press
the <OK> button.

Functions 1M Page|
n Configuration
Print Information

a Menus

E' Print Statistics

a Calibration
(1) Use Online button to return to standby sereen.

3 Enter the administrator password, and
then press the <OK> button.

Enter Password

u*u*
(6 -12 digits )

O Use Online button to return to standby screen.

Select [Change Password], and then
4 press the <OK> button.

Admin Setup 2/2 Pagﬂ
n Panel Setup

Time Setup

a Power Setup

ﬂ Others Setup

Settings

g T+ | Page
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Printing Configuration Information
Enter the new password, and then press

the <OK> button.

Note

* Specify a password that is at least six characters
long.

Eeiip fiah | New Password

***k**
{6 - 12 digits )

O Use Online button to return to s...

Re-enter the new password, and then
press the <OK> button.

erify Password

**u**
{8 - 12 digits »

(L) Use Online button to return to s...

Press the <ON LINE> button to return
to the standby screen.

MENU ON LINE

OO

@@&5%

GHI JKL  MNO

~ D®®

PQRS TUV WXYZ

®O©O

CLEAR

ATTENTION
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Checking the Print Count

Checking the Print Count

You can check the quantity of paper printed from the unwinder to date.

Press the <OK> button.

1 Press the scroll button A or v,

O3

ABC DEF

ON LINE

BACK

%

@ & ®

@7 @@ G R G
N

CANCEL @ @

PQRS TUV WXYZ

SE N clele

CLEAR

ATTENTION

Select [Configuration], and then press
the <OK> button.

Functions 1/1 Page
n Configuration
8 Print Information

a Menus
ﬂ E Admin Setup
EI Print Statistics

ﬂ Calibration

O Use Online button to return to standby screen.

3 Select [Feeder Count], and then press
the <OK> button.

Configuration 1/1 Page
n Feeder Count

B Supplies Life

B Network

a System

(L) Use Online button to return to standby screen.

4 Select the feeder you want to check.

Feeder Count 1/1 Page

(0) Use Online button to return to standby sereen.
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b{(0) Use Online button to return to ...

Press the <ON LINE> button to return

to the standby screen.

-

BACK

©
v

ON LINE

O3

ABC DEF

GHI JKL MNO

~Yololo

PQRS TUV WXYZ

PO
ATTENTION




Utility Software Usable
with This Printer

UBITIEY LISt coveenmerrrrsssnneesessssnnesesssnns 140

Using a Web Browser to
Configure the Network Setup.......... 141

Network EXtension.....cvccceereasesnnnnnnns 172
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Utility List

Utility List

Utility Name Description Operating Environment Re;::;zl;ce
Web Browser Can be used to view messages Computer with Microsoft Page 153
displayed on the printer, and to Internet Explorer, Safari,
configure network settings and other |Google Chrome, or
settings. Firefox installed
Network Extension Can be used to check printer setup Windows 10/Windows 8.1/ Page 190

items from a printer driver and to
configure option settings.

This utility is installed automatically
when a printer driver is installed on
a network connection.

Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008/
Computer running TCP/IP
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Using a Web Browser to Configure the Network Setup

Using a Web Browser to Configure the Network

Setup

Operating Environment

Computer with Microsoft Internet Explorer,
Safari, Google Chrome, or Firefox installed

Computer running TCP/IP

Memo

= Check to make sure that the security setting of the web
browser is MEDIUM.

The explanation here is based on the example
environment described below.

e Printer name: LT5C
e Printer IP address: 192.168.0.2
e MAC Address: 00:80:87:84:9C:9B

e Web Browser: Microsoft Internet Explorer
Ver.11

1 Start up the web browser.

In the address bar, enter the following
2 URL then press [Enter]: http://<printer
IP address>/.

’e [@ht';: 192.168.100.100

This displays the printer status screen.

e If the IP address includes a one-digit or two-digit
number, do not enter leading zeros. Doing so may cause
communication problems.

Example: Correct: http://192.168.0.2/
Incorrect: http://192.168.000.002/

9] < | @ Pro10s0
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Using a Web Browser to Configure the Network Setup

Logging in as an

Administrator

= To change printer settings using a web browser, you need
to log in as a printer administrator.

1 Click [Administrator Login].

4@ AFINIA LABEL

2 For [Username] enter "root", for 4
[Password] enter the current password,
and then click [OK].

Memo

Authentication Required x

® hitp://182.168.10.151 i requesting your username and password, The site says: "LTSC"

User Name: || |

Password: | |

( ] e

= The password is the same as the control panel
"Administrator Password".

- 142 -

Specify the configuration information
that can be checked on the network,
and then click [OK] or [SKIP].

4 AFINIA LABEL

= You can skip configuring settings by clicking [SKIP].

= Selecting the [Do not show this page again]
checkbox, and then clicking [OK] or [SKIP] will
cause this page not to be displayed any more.

This will display the screen below.

da ALINIA LABEL




Using a Web Browser to Configure the Network Setup

Item List

© : Appears for a person logged in as a printer
administrator.

EView Information

b ATINIA LABEL

EPrinter Menu ©

b AFINIA LABEL

Shon imer mome [LY5C 715705

-
in

Item Description
General . Can=be-used-to-configure-the-printer name, asset
Printer number, installation location, and other printer
Settings settings.
Unwinder You can do settings related to the unwinder and
Config the paper loaded in the unwinder.

Cutter Setup

You can set the cutter operations and the cutting
interval. Appears when the unwinder is mounted.

Item

Description

System
Adjust

Can be used to configure the power save time, and
for clearing warnings, timeout printing, and other
printer operations.

Status

Shows the current printer status. All warnings
and errors generated by the printer are shown

as "problem information". You can also check

the operational status of each network service,

a configuration list, and the IP address assigned
to the printer. For information about the status
window, see "To check using the "Status Screen""

(P.145),

Print Adjust

Can be used to configure print position adjustment,
print quality, and to adjust other settings.

Unit of
Measurement

You can set the units that are displayed.

Tray Count

Shows the print count.

Supplies Life

Shows the remaining life of consumables.

Usage Report

Shows usage reports.

Network Can be used to check general information, TCP/
IP status, maintenance information, and other
network-related setup information.

System Shows versions, memory capacity, flash memory

capacity, and system related information.

EPrint Information ©

b ATINIA LABEL

[ TUTR A ———

B Admin Setup ©

b ATINIA LABLL

Item

Description

Information
Print

Can be used to configure print and check
information about the network, the font list, and
other printer settings.

Item Description

Network Can be used to configure TCP/IP and other protocol

Setup settings.

Print Setup Can be used to configure toner saving and other
printer settings.

PCL Setup Can be used to configure PCL font and other PCL
settings.

Color Setup Can be used to configure PostScript settings for
the CMYK data conversion process and other color
settings.

Management | Can be used to configure the power setup, job

cancel setup, and other printer settings.
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m Calibration ©

Changing an Administrator

— -- Password

i o — ;

' T ——— You can use the procedure below to change
—_— the password for logging in to the printer as an

administrator.

= 11— — - OKI F
Actemerts Alecaeat Bttt Attt
Pro1050
Item Description . e
Normal Adjusmaéhsity of each color and other print
Setting quality settings. g
Customize Used to perform density and registration
Menu adjustment.
m Links
b ATINIA LABEL
S 3

Item Description ; R R —
Links Displays links configured by the administrator and
links configured by the manufacturer. 1 C|IC|( [Admin Setup] > [Management].
Edit Links Allows administrator to set any URL. Up to five
support links and five other links can be registered.
Be sure to include http:// when entering the URL. 2 Clle [Cha nge password]

In [New Password], enter the new
password. In [Verify Password], enter
the new password again.

b ATINIA LABEL

* The password will appear on the screen as a series
of dots ( @@ @@®® ) as you enterit.

= You can enter from 6 to 12 alphanumeric English
characters for a password.

= Note that passwords are case-sensitive, so enter
upper-case and lower-case letters correctly.

4 Click [Submit].
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This saves the settings on the printer.

You do not need to re-start the printer. Use
the new password the next time you log in
as an administrator.

Checking Printer Settings

From a Computer

You can use the procedures below to check the
printer status from a computer over a network.

B To check using the "Status Screen"

Access the printer web page and open
the "Status" screen.

b ATINIA LABEL

B To check using the "Status
Window"

Click [Status Window], which will display the
screen shown below.

4 ATINIA LABEL

& Pro10s0 (IP Addr192.16., — [m] x
P, & hitp://192.168.0.2/statuswinfrm.htmn
Shows
rinter T Click )
iF:n’orma- o tOI(l:,Ip
(tion. | . date the
printer
P status
Thls clicking the above button. W|th the
| latest
displays informa-
details . No Error tion.
about the|
printer
status.
Printer Status Icon Meaning

No error, online

Minor malfunction
(printing still possible)
Serious malfunction
(printing not possible)

Offline

Ol@®@|0|0
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Changing Printer Settings

From a Computer

Encrypting Communication
(SSL/TLS)

You can use the procedure below to change
printer settings.

Access the printer web page and log in
as an administrator.

4 AFINIA LABEL

Submit| Cancel|  Press Sttt send manges.Press Cance s ear changes

After changing the settings you want,
2 click [Submit].

Communication between the computer (client)
and printer can be encrypted when configuring
settings, performing IPP printing, and when
receiving print data with FTP protocol.

(Encryption of SSL/TLS Communication)

m Configuring Settings
The procedure below shows how to use the web
to create a certificate with the printer.

The two types of certificates below can be
created.

= Self-signed certificate
e CA certificate (CSR creation)

Memo

= If the printer's IP address is changed from what it was
when a certificate was created, that certificate become
invalid. Do not change the printer's IP address after
creating a certificate.

1 Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

2 Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

b ATINIA LABEL

e
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Select the type of the certificate to
create in [Step 1].

| 4 AFNIA LABED

[PPSR ——

Enter information for the Common
Name, Organization, and other items.

Note

* If you selected "Use a certificate issued by a
certificate authority", perform detailed content
input and other certificate issuing procedures in
accordance with issuing authority procedures.

b ALINIA LABET

= If you selected a self-signed certificate, the printer's
IP address will be set for [Common Name].

If you want to change the key exchange

method and key size, click [Change these

settings]. (The initial default setting is

RSA, 1024 bits. Normally, you should use

this setting without modifying it.)

i AFIN| e

9 & I — -@ % =

A adsrzz

s s

Click [OK].

Self-signed Certificate
To create a CA certificate, advance to "CA

Certificate" (P.148).
This displays the input.

Check the contents, and then click [OK].
This creates the certificate.

[ @ tr5c - Mozt Fireto - o x ‘

© & 192168.10151/ssl tls all.htm 8 - 9w

Value List

List of User Input Value

Cipher Level STANDARD

Type self-signed Certificate
| commeon Name 192.168.10.151

‘ Organization Afinia Label

| Organizational unit 5-Color

Locality Chanhassen
| State/Province My
‘ Country/Region us
Key Exchange method RSA
Key size 1024bit
_ok | JFancel

This completes self-signed certificate
creation.

Settings are saved on the printer and the
network function is restarted.

8 Perform steps 1 through 3 of this
procedure to display the encryption
(SSL/TLS) setup screen, and then
configure protocol settings to enable
encryption.

b ALINIA LAGFL

Click [Submit].

In this case, advance to "Usage Method"
(P.148).
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Q CA Certificate
This displays the input.

Check the contents, and then click [OK].

[0 s S

© A 192168.10.151/ss]_ts_allntm B8 - w =

Value List

List of User Input Value
Cipher Level STANDARD
self-signed Certificate

192.168.10.151
Afinia Label
5-Color
Chanhassen

Key Exchange method RSA
Key size 1024bit

OK ancel

8 Extract the CSR and send it to the

issuing authority. (For a CA certificate)

= Copy the contents of the text box from "-----

BEGIN CERTIFICATE REQUEST ----- "to " ----- END
CERTIFICATE REQUEST----- ". Depending on the
CA, sending the CSR may mean pasting it into web

page, sending it as a file, attaching it to a mail
message, etc.

da AFINIA LABFL

Ml v et e 3amat carstcats o 8 Carstcanon

10

1

This installs the certificate issued by
the CA (using the web). (For a CA
certificate)

b AFINIA LABFL

Perform steps 1 through 3 of this procedure
to display the encryption (SSL/TLS) setup
screen.

Paste the part of the generated certificate
from "----- BEGIN CERTIFICATE----- "to "--
--- END CERTIFICATE ----- " into the text
box, and then click [Send].

This completes CA certificate creation.

Settings are saved on the printer and the
network function is restarted.

Perform steps 1 through 3 of this
procedure to display the encryption
(SSL/TLS) setup screen, and then
configure protocol settings to enable
encryption.

b AFINIA LABFL

ot [l Corcel P b 4 s s ot s e e

Click [Submit].

m Usage Method
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Start up the web browser, and then
enter "https://<printer IP address>" as
the address to connect.

‘e [3 192.168.100.100;

D] < || & Protoso
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Printing with IPP

Printing can be performed using IPP.

B To enable IPP printing

1
2
3
4
D

Access the printer web page and log in
as an administrator.

Select [Admin Setup].

Select the following: [Network Setup] >
[IPP] > [Setting].

Follow the instructions that appear on
the display to configure the setup.

Click [Submit].

B To set up the printer as an IPP

1

printer (Windows)

Click [Start] and select [Control Panel]
in [Windows System].

Select [View devices and printers] >
[Add a printer].

From the list of usable printers, select
[The printer that I want isn't listed].

x

ice or printer to add to this PC

4
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Select [Select a shared printer by
name].

Browse.

\

Enter "http://<printer IP address>/ipp"
or "http://<printer IP address>/ipp/Ip",
and then click [Next].

Click [Have Disk].

& o Add Prntes

Install the printer driver

=

Cheote your printer from the list. Clck Windows Update to see more models.

To wnstall the driver from an installation CO, click Mave Disk.

A || Printers
4 Brother Color Leg Type) Class Driver
tor Ty

Have Disk...

‘ Nest Cancel

Insert the "Software DVD-ROM" into the
computer.

For [Copy manufacturer's files from],
enter one of the paths below, and then
click [Find].

e PCL driver:
D:\Drivers\PCLXL

Install From Disk x

Cancel

H Insert the manufacturer’s installation disk, and then
. Make sure that the comect drive is selected below.

Copy manufacturer’s files from:

D:\Drivers\PCLXL

Memo

= The above is an example when the DVD-ROM drive
is the D: drive.

~ Browse... ]

Select the INF file, and then click
[Open].
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10 Click [OK].

Select the printer name, and then click
[Next].

& o Add Prntes

Install the printer driver

@ Choose your prnter from the list. Cick Windows Update to see more models.
SB

To install the driver from an installation €O, click Mave Disk.

4 This diwver is digially signed Windows Update Have Disk...
Tell me why drivee signing i impenant

12 Click [Next].
13 Click [Finish].

A test page is printed after installation
14 is complete.

Encrypting Communication

(IPsec)

You can configure the settings in this section
to encrypt and prevent tampering with
communication between the computer (client)
and printer at the network layer level.

Memo

= The IKE protocol supported by this printer is "IKEv1".
The communication mode supported by this printer is
"Transport Mode". It does not support "Tunnel Mode".
Printer response may slow down while IPsec is enabled,
depending on network communication conditions.

= IPsec does not operate with the mail send function or
SNMP Trap function.

m Setup Flow
Configure printer settings before configuring
computer settings.

B To configure the printer setup

The procedure below shows how to use the web
to enable IPsec.

1 Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

2 Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

4 AFINIA LABFL

St | Corenl [T TR S p—
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Under [STEP1], enable [IPsec].

« Set "Enable" for IPsec to encrypt communications
from the computer with the IP address you specified
in "STEP2".

= The web page will not open if IPsec setup fails
because the configured parameters to not match the
computer, or because of some other reason. If this
happens, use the control panel Network Setup item
to disable [IPsec], or perform network initialization
to disable IPsec.

da AFINIA LABFL

St | Concdl [T TR S —

Under [STEP2], enter the host IP
address.

« Use an IP address to specify a host that is allowed
to print and configure settings.

o e

e For the IPv4 address, use single-byte numerals 7

separated by periods (.).

* For the IPv6 address, use single-byte alphanumeric
characters separated by colons (:). Abbreviated
notation is not supported.

= Entry of IP address 0.0.0.0. is invalid.

b AFINIA LABFL
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Undér [STEP3], configure the settings
of the Phasel Proposal parameters.

(1) For [IKE Encryption Algorithm],
select one of the following settings:

AES-CBC 256, AES-CBC 192, AES-
CBC 128, 3DES-CBC, DES-CBC.

(2) For [IKE Hash Algorithm], select
SHA-1 or MD5.

(3) For [Diffie-Hellman Group], select
Group2 or Groupl.

(4) For [Lifetime], enter and set a
value in the range of 600 (seconds)

to 86,400 (seconds).

b AHINIA LABFI'

Under [STEP4], set the pre-shared key.

For [Pre-Shared Key], enter at least one and
no more than 64 single-byte alphanumeric
characters. Here, we will show an example
where "ipsec" is entered for the character
string.

b ALINIA LABEL
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Under [STEP6], configure PhaseZ

O

8 Under [STEP5], set the Key PFS. Proposal settings.
= To configure [ESP] settings
(1) For [Key PFS], select KEYPFS or _ _
NOPFS. (1) For [ESP Encryption Algorithm],

select one of the following settings:
dm ALINALABEL AES-CBC 256, AES-CBC 192, AES-
CBC 128, 3DES-CBC, DES-CBC.

(2) For [ESP Authentication Algorithm],
select SHA-1, MD5, or OFF. If you

select [OFF], the ESP verification
algorithm will not be applied.

b AHINIA LABEL

(2) If [tKey PFS] is selected, select one
of the following settings for [Key

PFS Diffie-Hellman Group]: Group
2, Group 1, None.

b ALINIA LABEL

= — = e = To configure [AH] settings
=) (1) For [AH Authentication Algorithm],
=l - select SHA-1 or MDS5.

-;:‘ e : S : b AFINIA LABFL

(2) For [LifeTime], enter and set a
value in the range of 600 (seconds)

to 86,400 (seconds).

b AFINIA LABFL

10 Click [Submit].
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Settings are saved on the printer and
the network function is restarted.

B To configure computer settings

1 Click [Start], and then select [Control
panel] in [Windows System].

2 Click [System and Security].

1 Commipare e x

* O ot et

® wax

= 8 X

Q Connection Security Rules

% Adeinatratve Took

+ Control Panel + System and Securky + Adminitrative Tooh

4 Double-click [Local Security Policy].

| # cockaceen
2 Compaonent Serices
& OneDrve A Computer Management
- asc % Defragment and Ogtimize Drives
7% Disk Cleanup
8 Outiop £ Event viemer
Oocymars ), 505! It
& Doweiceds T Locel Secusty Pescy
D Music 7% ODRC Duta Sowrces
B Puctres ) Pedormance Mane:
By 9 Prot Managemant
e acitabk N Pescurce Monver
o Servees
L Locol DN i€ T2 System Configuraion
8 5ymem infermation
& Netwecik 57 .
) Tosk Scheduder
D s Cssl . A o
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5 Select [Windows Firewall with Advanced 8 Select [Require authentication for

Security] > [Windows Firewall with
Advanced Security - Local Group Policy
Object], right-click [Connection Securit
Rules], and then select [New Rule].

B Lecat Security Pebey - o x

Fle Zctien View Help

o 2 s B
B Secunty Settngs tare Enabled  Endpont!  Endpewel  Autee
) Accourn Pokcies
& Local Pokcies Theve e o iems 10 shisw in s viem
v 1 Windows Feewsl with Advasced Sect
v @@ Window: Seewal with 23vanced
I tound Pules
Y Outbeund Rules
A\ Connection:
Netmoat Lot Mavager
Pusiic Ky Polices —
Software Resteiction Pose 5 o
Apghcation Cortred Polk hte e e
8 P Securty Poins cale yigw
Advanced Ause Pebey C
L)
Lpont Lat
Help
<
New Ruse

6 Select [Custom], and then click [Next].

[ 0 Mo Conmection Securty Ruse Wizeet x

Rule Type

Select the tye of cormection sacurty rul % Create
| Stepm

| At Tpn What 1y of comacten sacurity b wokd you 1he 4 cramte?

) Inckation
Reat it conections based o sberticaron creria such 23 doman
I ntwrsh or Pwath stahss
Do ot ausharticats cornections rom Be tpscilied computers

O Servertowerver

O Tunnet
A shericate correctons tetneen Yo comguters

Select Endpoint 1 and 2. Configure as
required, and then click [Next].

[ 0 Mo Conmction securty Ruse Wizeet x

Endpoints

Somcity il be Puec

| Stepm

@ R T Create 5 sacured conpaction Batwasn computers n Erdosnt | and ndpont 2

|- Which comouters are in Gindocint 17

- ) hew [ addrens

& O Dose P asdersen

|o

lo ¥
Customae e riertace tpes % wheh ha e acobes Cystcace
Witch computens arm in Endoont 27
® Ay IP addess

O Timsn 1P asresses:

T e

inbound connections and request
authentication for outbound
y connections], and then click [Next].

| P Pew Conmection Securty Rule Witwd x

Requimmonts.
Toacity the suhentication regsrenents e Conrections Bt suich ths ruls.

Whant 85 you want athanticarion 1 sceur?

") Mecueet
Aushertcate whersver possble but suthertication it et regured.

and mane

& Racure
* eutbound connections

Ba Mowed
cossble bt 5 not requred.

! Recure
ot rbound and autound cormections must be sthanticated % be slomed

) Do not sutherticate
No corvactons mil be authentcated

SN v

9 Select [Advanced], and then click
[Customize].

Hew Conmection Secusty Rule Witsed x
| Y

Authentication Method
Toncity hom iusherticarion @ erlormed or Correctons at maich thes .

Wt thantication mathod waukd you e 10 use?
O et
Usa e subantication methods spechind n Deec sattines
O Comouter and user Rarberos V5)
pose
Prevades denlty rhormatn ke sshis e $0aCAE wars ard Comprbers 1
o and Gt s

» tove ) Comenter (Kevberss V5)

e Som. Provides
onkity plormation bor asber cee spech e compubers m rbound and otbourd

% Advanced

frst wd second Oumlomas_

]G SN oo [

In the [First authentication] section,
click [Add].

Customee Advanced Auestcsten Methods X
|

Fust athentication Second mstertiation

Specdy conguder suthentication mettods 10 use dring IPiec Soscity wier ahentication o & boath cortilicate

rmgatistions. Thoss hegher 1 e It ace i fest 199 durng Poec negotacons highee 0 B st ary

vind feat
Erst ssertcaton metods Frcond mterteatin mathods
Moz Adsnional acrmation. Matrod Adstoral itarmaren

n -
o A CAOn & cotonal (] Secod suthentication is aptionsl

A second mrbartication canmot be specifind mhen &
creshared by i 1 the frst suthenticetion methods et

o] Cowent

Select [Preshared Key] and enter the
key, and then click [OK].

Add First Authentication Method X

Select the credential to use for first authentication:

O Computer (Kesberos V5)

O Computer (NTLMv2)

O Computer certficate from this certfication authorty (CA:
Sienine aleorithm:  [BSA (dafaull)

Gertificate store type Fal 6 (defiull

(@ Preshared key ot recommended)
= ]

Preshared key authentication is less secure than other
authentication methods. Preshared keys are stored in
plantext. thhen preshared key authentication is used, Second
Authentication cannot

[ ok Gancel
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17 Click [OK].

Custome 20vanced Auesteaen Methods

=,
First athentication Sacond autentication
Soecdy conguter authentication methods 10 use dring IPsec ‘Soscity wier auhantication o & hoath cortilicate
regatistions. Those hughar 1 e It e e fest 1m0 g Poec nepettone highee i e bt are.
wid feat

Erst msentcaton metods Focond mtericaton mathods

Method Adsnonal baormaton Metrod Addtoral Intarmaton
Proshared hey wae
PR

() First mmercaton o cotionat

]3 Click [Next].

1 Click [Next].

A second aubartication camot be soecdind when 8
preshared ey @ 1 he frst authenticaton methods et

=)=

[ 80 tow Conmection Secusty Ruse wied
| Protocoland Ports:
Soecity the proncel and ports % wheh i rdle iples.

To whih ports and protacels does tha rule scely”

w7 Botscol e 3 v
Provacel rysber
Erdpont Joot MR

Example 81, 445, 5000-5010

Erdont 2ot 4 bt

Examele 81, 045, 5000-5010

<B-10ml

After confirming that all of the check
boxes are selected, click [Next].

| P Mew Conmection Securmy Rule Witsed
| Profie
Soacity the profies for which ths e acoles

When does tha ke scely®

whan & computer & connacied ) A% corporate doman

pies when 3 computer @ corrected 1 3 private ratecrk. iocation such as &
o ek, place

when & conputer @ comected b & puble rebwerk, keation.

N o [

Enter a name, and then click [Finish].

1

| 0 toow Conmection Securmy Fuie Witeet
| Name
Soncity the rame and Gnsr O1ion of s e

x

cha ]| o
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U IPsec Setup

17

Open the [Local Security Policy] of the
[Administrative Tools].

3 Lecst Securty Pebey

- o x
| Be zetien Yiew Help
|l X B
2y Sacurity Settings e Descrptn
B Accoun Polcias  Acceunt Pekcies Pastword and sccount lockeut pebiies
& Local Polcies

& Local Pokcies

Wendons Feewsd with A0 ances Securty
Netmea Lot Masager Petcoes

Publc Key Pokcies

Software Restection Poscies

Appication Contrct Policies

B 2 Securny Poka i Computer

Adeanced hust Pobcy Contiguration

v Werdows Frewall with Advanced Secr
v @ Windows rewsl with 18/anced
B bound Res
K Outbeund Puies
B Connecticn Securty Rules
Netmert Lat Maager Pebcies
Public Key Polices
Softmare Restecton Peicins
Apphcation Contrst Pohoes
B 5 Security Polics e Local Compute
Aavances 2ust Pebey Canhipurinen

Sudting wie nghts aad securty eption pehe
Wendoms Frens wth 28, amced Securty
Hetmed mame o0 and Jocaten grevp peboves

Applcation Contro Pelicies
Sacurty (Prac) i
Advanced Audt Policy Conigarstion

Right-click [Windows Firewall with
Advanced Security], and then select
[Properties].

B Lecal Security Pebey
e Zeten
2

View Hels
B Securty Settngs.
B Accoum Pekian

i Local Polcies
& VWindows Fnewatl with Advanrad | | Ocerien
Pokcy.
Pusbe Ky Pebores Expont Pelicy.. = ot contpaed
ool G
ot
8 2 Securty Polces entocat Com D09/ Repae @ ot eenfipursd
Advenced Audt Polcy Configure View
Fefresh #o & not contgured.

oy Corrmetion 4ecus ity s 55 soacily how ared whan Conmmtions batween Comguters e
warg merret frosscet

Help
on
]

View and create ficawall rules

Craate {rewall rules o alow or block connactions 15 specind programs or gorts. You can alse v |
3 s e >

pen selectien.

Select the [IPsec Settings] tab. Next,
in the [IPsec defaults] section, click
[Customize].

Windows Firewall with Advanced Security - Local Group Policy Ob... X

Domsin Profie  Private Profls  Public Profie  IPsec Settings

IPsec defaults

& Specify settings used by IPsec to
@lmy establish secured connections.

Customize...

IPsec exemptions
& Exempting ICMP from all IPsec requirements can
adm simplify i ivi
TS issues:

Exempt ICMP from IPsec:

Not configured ~

IPsec tunnel authorization
& Specify the users and computers that are authorized
@Jm to establish IPsec tunnel connections to this
“= computer.
@ None
O Advanced

Cancel

Apply.
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2 In the [Key exchange (Main Mode)]
section, select [Advanced], and then
click [Customize].

Customize IPsec Defaults

IPsec will uss these settings 1o establish secured connections
when there are active connection security rulss:

When you use the default options, any settings in a GPO with a
higher precedence are uzed

Key exchange (Main Mods)
O Default {(recommended)
@ Advanced

Custamize..

Data protection (Quick Made)

O Default (recommended)

@ Advanced Cugtomize..
Buthentication method

O Default

() Gomputer and user (Kerberas V5)

O Gomputer (Kerberos W5

O User (Kerberos WE)
@ Advanced Gustomize

Gancel

m- Change the [Security Methods] as
required, and then click [OK].

ctome Aduanced Ly Exchange Settngs

*
Sacur iy mathods
e e low vty et o ey exchurge

Thote higher 1 e bt e b

Creryston  Key wichanes sieorthm
AES-GBOC 1. Dita-Holiman Grou 3 (vttt}
065 Ote-taliman Growp 2

Key Matioes

Key exchanes copens
oty mhen ¢ rew by i conersied I you select

1] Lse Ditie-Hokoan for
Bt ogton, & raw kay 5 garar nhanced securfy
Tt Wreshold a resched
Comparle mth Wedoms Vata
il
Mewres wi
Sovsions oz
o] [ emcel

22 In the [Data protection (Quick Mode)]
section, select [Advanced], and then
click [Customize].

Custemize IPsec Defaults

IPsec will use these settings to establish secured connections
when there are active connection security rules.

When you use the default options, any ssttings in & GPO with a
higher precedence ars use

Key exchange (Main Mode)
O Default recommended)
® e

Data protection (Guick Made)
) Default (recommended)
@ Adyanced

Customize
ﬂu enfication method

O Default

(O Computer and user (Kerberos V/E)

O Computer (Kerberas V5)

(O User (Kerberos WE)

@ Advanced Customize...

[o]4 Cancel
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2 Configure the settings you want, and
then click [OK].

Cuntomae Data Pretectien Semmngs

*
Daa prstaction settings we used by connaction sacurity ruies 1 protect natwerk Saffic
[7) Pagure avcryption for a8 cormaction sacurity nules St use these sattines
Owta ringrty Duta gty and ancryption
Pt doa b it on %o
ety

ek, wrh Pete Dritect doa Ssm moddicaton and groveres contelhiaity on
Those huehwe i the kst ars ied e ratcrk. with thase
fest

Vg f gt
hese hicher o the I-lﬂ.-di-
Data mieerty algor thes: Duta ntegrty and epcrypten algor s
L Koy Litotime (mennes/XE) Protocol  Iemity Encrption  Key Litetow (m
or SHAc1 /100000 o A1 ALS-ORC. W/ eom
M SR w/ioame P SHAl 065 Il
o A

Note

= Support is provided only for time indicated by the
key lifetime. To disable session-specific (IPsec

communication data size) conditions, set the
maximum value.

* Select "ESP+AH" as the protocol.

24 In the [Authentication method] section,

25

select [Advanced], and then click
[Customize].

Customize IPsec Defaults

IPsec will use these settings to establish secured connections
when there are active connection security rules.

When you use the default options, any settings in & GPO with a
higher precedence ars uss

Key exchanee (Main Mode)
(O Detault (recommended)
® Advanced

Gustomize
Data protection (Quick Mode)

O Default {recommended)

®) Adyanced

Gustomizs

Authentication method

O Default

O Computer and user (Kerberos VG
(O Computer (Kerberos V)

O User (Kerberos VE)

® Advanced

Gustomize.

0K Gancel

In the [First authentication] section
click [Add].

Customze Adean

ed 2umesteaton Methess %
Fust athantication

Secand asterkication
Specdy conguder authentication methods 1o use dring IPuec Soscity wier aushentication methods or & heath certilicate
rmgatistions. Thoss haghar 1 e It are i Hrst 1 ute darg Prec

nagetatons. Those highee n 0w ket
viod feat
Erst mstentication mehods cond asarticatin matods
Mothod Assainal bicrmation Matrod Adstional Inkrmation
Fresharnd ey oo
Fﬂ""lum  cotionat
A second

spacihind when &
il ey st cor b e

o] | omemt



Using a Web Browser to Configure the Network Setup

2 Select [Preshared Key] and enter the Controlling Access by IP
key, and then click [OK].

Address (IP Filter)

Add First Authentication Method X

Selectthe credental o use fr first authentiat Access to the printer can be managed using IP
O Computer (Ketberos V5) addresses.

O Gomputer (NTLMv2)
O Computer certiicate from this certiication acthority (CA):

Signing algorithm: RS 4 (default) Note

Certificate store type g0t o4 (default)

« [IP Filtering] is set to [Disable] under the printer initial
default settings.

i t maopine

© Preshared key (ot recommended): = Take care to enter the IP address correctly. An incorrectly
[ipsec ] entered IP address can make it impossible to access the
authentication methads. Preshared keys are stored in printer using IP protocol.

plaintext. When preshared key authentication is used, Second
Authentication cannot be used.

Log in as an administrator.

Reference

2 ; Click [OK]' e See "Logging in as an Administrator" (P.142).

| Cumtomee Savanced Aumesbeason Methoss x

o g ertuin uton P ke g o st 2 Click in the following sequence: [Admin

GCancel 1

i i il o i ke Setup] > [Network Setup] > [Security].
Method Assnonal o maton Mathod Asdtoral Inbarmaron
Proshared hey e
ba ALINIA LABEL
\twn ekragdas | Bad bemates | Paate Weey | #0er Soh | Coleation | Ly
[Easascesims
s = o
mm:u.m:m_&:rum.m INRIOS over 1 e
biredsloniine) et
E — .
e o )
e =5
e =
e ==
i ]

2 Click [OK] to exit [Customize IPsec
Settings].

Customize IPsec Defaults x

IPsec will uss these settings 1o establish secured connections
when there are active connection security rulss:

When you use the default options, any settings in a GPO with a

< > Subma | Concel | Fress Suberit £3 3ead changes. Press Cascel 13 Sear Shanges.
higher precedence are uzed

ooy 3 Click [IP Filtering].

@® Advanced Customize...

Data protection {Quick Mods) & ALINIA LABEL

O Default (recommended) —
@® Advanced Cugtomize...

Authentication method

O Default STPL. Select 19 Pimeriog Sactings

() Gomputer and user (Kerberas V5)
O Gomputer (Kerberos W5
O User (Kerberes WE)

15 1nerieg

Oisnie

CAUTIONS ¥ you vet 17 Fitsing to frable. va <o
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ccess t orreer ot
e,

I acesans set

STEPL Set 19 Address range. T
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.
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“Corty ax marknd, WED et
ks 39 A, I 3o 0 STEP 3, wverrides o1 CoVIATatian 4TINS 1) (NS Sacrion

I oK l Gancel raay] M

Y - o
T Feses s
Click [OK] =
* s 0.0 0000
S T oae

—— o 2

< > Subma Concel | Press Suberit 63 sead changes. Press Cascel s Sear charges.
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Under [STEP1], select [Enable] for [IP
Filtering].
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= Enabling IP filtering disables all access from hosts
that are outside the range of IP addresses specified
in [STEP2].

Under [STEP2], specify the IP address
range.

= Using IP addresses, enter the range of hosts that
are allowed to print and configure settings.

« For the IP addresses, use single-byte numerals
separated by periods (.).

= Entry of IP address 0.0.0.0. is invalid.

= When there is overlap of IP addresses, the address
range with the highest level set in [Priority] is given
priority.

= Regardless of what is specified in [STEP2], you can
use [STEP3] to specify administrator addresses
for which printing and setting configuration are
enabled.

Click [Address Range Bar Display/
Refresh].

b ATINIA LABEL
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3 L

Yiwn ehrragios |

5 Jesee oos
« Jocoe teen
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s Address Rnoe Bor Depiay/Refresn e
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Rl oy B

Fon By
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& o b
AMAC M WEREC TP Save Adinlyiratoc 1P Address.

2 e OWY tre 15 Adcress cin D8 03 34 DevIvTINEY (B R4S ML
3 prowy 5 wond b acomss B printar, tha 0raey 333rees Wil apoea in Your Curwnt
9 Chorge Mebwork ow/Preay 1P Adcemay’ bax.

Wyse 1 Adwie v =
® Neistorance Ldrwes womeq” Fats Bk
Aduisistsater 1P Addeess (het hes bewn rowistered 0005

Yerar Current Local Wost/ Prowy 19 Abdress 192 1001003

D91 sene Adsisistrster's IF Address setting 3020 v

If you want to modify an IP address range,
re-enter the applicable IP addresses, and
click [Address Range Bar Display/Refresh].
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Under [STEP3], specify the
[Administrator’s IP Address setting].

‘.w[_/\jﬂ
'—"‘;“wl"ﬁ?‘w (LLEJ

. 0.c.00 0000

0.0.00 0000

1
[ Jesoe feoe
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e | 30 0.0.00 0000

oeeey 1
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okt Your Current Local Wost/ proy 19 Abdress 192 10m.1003
L
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 Color 5000
Subma | Cancl fress Zubmit s send changes. Press Canes s s charges.

Even if the wrong settings are configured
in [STEP2] due to administrator IP address
entry in [Administrator’s IP Address
setting], the administrator can re-configure
the setting from a host with the IP address
specified with [Administrator’s IP Address
setting].

= If the printer is being accessed via a proxy, the
intermediate device's address will be displayed
as [Your Current Local Host/Proxy IP Address].
Consequently, the address shown by [Your Host IP
Address] may be different from your actual host
address.

<

« If nothing is registered for the administrator IP
address, the setting in [STEP2] may make the
printer completely inaccessible.

< If you do not want to register an administrator IP
address, leave [Administrator’s IP Address setting]
blank.

8 Click [Submit].

b AFINIA LABEL

3000 v

Prese Zuberit €3 sead changes. Mress Cased B Ser tharges.

Settings are saved on the printer and
the network function is restarted.
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Controlling Access by MAC

Address

Access to the printer can be managed using MAC

addresses.

« Incorrectly entering a MAC address can make itimpossible
to access the printer using a network. Exercise caution
when entering an address.

1

2

3

Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

Click in the following sequence: [Admin
Setup] > [Network Setup] > [Security].

| dm ATINIA LABEL

v
< > | _Subma | Concdl |

Press Zuberit £ sead changes. Mress Cascs B Sear changes.

Click [MAC Address Filtering].
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D

Under [STEP1], select [Enable] for [MAC
Address Filtering].
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Under [STEP2], You can select [Accept]
or [Deny] for communication from
specific MAC addresses.
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@ Note

= Using MAC addresses, enter the range of hosts
whose communications are allowed or rejected.

« For the MAC addresses, use single-byte numerals
separated by periods (:).

« Regardless of what is specified in [STEP2], you can
use [STEP3] to specify administrator addresses for
which communication is enabled.
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Under [STEP3], specify the
[Administrator’'s MAC Address setting].
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Even if the wrong settings are configured in
[STEP2] due to administrator MAC address
entry in [Administrator’s MAC Address
setting], the administrator can re-configure
the setting from a host with the MAC
address specified with [Administrator’'s MAC
Address setting].

= If the printer is being accessed via a proxy, the
intermediate device's address will be displayed
as [Your Host MAC Address]. Consequently, the
address shown by [Your Host MAC Address] may be
different from your actual host address.

= If nothing is registered for the administrator MAC
address, the setting in [STEP2] may make the
printer completely inaccessible.

= If you do not want to register an administrator
MAC address, specify 00:00:00:00:00:00 for
[Administrator's MAC Address setting].

7 Click [Submit].
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Settings are saved on the printer and
the network function is restarted.

Sending Error Notifications

by Mail

The printer comes with a mail sending function
(SMTP) built-in. It can be configured to send a
mail message whenever an error occurs. You can
select whether to send a periodic mail message
about errors, or to send a mail message as soon
as an error occurs.

B To configure settings for sending
mail

1 Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

2 Click: [Admin Setup] > [Network
Setup].

b AFINIA LABFL

i ekeranan | et ievates | Pastee Viey | £nm Son | Coteation | Lk

153 o

IRRIOS ver TR awss v

EL TS

| oo sene
= P Uik States. OeL3CoRM-TX Ful)
Do Sene Clgatis msturk Duase v/
S ASouse Wt ik Satting DErp—_

Energy Ulficient (Dhernet  Lase
v
< > Subma | Cancel Fress Suberit 03 ead changes. Press Cascel 1 Sewr Shanges.

3 Click: [Email] > [Send Settings].
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Under [STEP1], select [Enable] for
[SMTP Send].

b AFINIA LABEL
%ML‘L‘L’J Cettabo ILrey.

PN ey STUPL SHTP sane settings

Subma | _Concal | Fress it £ sead changes. Press ol 1 et arges.

Under [STEP2], specify the required
addresses.

(1) For [SMTP Server], specify the mail

server domain name or IP address.

(2) For [Printer Email Addresslt,osgﬁecify

the mail address assigned
printer.

To configure SMTP server settings with a domain
name, you need to configure DNS server settings
with the [TCP/IP] setup.

The mail server needs to be configured to allow
the printer to send mail. For information about
mail server settings, consult with your network
administrator.

Internet Explorer 7 configured with its initial default
setup will not perform a send test.

To perform a send test, you need to change the
setup of Internet Explorer 7.

Select [Tools] > [Security Level Customization],
and then enable [Allow websites to prompt for
information using scripted windows].

To configure more advanced settings
from this point, click [Set detail of the
SMTP Protocol.] for [STEP3].

b AFINIA LABFL

541 U0 SHTP Sarvar L84 9 whars 114 psLe wll Mne Lt
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. 541 tha sender Aderiss (s prkr s Addvess

Privtes Emall Addrass.

v
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Otherwise, jump to step 16 of this
procedure.

7 Click [Security Settings].

 Fr01080 - wtsemet Exlorer - o x

& 5268100100

SMTP Security Settings

Set sacurity of the SMTP Protocal, ¥

8 For [SMTP Port Number], specify the
mail server port number.

9 Select [Enable] for [SMTP-Auth].

(1) For [User ID], specify the user ID
for connection to the mail server.

(2) For [Password], specify the
password for connection to the

mail server.

10 Click [OK].

:Il Click [Configure attached information].

@ F1010%0 - tarmet Exghorer - 0 x
o 2. 168100.100

Configure attached information

Character strings, which are appended to the end of Emall messages sent.

o Prieter Madel 1 Pro1050

¥ Netwerk intacface 3 OkILAN $4009

V' Serial Number 2 ALPHAS0004
Asset Number
Prieter Name H OK1-Pro1050-9E8160
Prieter Location

¥ 1P agdress 3 192.168.100.100
MAC Address 0025369E8160
Short Printer Hame 2 Pro1050-9E6160
Prieter URL : hetp://192.168.100.100

Comment (Max.63 characters per line)

oK | cancel |
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Select or enter the information you Sending Error Notifications
want to add to the end of the message - - -
text. by Periodic Mail
_ B To send periodic notifications
13 Click [OK]. about problems
For periodic notification, check that Auto Power
1 Click [Others]. Off setting is either Auto Config or Disable.

For [Reply-To Address], specify the . .
return address for the mail sent from 1 Log in as an administrator.

the printer. Normally, specify the mail Reference

address of the printer administrator.
e See "Logging in as an Administrator" (P.142).

2 Pro10%0 - intermet Exglorer - o x

;mm_ 2 Click: [Admin Setup] > [Network
| Setup].

Reply-To Address

OK | Cancel

4 ALINIA LABEL

1 Click [OK].

1 Click [Submit].

Settings are saved on the printer and
the network function is restarted.

Memo

= The authentication method is automatically selected from
among authentication methods supported by the mail

server. Click: [Email] > [Alert Settings].

v
Submat | Cancel Fress Zuberit €3 soad changes. ress Cancel B cear changes.

4 ALINIA LABEL
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Press Subent £ send changes. Press Cantel te desr changes.
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Enter the mail address of the

malfunction notification recipient.
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Click [Setting] of the mail address you

Under [Setting Events Used for Sending
Email Alerts], select the check boxes of
the error types for you to be notified of.

2 F1o108 - teemet Exglorer - o x

& Y2 6100100 et setting ¢

Setting perfodically(Address 1:user@asabbb)
Setting Email Alert Interval

Spacify an intarval for sanding Emall of printer status.
The interval that can be set Is any positive inteper value of 1 to 24.
Emall Alert Interval |24 s 154
Satting Events Used for Sending Emall Alerts

15 mad wiarts o & pristar whan the peter hes
8 wbrning o0 arer st Pages hat can sl he
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Sager

i Ul wharts for & peimtes wchan the ter bt
O Ly e

i Emad wharts for & printar schan tha pemter bt
B amg o ames shout B3 AN b
Merssey Over

want to specify. =
OK Back
Memo
= Malfunction notification condition settings can be .
copied to another addressee by clicking [Copy]. This Click [OK].
is useful when sending malfunction notifications to

multiple recipients with similar mail addresses.

Select the [Periodically] check box, and

then click [To STEP2].

@ 7191080 - et Exghorer - b0 x

& YRR 100100 et

STEPL. Determine how Email alerts,
Choose oo of the following ways and then press “To STEP2".

For [Email Alert Interval], specify the

mail send interval.

@ 101080 - wntermet Exhorer - b0 x

& YR 00100 s

Setting periodically(Address 1:user@asabbb)
Setting Email Alert Interval
Sacty an intarval for sending Emall of printer status.

Emall Alert Interval [24 " Jamnts-soenn
Mark the (s alerts,
Unmarked event(s) ace rot included in Email sberts.
Condition | | | Description
T [wies = et s for & prmker wham tow petar bt
jresected o consumabios bk oe

e
o St Cantrdoms -

Memo

= Mail is not sent if there are no reportable errors

within the period.

Check the configuration of the
malfunction notification conditions.

e Todisplay as a list

(1) Click [Show current settings table].

(2) Check the configuration, and then
close the window.
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= To compare the setting conditions of two
recipients

(1) Use the list box to select each
of the recipients you want to

compare.

(2) Check the displayed configuration.

Memo

= You can change notification condition settings by
clicking inside the setting condition comparison

table.
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]1 Click [Submit].
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Settings are saved on the printer and
the network function is restarted.

B To send alerts when problems
occur

1 Click: [Email] > [Alert Settings].
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Enter the mail address of the
malfunction notification recipient.
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3 Click [Setting] of the mail address you
want to specify.

Memo

= Malfunction notification condition settings can be
copied to another addressee by clicking [Copy]. This
is useful when sending malfunction notifications to
multiple recipients with similar mail addresses.

4 Select the [Upon occurrence of an
event] check box, and then click [To
STEP2].

D 710108 - wutermet Exgloner - b0 x

|@

Setting Emall Alert(Address 1:user@asabbb)
STEPL. Determine how Email alerts.
Cheose one of the following ways and than press “To STEP2".

Way of Emnall Nerting Oescrigtion
Pecoseally
Y™ prieter while the printer Is ccarating.
_TosTerz |
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Using a Web Browser to Configure the Network Setup

Under [Setting Events Used for Sending
Email Alerts], select the check boxes of
the error types for you to be notified of.

2 7101080 - et Exghorer - B0 x

@ e 25208 100.00 e

Setting upon occi

rronce of an event(Address 1:user@aaabbb)
Setting Events Used for Sending Emall Alerts.
Mark the checkbox(es) beside event(s) to be inciuded In Emal alerts.

Specify the delay after an error occurs
until the message is sent, and then click
[OK].

Memo

« Setting a delay time makes it possible to send
notifications only of errors that are generated only
over a long period of time.

* Setting "0 hours, 0 minutes" for the delay time,
causes the message to be sent immediately after an
error occurs.

Click [OK].
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Check the configuration of the
malfunction notification conditions.

* Todisplay as a list
(1) Click [Show current settings table].

(2) Check the configuration, and then
close the window.

=
X | srwenote || sr ot * e

- To compare the setting conditions of two
recipients

(1) Use the list box to select each
of the recipients you want to
compare.

(2) Check the displayed configuration.

Memo

= You can change notification condition settings by
clicking inside the setting condition comparison
table.
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Click [Submit].

b ATINIA LABEL'

Settings are saved on the printer and
the network function is restarted.



Using a Web Browser to Configure the Network Setup

Using SNMPv3 |
This printer implements an SNMPv3 compatible

agent.

You can use an SNMPv3 compatible SNMP
manager to encrypt printer administration with
SNMP for greater security.

1 Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

2 On the [Admin Setup] tab, click
[Network Setup].
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3 Click [SNMP] > [Settings].

b AFINIA LABEL

Sebect enr wne o buiew, and dick To STERY bmion,

Bl Moce Oescretisn
m ARV RGeSt e SNV
O St it SO
led * BRBYIC] DR el SOV wat MR Ot e S
O eeasol e
30 peotocol ' drabied.
Bver Dtk b o 13 43 4 cormricason (N e SN,
P
= ovet sete To 512 |
” ong
L seom
2 e Seu
[ye——

Select the check box of the SNMP
4 version to be used in [STEP1], and then
click [To STEP2].
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Memo

= If [SNMPv3] is selected, you will not be able to view
or configure settings with SNMPv1. If [SNMPv3+v1]
is selected, you will be able to view settings with
either SNMPv1 or SNMPv3, but you can configure
settings using SNMPv3 only.

5 In [STEP2], enter an SNMPv3 user
name for [User Name].
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Enter the passphrase for verification
in [Passphrase] for [Authentication
Settings].
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7 Select [Algorithm].
Authentication is in accordance with IEEE802.1X.

& AFINIA LABEL
e
T e — B IEEE802.1X Setup Flow
= e — To configure IEEE802.1X settings on the printer,
P e — first connect the printer and computer via a
i & i normal hub for setup. After completing the
e _3:,:\_:.‘_”_“ IEEE802.1X setting configuration procedure,
s e connect the printer to the authentication switch.
i 1 Connect the printer to a computer.

< >

On the computer, specify an IP address for

Enter the passphrase for encryption in
[Passphrase] for [Privacy (Encription)
Settings].

b AFINIA LABEL

setting up.

On the printer, specify an IP address for
setting up.

On the printer, configure IEEE802.1
settings.

Connect the printer to the
authentication switch.

2
3
4
D

Subma | Cancdl | fress it 3 sead changes. Press Cases & i charges.

< >

Memo

= You can select [DES] only for the encryption
algorithm.

9 Click [Submit].
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Settings are saved on the printer and
the network function is restarted.

Memo

« For the context key of the SNMP manager to be used,
specify "v3context".
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Using a Web Browser to Configure the Network Setup

B To configure IEEE802.1 settings

1 Log in as an administrator.

Reference

e See "Logging in as an Administrator" (P.142).

On the [Admin Setup] tab, click
[Network Setup].
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Reference

« If PEAP is to be used, proceed to "@ To use PEAP".
If EAP-TLS is to be used, proceed to "® To use EAP-
TLS".

To use PEAP

For the [IEEE802.1X] setting, select
[Enable].

5 For [EAP Type], select [PEAP].

b ALINIA LABEL
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6 In [EAP User], enter the user name.

7 In [EAP Password], enter the password.

b AFINIA LABEL
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Select the [Authenticate Server] check
box.
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Click [Import of CA Certificate].

Memo

= If the [Not authenticate Server] check box is
selected, import of a CA certificate is not required.
If the [Not authenticate Server] check box is
selected, there is no confirmation to determine if
the connection is to a properly authenticated server.
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This displays the "Import of CA Certificate"
screen.

Enter the file name of the CA certificate,
and then click [OK].

Memo

= The imported CA certificate is a certificate of the
server certificate issuing authority of the RADIUS
server.

e Supported import file formats are PEM, DER, and
PKCS#7.

Please choese Certificate to import,

( = |

—SOK |:Concel |

The CA certificate is imported by the printer.

]1 Click [Submit].

Settings are saved on the printer and
the network function is restarted.

When the standby screen appears on the
control panel, turn off the printer.

Using aEWeb Browser to Configure the Network Setup

To use -

D

~N O

8

9
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For the [IEEE802.1X] setting, select
[Enable].

For [EAP Type], select [EAP-TLS].
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In [EAP User], enter the user name.

Select the [Not use SSL/TLS Certificate
for EAP authentication] check box.

Click [Import of Client Certificate].
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This displays the "Import of Client
Certificate" screen.

Enter the file name of the client
certificate.

Memo

The importable certificate file format is PKCS#12.



Using a Web Browser to Configure the Network Setup

1 Enter the client certificate password,
and then click [OK].

[T — -
| @ e mrrear00100

Import of Client Cortificate

STEPL. Please choose Certificate to import,
(Tha file format which can be sported: KC5#12)

Browse...

STEP2. Please input a password required in order to import the selected

Pasoword ]

ok | cancel |

The client certificate is imported by the
printer.

Select the [Authenticate Server] check
box.

Click [Import of CA Certificate].

Memo

e If the [Not authenticate Server] check box is
selected, import of a CA certificate is not required.
If the [Not authenticate Server] check box is
selected, there is no confirmation to determine
if the connection is to the correct authenticated
server.

4 AFINIA LABEL
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This displays the "Import of CA Certificate"
screen.

Enter the file name of the CA certificate,
and then click [OK].

Memo

= The imported CA certificate is a certificate of the
server certificate issuing authority of the RADIUS

server.
= Supported import file formats are PEM, DER, and
PKCS#7.
2 Pre iR - intermet Explerer - o x

o 152.968.100.100 wwrr

Import of CA Cortificate
Please choose Certificate to import,

[ arowse... |||
OK | Cancel

The CA certificate is imported by the printer.

1 Click [Submit].
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Settings are saved on the printer and
the network function is restarted.

When the standby screen appears on the
control panel, turn off the printer.

Reference

= For information about how to turn off the printer,
refer to the "Setup Guide".

= Advance to "To connect the printer to an
authentication switch" (P.171).
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Using a Web Browser to Configure the Network Setup

B To connect the printer to an
authentication switch

Memo

= Confirm that the printer is turned off.

1 Plug a LAN cable into the printer's LAN
(network) interface connector.

Plug the LAN cable into the
authentication switch's authentication
port.

Turn on the power supply of the printer.

Confirm that the standby screen is
displayed on the control panel.

Configure settings in accordance with
the operating environment, such as the
printer's IP address, etc.

o1 B N
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Network Extension

Network Extension

Network Extension makes it easy to check printer setup items from a printer driver.

Reference

= Network Extension is installed along with the printerdrivers.

Operating Environment

Computer running Windows 10/Windows
8.1/Windows 8/Windows 7/Windows Server
2016/Windows Server 2012 R2/Windows
2012/Windows Server 2008 R2/ Windows
Server 2008

Computer running TCP/IP

Note

« Tolink operation with a printer driver, you need to install
the printer driver.

= Network Extension is installed automatically when a

printer driver is installed on a TCP/IP network connection.

= Operation is supported only for the printer driver
connection destinations shown below.

- Afinia Label LPR Port
- Standard TCP/IP port
= PC administrator privileges are required for the setup.

Checking the Printer

Settings

You can use the procedure below to check
connected printer configuration, etc.

Note

= Even if Network Extension is installed, the [Options]
tab will not be displayed if the operating environment is
incompatible.

1 Click [Start] and select [Control Panel]
in [Windows System].

2 Click [View devices and printers].

B Contrel Panet o X

3 Right-click the [LT5C PCL6] icon,
and then select [Printer Properties].

4 Click the [Status] tab.
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Network Extension

Click [Update]. Uninstalling Network
@Z::\WCLW::‘::S Ports Advanced Color Management - EXtenSIon
S— 1 Click [Start], and then select [Control

panel] in [Windows System].

Click [Uninstall a program].

Select [Afinia Label Network
Extension], and then click

S O D

[Uninstall].
(G ) wveren Follow the instructions on the screen to
ok | [ s | [ uninstall.

The printer configuration is displayed under
"Device Setting".

6 Click [OK].

Memo

« Clicking [Web Setting] automatically starts up the web
browser, which will display the printer configuration.
For details, see "Using a Web Browser to Configure the
Network Setup" (P.141).
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